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Introduction

Welcome Welcome to Gentran:Server® Windows® Forms Integration subsystem, Sterling 
Commerce’s Electronic Data Interchange (EDI) form-generation software for the 
Windows operating system. Gentran:Server provides you with the tools that you need to 
design forms to facilitate the keying and printing of EDI documents.
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What’s in this manual

Overview This manual contains a tutorial for Gentran:Server Forms Integration, using the 
TRADACOMS 92.1 standard. This tutorial includes a print form example (purchase 
order) and a screen entry form example (invoice). The purpose of this tutorial is to break 
the form creation process into concise and understandable steps, using examples that 
enable you to understand and master the tasks and processes required to create your own 
forms.

Complete the print form tutorial first. After you have mastered the steps involved in 
creating a print form, you can begin the tutorial for the screen entry form.

Related manuals To access reference information, refer to the Gentran:Server® Forms Integration online 
Help or Forms Integration User’s Guide. For additional information on the various tasks 
described in this manual, refer to the Gentran:Server® Windows® Forms Integration 
User’s Guide.

Intended audience This manual is intended for the following users:

◗ Technical users—users with a detailed knowledge of the Windows operating system, 
networking, databases, and communications. 

◗ Novice-to-average experienced users—users who are new to Gentran:Server for 
Windows, EDI, or both. 

◗ EDI Coordinators—users responsible for creating and maintaining the transfer of EDI 
data between Trading Partners.

Prerequisite
knowledge

The audience using this software should be familiar with:

◗ PC and Microsoft® Windows functions
◗ EDI concepts
◗ EDI standard structure
◗ the internal application format
◗ data mapping concepts
◗ Gentran:Server® Windows® product
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Description of Contents

Overview The Forms Integration TRADACOMS Tutorial contains the tasks associated with using 
the Forms Integration subsystem. 

Organization of
chapters

The tutorial guide is organized into the following chapters:

◗ Chapter 1, Getting Started, explains the content, organization, conventions, and 
system requirements. This chapter describes how to build forms and how to 
customise global EDI date formats.

◗ Chapter 2, Creating a Print Form, explains the tasks necessary to create a print form 
for an TRADACOMS purchase order (ORDERS).

◗ Chapter 3, Creating a Screen Entry Form, explains the tasks necessary to create a 
screen entry form for an TRADACOMS invoice (INVOIC).

◗ The Glossary contains definitions of Forms Integration and Gentran:Server terms and 
concepts.
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Online Help

Overview The majority of the Gentran:Server® Windows® Forms Integration User’s Guide 
documentation is also contained in the online Help system.
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Getting Support

Introduction Sterling Commerce’s Gentran:Server software is supported by trained product support 
personnel who are available to help you with product questions or concerns.

Note
Gentran:Server Customer Support does not support non-Sterling Commerce products 
(e.g., SQL Server, Oracle, etc.), but can assist you in configuring non-Sterling Commerce 
products to work with Gentran:Server.

Phone number For assistance, please refer to your Getting Started Guide to determine which support 
phone number you should use.

Before calling
support

To help us provide prompt service, we ask that you do the following:

◗ Attempt to recreate any problem that you encounter and record the exact sequence of 
events. 

◗ When you call product support, you should be prepared to provide us with the 
information below.

Information Description

Identification Your company name, your name, telephone number and 
extension, and the case number (if the question refers to a 
previously reported issue).

System Configuration The Gentran:Server version (and any service packs 
installed) and information about the primary Gentran 
system controller and all machines experiencing 
problems, including: the Windows operating system 
version, amount of memory, available disk space, 
database version, Microsoft Data Access (MDAC) 
version, and Internet Explorer version.

Also, please describe any recent changes in your 
hardware, software, or the configuration of your system.

System Data Store Which machines contain folders in the system data store?

Error Messages Record the exact wording of any error messages you 
receive and the point in the software where the error 
occurred, as well as any log files.

Attempted Solutions Record any steps that you took attempting to resolve the 
problem and note all the outcomes, and provide an 
estimate on how many times the problem occurred and 
whether it can be reproduced.
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Accessing the
Sterling

Commerce
Support Web Site

The Sterling Commerce Customer Support Web Site contains valuable information about 
getting support for Gentran:Server for Windows, including the:

◗ scope of support services
◗ customer support policies
◗ call prioritizing
◗ customer support phone directory
◗ how to create new Support on Demand cases
◗ how to check the status of Support on Demand cases
◗ how to add information to Support on Demand cases

The Customer Support Web Site is constantly updated and all Sterling Commerce 
customers have access to it. This web site also contains the most recent product updates 
and is a valuable source of product information.

Reference
Refer to the Getting Started Guide for information on how to access the Customer Support 
World Wide Web Site.

Documentation The Customer Support Web Site contains a documentation library, which has the entire 
Gentran:Server for Windows documentation set. You can download the product manuals 
in PDF format from this library at any time.
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Introducing Forms Integration

Overview The Gentran:Server Forms Integration subsystem enables you to design forms to facilitate 
the keying (screen entry) and printing (print) of EDI messages that you receive inbound or 
send outbound.

What is a form? A form is a set of instructions you define in the Forms Integration subsystem that indicates 
how the system should format data. When you compile the form, Gentran:Server 
generates a translation object. After you register the translation object with Gentran:Server 
and associate the translation object with a partner relationship, the system uses the 
translation object to format EDI messages. The Forms Integration subsystem enables you 
to create print and screen entry translation objects.

What is a print
translation object?

A print translation object organises and formats the printout of EDI messages that are 
received from or sent to the trading partner(s) for which you have established a trading 
relationship (inbound or outbound) that utilises that print translation object. The print 
translation object enables you to view the EDI message in an easily readable format.

What is a screen
entry translation

object?

A screen entry translation object provides a standardised format for keying an EDI 
message into the Document Editor, for translation and transmission to your trading 
partner(s), for which you have established an outbound trading relationship that utilises 
that screen entry translation object. The screen entry translation object ensures that your 
users key all the data necessary to create the required EDI message.

Gentran:Server generates the actual format of the translation object based on the EDI file 
format (in the EDI File Format Pane), and displays it in the Layout Pane.
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Navigation

Overview The Gentran:Server Forms Integration Window allows you to access its functionality in 
four different ways, as follows:

◗ Click the menu option from the Main Menu Bar.
◗ Click the appropriate button on the Main Toolbar.
◗ Click or double-click the appropriate part of the form.
◗ Click a form component (EDI File Format Pane or Layout Pane) with the right mouse 

button to access a shortcut menu that contains all the functions that are currently 
available for that form component. The shortcut menus enable you to quickly and 
easily access available functionality. The content of the shortcut menus will vary, 
depending on the type and level of the selected form component.

Note
When you start Gentran:Server, the Main Menu Bar contains a subset of menu items. The 
full set of menu items is displayed after you create a new form or open (load) an existing 
form.
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Forms Integration
Window

This diagram illustrates the Forms Integration Window.

Forms Integration
Window parts and

functions

This table describes the parts of the Gentran:Server Forms Integration Window.

Control Menu Title Bar Minimize/Maximize Buttons

Main Menu Bar Main ToolbarStatus Bar

EDI File Format Pane Layout Pane

Part Function

 Main Menu Bar The Main Menu Bar contains the drop-down menus. 
Unavailable items are dimmed.

Note
Detailed descriptions of each of the commands on these 
menus are found in the online Help. 

Main Toolbar The Main Toolbar gives you access to some of the 
most common operations in Gentran:Server. 

(Continued on next page)
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Main Toolbar The Main Toolbar gives you access to some of the most common operations in 
Gentran:Server. Unavailable items are dimmed. The Main Toolbar is a dockable toolbar, 
so you can affix it to any edge of the client window. This diagram illustrates the Main 
Toolbar.

 EDI File Format Pane The EDI File Format Pane contains the EDI file 
format. When you click a segment or group in the EDI 
file format, the corresponding frame is displayed in the 
Layout Pane. When you click an element in the EDI file 
format, the corresponding layout component is 
highlighted in the Layout Pane.

Layout Pane The Layout Pane contains the actual format of the 
translation object. Each group (with a maximum usage 
greater than one) and repeating segment has a 
corresponding frame in the Layout Pane. When you 
click a segment or group in the EDI file format, the 
corresponding frame is displayed in the Layout Pane. 
When you click an element in the EDI file format, the 
corresponding layout component is highlighted in the 
Layout Pane.

 Status Bar The Status Bar displays status information about a 
selection, command, or process, defines menu items as 
you highlight each item in the menu, and indicates any 
current keyboard-initiated modes for typing (e.g., CAP 
for the “Caps Lock” key, NUM for the “Num Lock” 
key, etc.).

 (Contd)
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EDI File Format Pane

Overview The EDI File Format Pane (left side of the Forms Integration subsystem main window) 
contains the EDI file format. The EDI file must contain all the information that you need 
to include to either create a message using the Document Editor (screen entry translation 
object) or print messages (print translation object), so that your system can accurately 
process the data. 

Generating EDI
files

Gentran:Server will generate an EDI file for you, based on the standard (agency), version, 
transaction set, and release (for the TRADACOMS standard only) you selected. The 
system includes all the groups, segments, composites, and elements that are defined by the 
standards agency for the version of the message you selected.

Reference
See Defining the Type of Form on page 2 - 19 (print) or Defining the Type of Form on 
page 3 - 23 (screen entry) for more information on generating an EDI file when you create 
a new form. 

You will typically need to customise the system-generated EDI file by modifying the 
properties of the form components, and using specialised Gentran:Server functions to 
manipulate the EDI file structure.

Generating
specialized EDI

standard versions

If you want to use a specialised version of an EDI standard that is not available in the 
Gentran:Server standards database, it may be appropriate for you to define the EDI file 
yourself.

Regardless of whether the system generates the EDI file or you define it, the specific EDI 
form components that you will use will depend on the type of form you are creating. This 
includes the standard, version, and transaction set (message) selected, and which groups, 
segments, composites, and elements your company requires. We recommend that you 
determine which form components you will be using before generating or defining an EDI 
file.
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Form components This table described the form components that Gentran:Server uses to define the EDI file 
format.

Note
When an element has an operation performed against it, a red checkmark is displayed over 
the element icon.

Icon Description

A group is a looping structure that contains related segments 
and/or groups that repeat in sequence until either the group data 
ends or the maximum number of times that the loop is allowed to 
repeat is exhausted. Groups are defined by the EDI standards. A 
group that is subordinate to another group is a sub-group (this 
corresponds to a nested looping structure – a loop within a loop). 
The EDI file is a group and therefore, it is visually represented 
the same way as other groups and sub-groups in Gentran:Server.

A segment contains a group of related elements or composite 
data elements that combine to communicate useful data. 
Segments are defined by the EDI standards. A segment can occur 
once or can repeat multiple times. 

A composite is a data element that contains two or more 
component data elements or sub-elements. Composites are 
defined by the EDI standards that use them (EDIFACT, 
TRADACOMS, and certain ANSI X12 standards). 

An element is the smallest piece of information defined by the 
EDI standards. An individual element can have different 
meanings depending on the context. Therefore, elements are 
normally not considered to have useful meaning until they are 
combined into segments. 

◗ When a field has a mapping operation performed against it, 
a red checkmark is displayed over the field icon.

◗ When a field contains a standard rule a black asterisk 
appears to the right of the element icon.
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Layout Pane

Overview The Layout Pane (right side of the Forms Integration subsystem main window) contains 
the actual format of the translation object. Gentran:Server uses frames to format the EDI 
file for the translation object. Each frame contains the groups, repeating segments, and 
elements at that level (single segments are not represented on the frame). 

List formats For screen entry translation objects, groups (with a maximum usage greater than one) and 
repeating segments are formatted as list boxes. Elements are formatted as edit boxes 
(fields) or drop-down list boxes on the frame. Elements will typically be formatted as 
fields, but will be formatted as a drop-down list box if you apply a standard rule that 
allows a selection of multiple items. Each group and repeating segment also has a 
corresponding frame that contains all the groups (with a maximum usage greater than 
one), repeating segments, and elements at that level. 

Field formats For print translation objects, groups, repeating segments, and elements are always 
formatted as fields. Each group and repeating segment also has a corresponding frame that 
contains all the groups (with a maximum usage greater than one), repeating segments, and 
elements at that level.

Displaying
information

When you click a segment or group in the EDI File Format Pane, the corresponding frame 
is displayed in the Layout Pane. When you click an element in the EDI File Format Pane, 
the corresponding layout component is highlighted in the Layout Pane.
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Building a Form with Forms Integration

Overview This section defines how to proceed with building a form using the Gentran:Server Forms 
Integration subsystem.

Stages of building
a form

This table describes the steps required to build a form using Forms Integration.

Stage Description

1 Prepare and Analyse.
Obtain a layout of how you want the form to be displayed and determine 
how it corresponds to the EDI standard you will be using. Determine what 
operations need to be performed to generate the required layout.

2 Set Global Defaults (first time only).
The first time you use Gentran:Server, you should establish the default 
date format that the system will use. 

Reference
See Verifying the Global EDI Date Formats on page 2 - 18 (print) or 
Verifying the Global EDI Date Formats on page 3 - 22 (screen entry) for 
more information.

3 Create, Save, and Name a New Form.

Reference
See Design and Create the Form on page 2 - 18 (print) or Design and 
Create the Form on page 3 - 22 (screen entry) for more information.

4 Activate the Appropriate EDI Groups, Segments, Composites, and 
Elements.

Reference
See Activating Groups, Segments, Composites, and Elements on 
page 2 - 24 (print) or Activating Groups, Segments, Composites, and 
Elements on page 3 - 28 (screen entry) for more information.

5 Promote, Split, and Change Segments and Groups.

Reference
See Modify Form Components on page 2 - 31 (print) or Modify Form 
Components on page 3 - 35 (screen entry) for more information on 
promoting, splitting, and changing segments and groups.

6 Customise the EDI Data.

Reference
See Customise the EDI Data on page 2 - 39 (print) or Customise the EDI 
Data on page 3 - 44 (screen entry) for more information.

(Continued on next page)
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7 Define the Layout of the Form.

Reference
See Verifying EDI Delimiters on page 2 - 28 (print) or Verifying EDI 
Delimiters and Adding Frame Help Text on page 3 - 31 (screen entry) for 
more information on customising your EDI file, including verifying the 
EDI delimiters.

8 Compile the Form.

Reference
See Compiling the Form on page 2 - 98 (print) or Compiling the Form on 
page 3 - 160 (screen entry) for more information on compiling the form 
and translation object naming conventions.

9 Print the Report.
Validate and review the form, and make modifications as needed. 

Reference
See Printing the Report on page 2 - 100 (print) or Printing the Report on 
page 3 - 162 (screen entry) for more information.

10 Test the Translation Object.
For a screen entry translation object, create a new message in Document 
Editor, using the screen entry translation object. For a print translation 
object, print a message. Verify that the output is correct. 

Reference
See Testing the Translation Object on page 2 - 101 (print) or Testing the 
Translation Object on page 3 - 163 (screen entry) for more information.

 (Contd)
Stage Description
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How to Launch Forms Integration

Overview This section describes how to launch the Forms Integration subsystem by means of 
Gentran:Server.

Procedure Use this procedure to launch the Forms Integration subsystem. 

Step Action

1 Select Programs from the Windows Start menu. 

2 Select Gentran Server Forms Integration from the Gentran Server 
Programs group. 

System Response
The system displays the Forms Integration subsystem.
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How to Install Gentran Standards

Overview Note
You need to install Gentran Standards only if you installed Integration Components during 
the Gentran:Server installation.

Reference
See the appropriate Gentran:Server Standards card for information about installing the 
Gentran Standards.
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Overview 0

Introduction

In this chapter This chapter includes the following topics associated with creating a print form:

◗ Form analysis
◗ Creating, saving, and setting up a new form
◗ Customising the form, including the groups, segments, and elements
◗ Formatting the form, including fields and field labels
◗ Finalizing the form

Purpose of this
tutorial

This tutorial explains how to customise and format a form before it is compiled into a 
translation object. The form that you create is a source form. After that source form is 
compiled, the result is a compiled translation object. You must register the translation 
object with Gentran:Server before you can use the translation object to print messages of 
that type.

Form criteria Gentran:Server generates a basic form based on the following criteria you specify:

◗ Type of form (e.g. print or screen entry)
◗ Standard agency (e.g. TRADACOMS, EDIFACT)
◗ Standard version (e.g. ANA001, 92.1)
◗ Message type (e.g. ORDERS, INVOIC)
◗ Release (message version) (e.g. 9)

Mandatory
components

All mandatory groups, segments, composites, and elements for the standard, version, and 
message you specify are available for use (activated) when Gentran:Server creates a form. 
Only these mandatory form components (groups, segments, composites, and elements) are 
activated automatically. You must activate additional form components to accommodate 
the data you expect to receive from your trading partner, and then customise and format 
the form so that it is appropriate and useful for your company’s needs.
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Before you begin Before you begin to customise a print form, you should be familiar with the following 
elements of form design:

◗ EDI standards (how EDI standards work and how the information your users need is 
translated to and from the standards)

◗ Your users (the individuals who will be using the print forms to create printouts of 
processed EDI data)

◗ Your trading partners (the organisations that send you or that you send the EDI data to 
be processed and printed)

You can create a different print form for each combination of message, trading partner, 
standard version, and release. There is no limit to the number of print forms you can 
create, and the number of print forms you create is not affected by the number of screen 
entry forms you create.

Recommendation
We recommend that you mock up a layout of the print form the way you ultimately want it 
to look. As you are designing the layout, you should take into consideration the people 
who will be using the printouts. Make sure that the form makes sense to the people who 
will be using it. By analysing your company’s needs before you actually create the print 
form, you will reduce the amount of time spent later on redesigning or reformatting the 
form. Specifically, you should include the following design considerations in your form 
planning:

◗ Which fields should be printed, and which are necessary for the EDI data but do not 
need to be displayed on the printout

◗ Where fields should be located on the form
◗ What labels you will use to identify the fields on the form

Note
Press F1 from any area of the system to access the online Help for that function. The 
online Help system contains field definitions and other detailed information.
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Phases of Designing a Form

Design phases There are four phases in designing a form. These phases generally are completed in the 
order in which they are listed below, although the form design process is an iterative one 
(that is, the phases may overlap). This tutorial is designed to guide you through each of 
these four phases in sequential order, completing one phase before proceeding to the next. 
However, when you create your own forms, the phases may overlap, and usually you will 
return to one or more of the phases several times before the form is completed.

Phase Description

1 Analyse the EDI file.

2 Design and create the form.

3 Modify form components.

4 Customise the EDI data.

5 Format the form.

6 Finalize the translation object.



Getting Started Creating a Print Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

2 - 6

Getting Started

Overview This tutorial is meant to be completed in its entirety. We strongly recommend that you 
complete each task sequentially. The purpose of completing each task in this tutorial in 
sequential order, as if it were your own scenario, is not only to teach you how to perform 
the individual tasks, but also to teach you a logical approach and methods that should be 
used when you create your own form.

This section guides you in completing the steps in the first phase of form design. In this 
section, you will create a new print form based on a scenario we have defined for you. 
This section includes the basics of creating the form, such as defining the scenario and 
analysing the purpose of the form, creating and saving the form, and setting up the form. 
You can find techniques for customising the segments, elements, and groups in the form, 
as well as for formatting the organisation and appearance of the form, later in this chapter.

Print form
scenario

For this tutorial, you will create a print form for the ORDERS message (purchase order), 
using the TRADACOMS ANA001 release 9 standard. The steps involved in creating this 
form are broken down into manageable pieces so that you can learn the tasks and 
procedures involved in creating a print form. Then, you can apply the knowledge gained 
from using this tutorial to create your print forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a wide 
variety of pet supplies for pet stores. You will create a form that formats and arranges the 
EDI data you receive from one of your trading partners, Pet Zone (a large pet supply 
retailer), to produce a printout of a purchase order. You do not want to alter the integrity of 
the EDI data. However, you will want to interpret some of the codes included in the EDI 
message into more meaningful text.
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Analyse the EDI File 0

Basic Tasks

Introduction To analyse the EDI file, first you must determine what data your trading partner will send 
you. You and your partner must agree on which standard, version, message, and release 
you will be using. In this tutorial, you are using a TRADACOMS ANA001 ORDERS 
release 9 purchase order. It is important to know the information that your partner will 
send you in the purchase order, and what data will be contained in each element used.

It is very helpful to review the EDI standard that you will use before analysing the EDI 
file. We recommend that you obtain an EDI standard manual for the standard and version 
that you will use. Standard manuals are available from EDI standard agencies.

The TRADACOMS standard uses a header with each interchange (ORDHDR for the 
ORDERS message). The header message contains information that pertains to each 
message in the interchange. Gentran:Server copies the header segments to the beginning 
of each document, to ensure that all the relevant information is contained in the document. 
Therefore, you will need to load the header message (ORDHDR) into the ORDERS EDI 
file, so that all the segments and elements are available for use.

After discussing with your partner what they will send, determining which segments and 
elements your company requires, and reviewing the EDI standard, you can list the items 
that you will need to use. Then, you will make the form components you need available 
for use (activate). When Gentran:Server generates the EDI file format, the system includes 
all the groups, segments, composites, and elements that are defined by the standard agency 
for the version of the message you selected. The system activates all the groups, segments, 
composites, and elements that are defined as mandatory (must be present) by the standard. 
The system does not enable you to deactivate mandatory groups, segments, composites, 
and elements.
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Mandatory
components

For a TRADACOMS ANA001 ORDERS release 9 purchase order, the following groups, 
segments, composites, and elements have been defined as mandatory by the standards 
committee. 

This table describes the components that are activated automatically when you create a 
new form.

When translating data, the system does not process groups, segments, composites, and 
elements that are not activated. Therefore, you must make available (activate) the form 
components that are not defined as mandatory by the standard, but that you have 
determined you need to use in the form.

Group Segment Composite Element Description

ORDHDR Order File Header

TYP Transaction Type Details

CD02 Transaction Code

SDT Supplier Details

SIDN

CDT Customer Details

CIDN

FIL File Details

FLGN File Generation Number

FLVN File Version Number

FLDT File Creation Date

CLO Customer’s Location

CLOC

ORD Order References

ORNO

OLD

OTR Order Trailer

LORD Lines Ordered
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Form analysis The first step in creating a form is the analysis of the form requirements. If the analysis 
you perform is complete, you will have all the information you need to create the form in 
an efficient and logical manner. If you omit this critical step and proceed directly to 
creating the form, it is likely that creating the form will be a much longer and arduous 
task, and the form may not work the way you need it to, due to oversights and omissions.

Creating a print form for the TRADACOMS ORDERS purchase order requires several 
steps. Some steps are performed at the message level (such as activating form 
components), and others are iterative steps that are performed for each group, segment, or 
element in the form. In this analysis phase, you must determine what EDI data Pet Zone 
will be sending you, as well as what information you want to print for the purchase order. 
The fields on the form must accommodate all information that you want to print from the 
purchase order your trading partner sends you.

Required
components

This table lists the form components that are required (need to be activated) and are not 
mandatory for the standard.

Note
When you activate a conditional group, segment, or composite, the mandatory subordinate 
segments, composites, and elements are activated automatically. A conditional group, 
segment, or composite is used only if there is EDI data available for an element in it.

Element Description
Data
Type Length

Code Value/Format 
to Be Assigned

Order File Header (ORDHDR Group) (Already Activated)

Supplier Details (SDT Segment) (Already Activated)

SDT SIDN SID0 Supplier’s ANA 
Location Code

String 13

SDT SNAM Supplier’s Name String 40

Customer Details (CDT Segment) (Already Activated)

CDT CIDN CID0 Customer’s ANA 
Identity/Loc

String 13

CDT CNAM Customer’s Name String 40

CDT CADD CAD0 Customer’s Address 
Line 1

String 35

CDT CADD CAD1 Customer’s Address 
Line 2

String 35

CDT CADD CAD2 Customer’s Address 
Line 3

String 35

(Continued on next page)
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CDT CADD CAD3 Customer’s Address 
Line 4

String 35

CDT CADD CAD4 Customer’s Post Code String 8

Customer’s Location (CLO Segment) (Already Activated)

CLO CLOC CLO0 Customer’s ANA 
Location Code

String 13

CLO CNAM Customer’s Name String 40

CLO CADD CAD0 Customer’s Address 
Line 1

String 35

CLO CADD CAD1 Customer’s Address 
Line 2

String 35

CLO CADD CAD2 Customer’s Address 
Line 3

String 35

CLO CADD CAD3 Customer’s Address 
Line 4

String 35

CLO CADD CAD4 Customer’s Post Code String 8

Order References (ORD Segment) (Already Activated)

ORD ORNO ORN0 Customer’s Order 
Number

String 17

ORD ORNO ORN2 Date Order Placed by 
Customer

Dt/Tm 6 Screen Format = 
DD/MM/YY

ORD CD07 Order Code String 1 Any valid code

Delivery Instructions (DIN Segment)

DIN LDAT Latest Delivery Date Dt/Tm 6 Screen Format = 
DD/MM/YY

Order Line Details (OLD Group) (Already Activated)

Order Line Details (OLD:2 Segment)

OLD:2 SPRO SPR1 Supplier’s Code for the 
Traded Unit

String 30

OLD:2 CPRO CPR1 Customer’s Item Code String 30

(Continued on next page)

 (Contd)
Element Description

Data
Type Length

Code Value/Format 
to Be Assigned
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Segment analysis For each segment activated (either mandatory or optional), you must answer the following 
questions:

◗ Is the segment a group?
◗ Will the segment have a maximum use greater than one?
◗ What composites and elements need to be activated for the segment?

This table describes the segment components used in this tutorial.

OLD:2 UNOR UNO0 Consumer Units in 
Traded Unit

String 15 Format = N0

OLD:2 UNOR CD04 Measure Indicator String 6

OLD:2 OQTY OQT0 Number of Traded Units 
Ordered

String 15 Format = N0

OLD:2 OUCT OUC0 Cost Price Real 14 Screen Format = R4

OLD:2 TDES TDE0 Traded Unit Descr. Line 
1

String 40

OLD:2 TDES TDE1 Traded Unit Descr. Line 
2

String 40

 (Contd)
Element Description

Data
Type Length

Code Value/Format 
to Be Assigned

Component Description

Group Contains related segments and/or groups that repeat in 
sequence until either the group data ends or the maximum 
number of times that the loop is allowed to repeat is 
exhausted.

Repeating segment Consists of elements that repeat (in sequence) until either the 
data ends or the maximum number of times the segment is 
allowed to repeat is exhausted.

Composite Contains two or more component data elements or 
subelements. Composites are defined by the EDI standards 
that use them (TRADACOMS, EDIFACT, and certain ANSI 
X12 standards).

(Continued on next page)
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Customisation
tasks

Gentran:Server generates a form based on the groups, segments, composites, and elements 
you activate. At this point, the form is compliant with the standard and it contains all the 
necessary components based on the data Pet Zone will send you. However, you need to 
customise the form components to produce a printed report that looks the way your 
company expects it to look.

This table lists the customisation tasks described in this tutorial.

Maximum use Refers to the number of times that a segment can be used 
within the structure in which the segment is defined. For 
example, if a segment can be used only once within a group, 
but the group can be used multiple times, the segment still 
has a maximum use of one within each occurrence of the 
group. The standard defines the maximum number of times 
a segment can be used, but you must determine which of 
these segments will be used, based on what your trading 
partner will be sending you.

Elements Each segment contains elements. Some elements are 
mandatory and others are optional to the standard but 
necessary for your needs. You must define all the elements 
that you will be expecting from Pet Zone for each segment.

 (Contd)Component Description

Form Component Description Customisation Task

ORDHDR group Order File Header You will promote this group so that the 
fields in this group are placed on the 
parent frame.

TYP CD02 element Transaction Code This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

SDT SIDN SID0 
element

Supplier’s ANA 
Location Code

This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

SDT SNAM 
element

Supplier’s Name This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

(Continued on next page)
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CDT CIDN CID0 
element

Customer’s ANA 
Identity/Loc

This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

CDT CNAM 
element

Customer’s Name You will change the field name to 
“Customer”, which better describes the 
data in this field for your company.

CDT CADD CAD0 
element

Customer’s 
Address Line 1

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CDT CADD CAD1 
element

Customer’s 
Address Line 2

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CDT CADD CAD2 
element

Customer’s 
Address Line 3

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CDT CADD CAD3 
element

Customer’s 
Address Line 4

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CDT CADD CAD4 
element

Customer’s Post 
Code

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

FIL FILGN 
element

File Generation 
Number

This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

FIL FILVN element File Version 
Number

This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

FIL FILDT element File Creation Date This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

CLO CLOC CLO0 
element

Customer’s ANA 
Location Code

This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

(Continued on next page)

 (Contd)
Form Component Description Customisation Task
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CLO CNAM 
element

Customer’s Name You will change the field name to 
“Location”, which better describes the 
data in this field for your company.

CLO CADD CAD0 
element

Customer’s 
Address Line 1

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CLO CADD CAD1 
element

Customer’s 
Address Line 2

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CLO CADD CAD2 
element

Customer’s 
Address Line 3

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CLO CADD CAD3 
element

Customer’s 
Address Line 4

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

CLO CADD CAD4 
element

Customer’s Post 
Code

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

ORD ORNO 
ORN0 element

Customer’s Order 
Number

You will set up the document name (which 
enables you to differentiate between 
messages in the document browsers in 
Gentran:Server) in this element. Also, you 
will change the field name to “Order 
Number”, which better describes the data 
in this field for your company.

ORD ORNO 
ORN2 element

Date Order Placed 
by Customer

You will change the field name to “Order 
Date”, which better describes the data in 
this field for your company. Also, the date 
in the EDI data will be in the format 
“YYMMDD”, but you want the date to be 
printed in the format “DD/MM/YY”, so 
you will set the screen format accordingly. 
In addition, you will change the field and 
element lengths to reflect the longer date 
format.

(Continued on next page)

 (Contd)
Form Component Description Customisation Task
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ORD CD07 
element

Order Code The code from this element will be used to 
look up the description in a code values 
list, and the description will be printed in 
another field that you create. You will 
prevent the Order Code field from being 
displayed on the printout, because the 
more meaningful description will be 
printed instead.

DIN LDAT element Latest Delivery 
Date

The date in the EDI data will be in the 
format “YYMMDD”, but you want the 
date to be printed in the format “DD/MM/
YY”, so you will set the screen format 
accordingly. Also, you will change the 
field and element lengths to reflect the 
longer date format.

OLD group Order Line Details After you customise and format the fields 
in the OLD group, you will copy and paste 
the OLD group at the same level in the 
EDI file. The original OLD group will 
contain column headings for the line item 
detail, but you will prevent the column 
headings from being printed for all line 
items after the first. You will change the 
maximum use of the first OLD group to 
one so that the column headings are 
printed only once (for the first line item). 
You will change the maximum use of the 
second OLD group to 999,998. Up to 
999,999 line items (one from the first 
OLD group and 
999,998 from the second OLD group) can 
be printed on the printout (without 
printing the column headings for each line 
item).

OLD:2 SEQA 
element

First Level 
Sequence Number

The standard allows a maximum length of 
ten digits, but you expect a number no 
longer than five digits from your partner. 
You will change the maximum length of 
the element and the display length of the 
field to five. You will change the field 
name to “Line”, which better describes the 
data in this field for your company.

(Continued on next page)

 (Contd)
Form Component Description Customisation Task
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OLD:2 SPRO 
SPR1 element

Supplier’s Code for 
the Traded Unit

The standard allows a maximum length of 
thirty characters, but you expect a string 
no longer than ten characters from your 
partner. You will change the maximum 
length of the element and the display 
length of the field to ten. You will change 
the field name to “Prod ID”, which better 
describes the data in this field for your 
company.

OLD:2 CPRO 
CPR1 element

Customer’s Item 
Code

This element is required in the purchase 
order, but is not meaningful for your 
purposes. Therefore, you will prevent this 
field from being printed on the printout.

OLD:2 UNOR 
UNO0 element

Consumer Units in 
Traded Unit

The standard allows a maximum length of 
fifteen characters, but you expect a 
number no longer than ten digits from 
your partner. You will change the 
maximum length of the element and the 
display length of the field to ten. Also, you 
will change the data type from string to 
number, and assign EDI and screen 
formats of N0 (indicating a number with 
an implicit decimal point and no decimal 
places). In addition, you will change the 
field name to “Cons. Units”, which better 
describes the data in this field for your 
company.

OLD:2 UNOR 
CD04 element

Measure Indicator You will change the field name to “Unit”, 
which better describes the data in this field 
for your company.

OLD:2 OQTY 
OQT0 element

Number of Traded 
Units Ordered

The standard allows a maximum length of 
fifteen characters, but you expect a 
number no longer than six digits from 
your partner. You will change the 
maximum length of the element and the 
display length of the field to six. Also, you 
will change the data type from string to 
number, and assign EDI and screen 
formats of N0 (indicating a number with 
an implicit decimal point and no decimal 
places). In addition, you will change the 
field name to “Qty Ord”, which better 
describes the data in this field for your 
company.

(Continued on next page)
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OLD:2 OUCT 
OUC0 element

Cost Price The standard allows a maximum length of 
fourteen digits, but you expect a number 
no longer than ten digits from your 
partner. You will change the maximum 
length of the element and the display 
length of the field to ten. Also, you will 
change the screen format of the data to R4 
(indicating a number with an explicit 
decimal point and four decimal places). In 
addition, you will change the field name to 
“Price Each”, which better describes the 
data in this field for your company.

OLD:2 TDES 
TDE0 element

Traded Unit Descr. 
Line 1

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

OLD:2 TDES 
TDE1 element

Traded Unit Descr. 
Line 2

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

OTR segment Order Trailer You want this segment to print the total 
number of line items at the end of the 
printout. However, if the form were 
generated now, the total would be printed 
at the beginning of the printout (because 
the fields in the OTR segment would be 
displayed on the same frame as the fields 
in the ORDHDR group). You will change 
the arrangement of the form, while 
maintaining the integrity of the EDI data, 
so the total is printed at the end of the 
purchase order.

OTR LORD 
element

Lines Ordered You will change the field name to 
“Number of Line Items”, which better 
describes the data in this field for your 
company.

 (Contd)
Form Component Description Customisation Task



Verifying the Global EDI Date Formats Creating a Print Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

2 - 18

Design and Create the Form 0

Verifying the Global EDI Date Formats

Introduction Gentran:Server enables you to customise the global EDI date formats (for all forms). You 
can specify the default EDI format of dates for both six-character dates and eight-
character dates. When you customise the global EDI date formats, the settings are valid 
for all forms created in the current session of Gentran:Server. However, you can override 
the default date formats for an individual element on the Element Properties dialogue for 
that element.

You must verify that you are using the correct global date formats the first time you use 
Gentran:Server. Typically, you will verify the global EDI date formats one time only. You 
can change the default date formats if they do not match the formats you intend to use.

Procedure Use this procedure to verify the global EDI date formats.

Step Action

1 Select Preferences from the Options menu to display the Preferences 
dialog. The Preferences dialog is a property sheet that enables you to set 
global defaults for Gentran:Server.

2 Verify that the Standard Formats tab displays the default date formats that 
are used when elements are read from the standards database.

3 Verify that the Six-character dates drop-down list box contains 
YYMMDD to define the format of the six-character EDI dates in your 
forms.

4 Verify that the Eight character dates drop-down list box contains 
YYYYMMDD to define the format of the eight-character EDI dates in 
your forms.

5 Click OK to accept the default date formats for 6- and 8-character date 
fields and exit the Preferences dialog.

Note
To change the order in which the date formats appear in the Six-character 
dates and Eight character dates drop-down list boxes or to add a new date 
format to the lists, select Date Formats from the Options menu.
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Defining the Type of Form

Overview The first task in creating a new form is to define the type of form and EDI standard, 
version, transaction (message), and release. In this tutorial, you are creating a print form 
so that you can print the purchase orders that your partner sends you. Instead of defining 
the ORDERS message to the system yourself, you want Gentran:Server to use the 
standards database on your system to build the purchase order according to the 
TRADACOMS standard.

Procedure Use this procedure to create the new print form.

Step Action

1 Select New from the File menu to display the New Form Wizard.

2 From the What kind of form list, select Print to indicate that the 
translation object you are creating is a print translation object.

3 In the What is the name of the form box, enter Print TRADACOMS 
ORDERS Pet Zone. This description provides a brief explanation of the 
compiled translation object that enables you to differentiate it from similar 
translation objects in Gentran:Server.

Example
Print TRADACOMS ORDERS Pet Zone is the description of a 
TRADACOMS ANA001 purchase order (ORDERS) for partner Pet Zone.

4 Verify that the name that appears in the What is your name box is 
accurate.

5 Click Next to advance the wizard.

6 Select Delimited EDI as the data format syntax that you want to use.

7 Click Customise.

System Response
The system displays the New Delimited EDI Wizard.

8 Click Next to continue.

9 From the Data Source list, select Gentran Standards ODBC data source.

10 Click Next to continue.

11 From the Agency list in the Standards section, select [A] Tradacoms, 
which is the EDI standard you will use for this translation object.

(Continued on next page)
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12 From the Version list, select [ORDERS] ORDER DETAILS, which is 
the version of the standard you use for this translation object. The versions 
that are available depend on which standard you selected.

13 From the Transaction list, select [850] PURCHASE ORDER, which is 
the transaction set (document) you use for this translation object. The 
documents that are available depend on which standard and version you 
selected.

14 From the Release drop-down list, select 9, which is the message version 
you will use for this translation object. The message versions that are 
available depend on which message (transaction) you selected.

15 Click Next to continue.

16 Click Finish. This may take a few seconds.

System Response
The system displays the New Form Wizard dialog box.

17 Click Next to continue.

18 Click Finish to create the EDI file (it may take a few seconds to create the 
file). 

System Response
The form is displayed as follows:

19 From the Edit menu, select Details.

System Response
The Translation Object Details box is displayed.

20 Verify that Print is selected from the Translation Object Function list.

(Continued on next page)
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21 In the Major version box, enter 1 to designate the version number for this 
translation object.

22 In the Minor version box, accept the default value 0 that designates the 
release number for this translation object.

Hint
When you make a major change to this form, increase the version to the 
next higher sequential number (e.g., 2.0, 3.0). If you make a minor change 
to the form, increase the release to the next higher sequential number (e.g., 
2.1, 2.2).

23 The Input and Output boxes (Agency, Version, Transaction, Release, and 
F Group) contain information only if the Input and/or Output sides of the 
form are of EDI format. For this tutorial, do not change the information in 
these boxes.

Note
The system allows you to change the information in the Input and Output 
boxes, but modifying this information does not alter the content of the 
form. An example of when you might want to alter these boxes is when 
you want the form to reflect a standard version that is not loaded on your 
system. You can change the version on this dialog, and then physically 
alter the form to be compliant with that version.

24 Click OK to save the translation object details.

25 Select Save from the File menu.

Recommendation
We recommend that you save the form as often as possible, to mitigate the 
possible loss of additions or modifications in the event of a hardware or 
system error.

Note
If you have performed any function that invalidates the current format of 
the translation object, the Save function is unavailable until you 
regenerate the layout (click Generate Layout on the Main Toolbar).

26 Verify that the Save in list reflects the drive\folder where Gentran:Server 
is installed.

Default
The default drive\folder is GENSRVNT\Forms.

(Continued on next page)
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27 In the File name box, enter pettordp.stp to replace the default file name. 
You allocate a file name to a form when you save the form for the first 
time or use the Save As function to save a copy of the form under a 
different name. The name of the form must be one to eight unique 
characters that define the form in a meaningful way. For example, 
“PET_850P” is the name of a print form for an ANSI X12 purchase order 
message (850) for partner Pet Zone.

Note
The default file extension for forms is .STP. Using this extension 
distinguishes source form files from other types of files, such as compiled 
translation objects. The naming conventions in Gentran:Server are as 
follows:

◗ The source form (form created in Gentran:Server) should be named 
using the file extension .STP (e.g., PET_850P.STP).

◗ The compiled translation object (translation object that is the result of 
compiling the source form) should be named using the same file 
name that was allocated to the source form, but with the file extension 
.TPL (e.g., PET_850P.TPL).

Recommendation
We recommend that you use these naming conventions to distinguish 
source forms and compiled translation objects from other types of files. 
We also recommend that you use the same file name (different file 
extension) for a source form and the translation object that was compiled 
from it.

28 Click Save to save the form.

 (Contd)
Step Action
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Loading the ORDHDR Message

Overview The TRADACOMS standard uses a header with each interchange (ORDHDR for the 
ORDERS message). The header message contains information that pertains to each 
message in the interchange. Gentran:Server copies the header segments to the beginning 
of each document, to ensure that all the relevant information is contained in the document. 
Therefore, you need to load the header message (ORDHDR) into the ORDERS EDI file, 
so that all the segments and elements are available for use.

Procedure Use this procedure to load the ORDHDR message into the ORDERS EDI file.

Step Action

1 Click the ORDERS EDI file icon to select it.

2 Select Create Sub from the Edit menu.

3 Select Transaction Set from the Create Sub cascading menu. You will be 
prompted to select an ODBC data source name. Select the appropriate 
DSN and click OK to display the Insert Transaction Set From Standards 
dialogue.

4 From the Agency drop-down list box, select [A] Tradacoms, which is the 
EDI standard you will use for the inserted message.

5 From the Version drop-down list box, select [ANA001], which is the 
version of the standard you will use for the inserted message. The versions 
that are available depend on which standard you selected.

6 From the Transaction drop-down list box, select [ORDHDR] ORDER 
FILE HEADER, which is the transaction set (message) you will use for 
the inserted message. The transactions that are available depend on which 
standard and version you selected.

7 From the Release drop-down list box, select 9, which is the message 
version you will use for the inserted message. The message versions that 
are available depend on which message (transaction) you selected.

8 Click OK to load the ORDHDR message into the ORDERS EDI file as a 
subordinate group.
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Activating Groups, Segments, Composites, and Elements

Overview When Gentran:Server generates the form, the system includes all the groups, segments, 
composites, and elements that are defined by the standard agency (TRADACOMS) for the 
version (ANA001), message (ORDERS), and release (9) you selected. The system 
activates all the groups, segments, composites, and elements that are defined as mandatory 
(must be present) by the standard. The system does not enable you to deactivate the 
mandatory groups, segments, composites, and elements.

Example In the example below, the CLO segment and CLO CLOC composite are mandatory for the 
purchase order. You do not need to activate these components. The CLO CLOC CLO0, 
CLO CLOC CLO1, CLO CLOC CLO2, and CLO CNAM elements and the CLO CADD 
composite are not mandatory, so they are dimmed on the form. To view the segments, 
composites, and elements in a group, segment, or composite on your form, double-click 
the form component in the EDI File Format Window (left side of the Forms main 
window). To activate an inactive form component, click Activate on the Main Toolbar, 
then click the form component. The component is no longer dimmed.

You must activate the groups, segments, composites, and elements that are not defined as 
mandatory by the standard, but that you have determined that you need to use in the form.
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Groups, segments,
elements, and

composites used in
this tutorial

This table lists the groups, segments, elements, and composites used in this tutorial.

Group Segment Composite Element

ORDHDR
(already 
activated)

SDT
(already activated)

SIDN
(already activated)

SID0

SNAM

CDT
(already activated)

CIDN
(already activated)

CID0

CNAM

CADD CAD0

CAD1

CAD2

CAD3

CAD4

CLO
(already activated)

CLOC
(already activated)

CLO0

CNAM

CADD CAD0

CAD1

CAD2

CAD3

CAD4

ORD
(already activated)

ORNO
(already activated)

ORN0

ORN2

CD07

DIN LDAT
(Continued on next page)
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Procedure Use this procedure to activate the required groups, segments, composites, and elements.

OLD
(already 
activated)

OLD:2 SPRO
(mandatory for 
OLD:2)

SPR1

CPRO CPR1

UNOR
(mandatory for 
OLD:2)

UNO0

CD04

OQTY
(mandatory for 
OLD:2)

OQT0

OUCT OUC0

TDES TDE0

TDE1

 (Contd)
Group Segment Composite Element

Step Action

1 Double-click the groups, segments, and composites listed in the previous 
table to open them. The table lists all the groups, segments, composites, 
and elements that you need to activate. Opening all the necessary groups, 
segments, and composites before you start to activate enables you to scroll 
down the form and activate the segments, composites, and elements 
sequentially.

Note
When you activate a conditional group, segment, or composite, the 
mandatory subordinate segments, composites, and elements are activated 
automatically.

2 Click Activate on the Main Toolbar.

3 Click each inactive segment that you need to use. Clicking these segments 
will activate the segments.

Note
If you accidentally click a segment that you did not mean to activate, click 
the segment with the right mouse button to access the shortcut menu. 
Select Deactivate from the shortcut menu.

(Continued on next page)
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4 Click each inactive composite that you need to use. Clicking these 
composites will activate the composites.

Note
If you accidentally click a composite that you did not mean to activate, 
click the composite with the right mouse button to access the shortcut 
menu. Select Deactivate from the shortcut menu.

5 Click each inactive element that you need to use. Clicking these elements 
will activate the elements. When you activate an element in a print form, 
the tag “Printed” is displayed before that element’s description to indicate 
that this field will be printed. If you later prevent a field from being 
displayed on the printout, then the tag “Not Printed” is displayed before 
that element’s description.

Note
If you accidentally click an element that you did not mean to activate, 
click the element with the right mouse button to access the shortcut menu. 
Select Deactivate from the shortcut menu.

6 Click Activate on the Main Toolbar to turn activation mode off.

 (Contd)
Step Action
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Verifying EDI Delimiters

Overview You are using an EDI standard that contains composite elements, so you must verify that 
Gentran:Server is specifying the correct delimiters. Delimiters are flags that you define to 
the system as separating specific EDI components. Delimiters are necessary for all 
variable field-length standards, because the data is compressed (and the leading zeroes and 
trailing blanks are removed). The fields vary in length, so the system needs a flag to 
determine where one element ends and another begins. For example, an element delimiter 
marks the beginning of a new element.

Recommendation
Although verifying EDI delimiters in Gentran:Server is mandatory only if you are using a 
standard with composite elements or subelements, we recommend that you perform this 
task regardless of which standard you use.

EDI delimiters
table

This table lists the valid EDI delimiters.

Field
EDIFACT Default 

Character
EDIFACT Default Hex 

Value

Tag Delimiter = (equal sign) Ox3D

Segment Delimiter ’ (apostrophe) Ox27

Element Delimiter + (plus sign) Ox2B

Sub Element Delimiter : (colon) Ox3A

Decimal Separator . (full stop) Ox2E

Release Character ? (question mark) Ox3F
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Procedure Use this procedure to verify EDI delimiters.

Step Action

1 Click the Orders file icon with the right mouse button to access the 
shortcut menu.

2 Select Properties from the shortcut menu to display the File Format 
Properties dialogue.

(Continued on next page)
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3 Click Delimiters to access the Delimiters dialogue.

4 Verify that the correct delimiters are being used for the TRADACOMS 
standard. If the delimiters differ from the default values listed in the table 
below, you can enter either the character or the hexadecimal value in the 
correct field. The default delimiters for TRADACOMS are the following:

Note
If you use the default hex value, the value must begin with “0x” (the 
number zero and the letter “x”).

Note
The Stream segments check box on the Delimiters dialogue currently is 
not marked. For this tutorial, do not mark this check box, so the translator 
will continue to insert a carriage return after every segment. If the Stream 
segments check box is marked, then a carriage return is not used after 
every segment, and the segments are “streamed”.

5 Click OK to save the delimiters and exit the Delimiters dialogue.

6 Click Close to exit the File Format Properties dialogue.

 (Contd)
Step Action
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Modify Form Components 0

Promoting the ORDHDR Group to the Parent Frame 

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment. 
Promote is a specialised function that preserves the integrity of the EDI structure.

By default, the fields corresponding to each group and repeating segment are displayed on 
a separate frame from the rest of the fields in the message. When you promote a group to 
the parent frame, the fields corresponding to the group are displayed on the frame to which 
the group is subordinate. If you do not promote a group to the parent frame, the fields 
corresponding to the group are displayed on their own frame.

Procedure Use this procedure to promote the ORDHDR group to the parent frame.

Step Action

1 Click the ORDHDR group with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Group Properties dialogue is displayed.

2 Select the Print tab.
(Continued on next page)
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3 Click the Promote group to parent frame check box to display the fields 
in this group on the same frame as the fields in the parent group.

Note
Although this group has a maximum use of one, if you do not mark the 
Promote group to parent frame check box, then the fields in this group will 
not be displayed on the same frame in the Layout Window as the fields in 
the parent group.

4 Click OK to exit the Group Properties dialogue.

Step Action
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Creating an OTR Group

Overview The OTR segment contains Order Trailer summary information for the purchase order. If 
the form were generated now (displaying the layout of the fields in the form on the right 
side of the Forms main window), the total number of line items would be printed along 
with the ORDHDR fields at the beginning of the purchase order (because the fields in the 
OTR segment would be displayed on the same frame as the fields in the ORDHDR group). 

To print the total number of line items at the end of the printout and maintain the integrity 
of the purchase order, you must create an OTR group with a minimum use and a 
maximum use of one, then cut the OTR segment and paste it as a subordinate to the group 
you just created. By moving the OTR segment to the new OTR group that you create, the 
total number of line items will be displayed on its own frame, separate from the header 
(ORDHDR) information.

Procedure Use this procedure to create an OTR group.

Step Action

1 Select the OTR segment.

2 Select Insert from the Edit menu.

3 Select Group from the cascading menu.

System Response
The Group Properties dialogue is displayed.

(Continued on next page)
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4 In the Name field, enter OTR_Group as the segment loop identification 
code.

Caution
Do not use spaces or hyphens (-) in the Name field. You can use the 
underscore (_) to separate words

5 In the Desc field, enter OTR Group to provide a brief explanation of the 
loop.

6 Select the Looping tab.

7 In the Min Usage field, enter 1 to make this group mandatory. Changing 
the minimum use of a segment or group from zero to one changes the 
status of the segment or group from conditional to mandatory. If EDI data 
is not present for a segment or group that has a minimum use of one or 
greater, a compliance error will occur during translation for that segment 
or group.

8 Click OK to create the group. Gentran:Server prompts you that the frame 
caption for the group will default to the name of the group. (The frame 
caption is the name of the frame for the group. When the frame caption is 
not specified, then Gentran:Server uses the value in the Name field as the 
frame caption.)

9 Click OK to accept the message. 

 (Contd)
Step Action
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How to cut and
paste the OTR

segment

Use this procedure to cut and paste the OTR segment.

Step Action

1 Verify that the OTR segment is selected.

2 Click Cut on the Main Toolbar.

3 Select the OTR group, which is the group for which you want to paste the 
OTR segment as a subordinate.

4 Click Paste on the Main Toolbar to paste the OTR segment. 
Gentran:Server prompts you to specify whether you want the contents of 
the Clipboard pasted as a child (subordinate) of the selected group, or at 
the same level as the group.

5 The Paste as a child of selected item radio button is selected as the 
default. Accept the default to paste the Clipboard contents as a child 
(subordinate) of the group. Click OK to exit the dialogue.
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Generating the Form 

Overview Generating a form is different from compiling a form. When you compile a form, the 
source form is translated into a compiled translation object. When you generate a form, 
the fields of the form are displayed on a frame in the Layout Window (right side of the 
Forms main window), based on the groups, segments, and elements that are activated.

Note
You can, and should, regenerate (or refresh) the form several times as you customise and 
format the form to ensure that you are viewing the most recent changes to the Layout 
Window.

Procedure Use this procedure to generate the print form based on the groups, segments, and elements 
you activated.

Step Action

1 Select the ORDERS file icon. Selecting the ORDERS file icon before you 
generate the layout enables you to view the beginning of the purchase 
order layout in the Layout Window after the layout is generated. However, 
selecting the ORDERS file icon is not a required prerequisite to 
generating the layout.

(Continued on next page)
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2 Click Generate Layout on the Main Toolbar. 

System Response
The layout of the print form will be displayed in the Layout Window.

Note
You should regenerate the form periodically as you customise the print 
form to ensure that the most recent changes to the frame are reflected in 
the Layout Window.

When you generate the form, there is one field on the right side of your 
screen (Layout Window) for every activated element on the left side of 
your screen (EDI File Format Window). You can click either the field or 
its corresponding element to select it. To access the Element Properties 
dialogue for a field/element, either double-click the element, or use the 
right mouse button to click the field or element, then select Properties 
from the shortcut menu.

Note
When you first generate the form, each field in the Layout Window is 
labelled with the same name as its corresponding element in the EDI File 
Format Window. As you customise the form, however, you will change 
some of the labels and remove others, so all the fields will not be labelled 
the same as their corresponding elements. Even though you will change or 
remove some field labels, each field still will correspond to one element.

 (Contd)
Step Action
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After generating
the form

After the print form is generated, each group and repeating segment has a corresponding 
frame in the Layout Window that contains all the groups, segments, and elements at that 
level. Fields in groups or segments that have a maximum use of only one are displayed on 
the frame corresponding to the group to which the groups or segments are subordinate. For 
example, the following fields are displayed on one frame (all the groups and segments in 
which these fields are contained are subordinate to the same group):

◗ Transaction Code (TYP CD02)
◗ Supplier’s ANA Location Code (SDT SIDN SID0)
◗ Supplier’s Name (SIDN SNAM)
◗ Customer’s ANA Identity/Loc (CDT CIDN CID0)

Note
There are several other fields on this frame. All of the fields on this frame are subordinate 
to the same group.

In print forms, the frames are not titled in the Layout Window (as they are in screen entry 
forms). To identify the frame that currently is displayed, click one of the fields on the 
frame, then check the EDI File Format Window to determine in which segment or group 
the field is contained.
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Customise the EDI Data 0

Overview

Introduction You can customise the form, including the properties of each type of form component 
(group, segment, and element).

Customising the form is an iterative process. This tutorial guides you through all the steps 
involved in customising the form, component by component. When you create print 
forms, you usually will activate the form components you need to use, then compile the 
form, test it, and print the EDI data using the compiled translation object. As you 
substantially customise the form, you usually will compile and print the form several 
times to view your changes before the form truly is finalised.

This section explains how to customise the form components for each sequential 
component.

How to set up the
document name

We recommend that you set up a Document Name for each form. The document name 
makes the identification of a message created by the form easier in Gentran:Server. Setting 
up the document name enables you to differentiate between messages in the document 
browsers in Gentran:Server. If you set up the document name in the Forms Integration 
subsystem, the Name field of the document browsers that contain this message in 
Gentran:Server will contain the data from that element. You can choose any element as the 
document name, but we strongly recommend that you select an element that occurs only 
once in the message and has a data type of string. For a TRADACOMS ANA001 
ORDERS release 9 purchase order, the document name usually is the Customer’s Order 
Number.

Use this procedure to set up the document name.

Step Action

1 Double-click the ORD ORNO ORN0 element. 

System Response
The Element Properties dialogue is displayed.

Note
In this tutorial, we recommend that you select this element because it is a 
non-recurring and mandatory element, and it will help identify this 
message meaningfully in Gentran:Server.

2 Select the Use Standard Rule tab.

3 Select the Update option.
(Continued on next page)



Overview Creating a Print Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

2 - 40

4 From the Table/Group drop-down list box, select Document record to 
indicate that you are updating the document record in Gentran:Server.

5 From the Column/Field drop-down list box, select Document Name to 
indicate that you are updating the Name field in the document browsers 
with the contents of the ORD ORNO ORN0 element.

The dialogue now should look like this:

6 Click OK to set up the document name.

 (Contd)
Step Action
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Customising the ORDHDR Group

Overview The ORDHDR group (Order File Header) is used to print the header details pertaining to 
the ORDERS message. You already promoted this group to the parent frame (the 
ORDERS file).
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Customising the TYP Segment

Overview The TYP segment (Transaction Type Details) contains the transaction code for this 
message. 

How to customise
the TYP CD02

element

The TYP CD02 element (Transaction Code) is a mandatory element that contains the code 
for the type of orders that follow (e.g. new orders, cancelled orders, etc.). You do not need 
to print the code on the printout, so you will prevent (hide) the Transaction Code field 
from being printed.

Use this procedure to prevent the Transaction Code field from being printed.

Step Action

1 Double-click the TYP CD02 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.
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Customising the SDT Segment

Overview The SDT segment (Supplier Details) contains details about the supplier. In this tutorial, 
the supplier is your company, MWT Manufacturing Co.

How to customise
the SDT SIDN
SID0 element

The SDT SIDN SID0 element (Supplier’s ANA Location Code) contains the code 
assigned by the Article Numbering Association for the supplier’s location. Your trading 
partner will send you this code, but you do not need the code to be printed on the printout. 
Therefore, you will hide this field.

Use this procedure to hide the Supplier’s ANA Location Code field.

How to customise
the SDT SNAM

element

The SDT SNAM element (Supplier’s Name) contains the name of the supplier (in this 
tutorial, you are the supplier). Your trading partner will send you this name, but you do not 
need the name to be printed on the printout. (All purchase orders you receive from 
customers should have your company designated as the supplier.) Therefore, you will hide 
this field.

Use this procedure to hide the Supplier’s Name field.

Step Action

1 Double-click the SDT SIDN SID0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the SDT SNAM element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.
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Customising the CDT Segment

Overview The CDT segment (Customer Details) contains details about the customer (your trading 
partner, Pet Zone). In this tutorial, the CDT segment contains details relating to the Pet 
Zone corporate office.

How to customise
the CDT CIDN

CID0 element

The CDT CIDN CID0 element (Customer’s ANA Identity/Loc) contains the code 
assigned by the Article Numbering Association for the customer’s location. Your trading 
partner will send you this code, but you do not need the code to be printed on the printout. 
Therefore, you will hide this field.

Use this procedure to hide the Customer’s ANA Identity/Loc field.

How to customise
the CDT CNAM

element

The CDT CNAM element contains the Customer’s Name. For brevity, you will change the 
field label to Customer.

Use this procedure to change the field label for the Customer’s Name field.

Step Action

1 Double-click the CDT CIDN CID0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the CDT CNAM element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, enter Customer: to replace the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the CDT CADD

CAD0 element

The CDT CADD CAD0 element (Customer’s Address Line 1) contains the first line of the 
customer’s address. The address will correspond to the name in the CDT CNAM element, 
so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 1 field.

How to customise
the CDT CADD

CAD1 element

The CDT CADD CAD1 element (Customer’s Address Line 2) contains the second line of 
the customer’s address. The address will correspond to the name in the CDT CNAM 
element, so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 2 field.

Step Action

1 Double-click the CDT CADD CAD0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the CDT CADD CAD1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the CDT CADD

CAD2 element

The CDT CADD CAD2 element (Customer’s Address Line 3) contains the third line of 
the customer’s address. The address will correspond to the name in the CDT CNAM 
element, so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 3 field.

How to customise
the CDT CADD

CAD3 element

The CDT CADD CAD3 element (Customer’s Address Line 4) contains the fourth line of 
the customer’s address. The address will correspond to the name in the CDT CNAM 
element, so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 4 field.

Step Action

1 Double-click the CDT CADD CAD2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the CDT CADD CAD3 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the CDT CADD

CAD4 element

The CDT CADD CAD4 element (Customer’s Post Code) contains the post code of the 
customer’s address. The post code will correspond to the name in the CDT CNAM 
element, so you do not need to print a label for this field.

Use this procedure to remove the field label for the Customer’s Post Code field.

Step Action

1 Double-click the CDT CADD CAD4 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.
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Customising the FIL Segment

Overview The FIL segment (File Details) contains details about the ORDHDR message. These 
elements must be present in the ORDHDR message, but you do not need to print them on 
a printout.

How to customise
the FIL FLGN

element

The FIL FLGN element (File Generation Number) contains the sequential number 
assigned to this message by your trading partner. Your trading partner will send you this 
number, but you do not need the number to be printed on the printout. Therefore, you will 
hide this field.

Use this procedure to hide the File Generation Number field.

How to customise
the FIL FLVN

element

The FIL FLVN element (File Version Number) contains the number corresponding to this 
version of the message. The first version of the message is always version one, and 
subsequent copies of the message are incremented by one. Your trading partner will send 
you this number, but you do not need the number to be printed on the printout. Therefore, 
you will hide this field.

Use this procedure to hide the File Version Number field.

Step Action

1 Double-click the FIL FLGN element.

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the FIL FLVN element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.
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How to customise
the FIL FLDT

element

The FIL FLDT element (File Creation Date) contains the date on which the message was 
created. Your trading partner will send you this date, but you do not need the date to be 
printed on the printout. Therefore, you will hide this field.

Use this procedure to hide the File Creation Date field.

Step Action

1 Double-click the FIL FLDT element. 

System Response 
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.

5 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

The print form now should look like this:
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Customising the CLO Segment

Overview The CLO segment (Customer’s Location) contains details about the specific customer 
location pertaining to this purchase order. In this tutorial, the CLO segment contains 
details relating to the specific Pet Zone store to which the order should be sent. Earlier in 
this tutorial, you customised the CDT segment, which contains details relating to the Pet 
Zone corporate office.

How to customise
the CLO CLOC

CLO0 element

The CLO CLOC CLO0 element (Customer’s ANA Location Code) contains the code 
assigned by the Article Numbering Association for the customer’s location. Your trading 
partner will send you this code, but you do not need the code to be printed on the printout. 
Therefore, you will hide this field.

Use this procedure to hide the Customer’s ANA Location Code field.

How to customise
the CLO CNAM

element

The CLO CNAM element contains the Customer’s Name (for the specific location to 
which the order should be sent). For brevity, you will change the field label to Location.

Use this procedure to change the field label for the Customer’s Name field.

Step Action

1 Double-click the CLO CLOC CLO0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the CLO CNAM element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, enter Location: to replace the existing field label.

4 Click OK to exit the dialogue.



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Print Form Customising the CLO Segment 2 - 51

How to customise
the CLO CADD

CAD0 element

The CLO CADD CAD0 element (Customer’s Address Line 1) contains the first line of the 
customer’s address. The address will correspond to the name in the CLO CNAM element, 
so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 1 field.

How to customise
the CLO CADD

CAD1 element

The CLO CADD CAD1 element (Customer’s Address Line 2) contains the second line of 
the customer’s address. The address will correspond to the name in the CLO CNAM 
element, so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 2 field.

Step Action

1 Double-click the CLO CADD CAD0 element.

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the CLO CADD CAD1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the CLO CADD

CAD2 element

The CLO CADD CAD2 element (Customer’s Address Line 3) contains the third line of 
the customer’s address. The address will correspond to the name in the CLO CNAM 
element, so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 3 field.

How to customise
the CLO CADD

CAD3 element

The CLO CADD CAD3 element (Customer’s Address Line 4) contains the fourth line of 
the customer’s address. The address will correspond to the name in the CLO CNAM 
element, so you do not need to print a label for the address fields.

Use this procedure to remove the field label for the Customer’s Address Line 4 field.

Step Action

1 Double-click the CLO CADD CAD2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the CLO CADD CAD3 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the CLO CADD

CAD4 element

The CLO CADD CAD4 element (Customer’s Post Code) contains the post code of the 
customer’s address. The post code will correspond to the name in the CLO CNAM 
element, so you do not need to print a label for this field.

Use this procedure to remove the field label for the Customer’s Post Code field.

Step Action

1 Double-click the CLO CADD CAD4 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.

5 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

The section of the print form that contains the fields in the CLO segment 
now should look like this (you may need to scroll down the form to see 
these fields):
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Customising the ORD Segment

Overview The ORD segment (Order References) contains reference information pertaining to this 
purchase order, such as the purchase order number, the date the order was placed, and the 
purchase order code. 

How to customise
the ORD ORNO

ORN0 element

The ORD ORNO ORN0 element (Customer’s Order Number) contains the purchase order 
number assigned by the customer. You already used a standard rule for this element to 
assign the document name. For brevity, you will change the field label to Order Number.

Use this procedure to change the field label for the Customer’s Order Number field.

How to customise
the ORD ORNO

ORN2 element

The ORD ORNO ORN2 element (Date Order Placed by Customer) contains the date on 
which the customer placed the purchase order. You will change the screen format for the 
purchase order date to DD/MM/YY. Also, this element is defined by the standard to be a 
six-digit date. In this tutorial, the purchase order date will be printed as an eight-digit date, 
so you will change the element and field lengths to accommodate the longer date. For 
brevity, you will change the field label to Order Date. 

Use this procedure to change the screen format, change the element and field lengths, and 
rename the field label for the Date Order Placed by Customer field.

Step Action

1 Double-click the ORD ORNO ORN0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, enter Order Number: to replace the existing field 
label.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the ORD ORNO ORN2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators 
(/), to be contained in this element.

(Continued on next page)
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Customising the
ORD ORNO CD07

element

The ORD ORNO CD07 element (Order Code) contains the code representing the type of 
purchase order (e.g. new order, cancelled order) for this message. You want the more 
meaningful description of the code to be printed on the printout, instead of the code itself. 
Therefore, you will hide the Order Code field, but use the code from that element (ORD 
ORNO CD07) to look up the code description in Code Values List 7 and print that 
description in another field that you create. The description of the code will be displayed 
in the new field on the printout. You will rename the new field and change the element and 
field lengths to accommodate the text from the description of the code.

How to copy the
ORD ORNO CD07

element

The description of the EDI code in the ORD ORNO CD07 element is important, even 
though you do not need to print the code itself. For example, the EDI code value “N” is 
not descriptive enough for users reading a printout of the purchase order. The description 
of code “N” (“New Order”) is meaningful, however.

Before you can print the description of the EDI code value, you must create a new element 
in the ORNO segment to store and print the description. The new ORNO element is the 
element that will print the description of the Order Code. You will use the Copy and Paste 
functions to copy EDI information in the form. Copied form components retain all the 
information of the original form components.

Use this procedure to copy and paste the ORD ORNO CD07 element.

4 From the Form Format drop-down list box, select DD/MM/YY to 
designate the format for the date on the printout.

5 Select the Print tab.

6 In the Label field, enter Order Date: to replace the existing field label.

7 In the Maximum number of characters field, enter 8 to allow the entire 
date, including separators (/), to be displayed.

8 Click OK to exit the dialogue.

Step Action

Step Action

1 Select the ORD ORNO CD07 element.

2 Click Copy on the Main Toolbar.

3 Select the ORNO SCRF composite, which is the last form component in 
the ORNO segment. The ORNO SCRF composite is the form component 
after which you want the copy of the ORD ORNO CD07 element to be 
pasted.

(Continued on next page)
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How to change the
ORD CD07:2

element and field
properties

The system names the new element created from copying the ORD ORNO CD07 element 
ORD CD07:2. You will rename the new element to identify its purpose, which is to print 
the description of the code from the ORD ORNO CD07 element. 

Note
If a segment or element occurs more than once in a form, it is identified by its name <ID>. 
The second and subsequent occurrences are identified by <ID>:n, where “n” is the number 
of the occurrence in the form.

You will rename the element name and field label corresponding to the newly-created 
ORD CD07:2 element to reflect the contents of the field (the description of the Order 
Code). You will also increase the field and element lengths to accommodate the longer 
description.

Use this procedure to change the rename the element name and field label, and change the 
field and element lengths, for the ORD CD07:2 element.

4 Click Paste on the Main Toolbar to paste the ORD ORNO CD07 element. 
Gentran:Server prompts you to specify whether you want the contents of 
the Clipboard pasted as a child (subordinate) of the selected composite, or 
at the same level as the composite.

5 Click the Paste after selected item (at the same level) radio button to 
paste the Clipboard contents after the ORNO SCRF composite. A new 
element (ORD CD07:2) is created. The ORD CD07:2 element is an exact 
copy of the ORD ORNO CD07 element.

6 Click OK to exit the dialogue.

Step Action

Step Action

1 Double-click the ORD CD07:2 element. 

System Response
The Element Properties dialogue is displayed.

(Continued on next page)
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How to hide the
ORD ORNO CD07
field and loading a

code list table from
the standard

Now that you have created an exact copy of the ORD ORNO CD07 element in order to 
retain all of the EDI data and formatting associated with that element, you can hide the 
Order Code field.

When you use code list tables, you load a code list table from the standard to tell the 
system which code list table to use in looking up EDI code values. You can load the 
specific code values you expect to receive in the EDI data, or you can load the entire code 
list table. For this tutorial, you will load the entire code list table.

Use this procedure to hide the Order Code field and load the code list table from the 
standard.

2 In the Name field, enter CD07_DESC to give the name a more descriptive 
identifier than its current name.

Important
Do not use spaces or hyphens (-) in the Name field. You can use the 
underscore (_) to separate words.

3 Select the Validation tab.

4 In the Max field, enter 35 for the maximum number of characters allowed 
for this element.

5 Select the Print tab.

6 In the Label field, enter Order Type: to replace the existing field label.

7 In the Maximum number of characters field, enter 35 to allow a thirty-
five-character description to be displayed on the printout.

8 Click OK to save the new label and exit the dialogue.

Step Action

Step Action

1 Double-click the ORD ORNO CD07 element. You need to use a code list 
table for this element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the Display Properties dialogue.

5 Select the Use Standard Rule tab.
(Continued on next page)
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6 Click Use Code from the drop-down list.

7 Click Edit to access the Edit Code List dialogue.

The Table ID field contains “CD07,” the name of the element for which 
this code list table will be used. The Desc field contains “ORDER 
CODE,” the description of the element for which this code list table will 
be used.

8 Click Load to access the Load Code List dialogue. You will be prompted 
to select an ODBC data source name. Select the appropriate DSN and 
click OK to access the Load Code List dialogue. The Codes In Standard 
list box contains the entire code list table.

(Continued on next page)

 (Contd)
Step Action
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9 Click Add All to move all of the codes in the code list table to the Codes 
Selected list box.

Note
Adding all the codes in the list (by using Add All) creates a much larger 
form than if you use only selected codes. However, it is necessary for your 
users to have all the codes available from which to choose.

10 Click OK to load the code list table and exit the Load Code List dialogue.

11 Click Close to exit the Edit Code List dialogue.

12 From the Store Field drop-down list box, select CD07_DESC ORDER 
CODE to store the description in the ORD CD07_DESC element you 
created.

The dialogue now should look like this:

13 Click OK to exit the Element Properties dialogue.
(Continued on next page)

 (Contd)
Step Action
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14 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

The section of the print form that contains the fields in the ORD segment 
now should look like this (you may need to scroll down the form to see 
these fields:

 (Contd)
Step Action
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Customising the DIN Segment

Overview The DIN segment (Delivery Instructions) is a conditional segment that contains details 
about the delivery of the ordered items. For this tutorial, the only delivery instructions you 
and your trading partner require is the last date on which the items may be delivered.

How to customise
the DIN LDAT

element

The DIN LDAT element (Latest Delivery Date) contains the last date on which the 
ordered items may be delivered. You will change the screen format for the last delivery 
date to DD/MM/YY. Also, this element is defined by the standard to be a six-digit date. In 
this tutorial, the last delivery date will be printed as an eight-digit date, so you will change 
the element and field lengths to accommodate the longer date. In addition, you will add a 
colon (:) to the field label to make the label consistent with the other field labels on the 
same frame.

Use this procedure to change the screen format, change the field and element lengths, and 
add a colon (:) to the field label for the Latest Delivery Date field.

Step Action

1 Double-click the DIN LDAT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators 
(/), to be contained in this element.

4 From the Form Format drop-down list box, select DD/MM/YY to 
designate the format for the date on the printout.

5 Select the Print tab.

6 In the Label field, enter “:” after the text in the field label (for consistency 
in labelling the fields).

7 In the Maximum number of characters field, enter 8 to allow the entire 
date, including separators (/), to be displayed.

8 Click OK to exit the dialogue.
(Continued on next page)
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9 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

The section of the print form that contains the field in the DIN segment 
now should look like this:

 (Contd)
Step Action
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Customising the OLD Group

Overview The OLD group contains details about each line item in the purchase order. The fields in 
the OLD group are displayed on a separate frame than the fields you have customised up 
to now, because the OLD group has a maximum use of 999,999. The fields on the OLD 
frame will be be printed as many times as necessary (up to 999,999 occurrences) before 
the fields on the next frame (OTR group) are printed.
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Customising the OLD:2 Segment

Overview The OLD:2 segment (Order Line Details) contains line item details for the purchase order.

How to customise
the OLD:2 SEQA

element

The OLD:2 SEQA element (First Level Sequence Number) contains the line number for 
each item on the purchase order. Your trading partner will send you the value “1” for the 
first line item, and will increment each subsequent line item by one. You and your trading 
partner have agreed that they will order no more than 99999 line items per purchase order. 
Because each line item will be numbered sequentially, starting with one, you will need a 
maximum length of only five digits for this field. Therefore, you will change the element 
and field lengths to five. Also, for brevity, you will rename the field label.

Use this procedure to change the field and element lengths and rename the field label for 
the First Level Sequence Number field.

Step Action

1 Double-click the OLD:2 SEQA element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 5 to allow a five-digit number in this element.

4 Select the Print tab.

5 In the Label field, enter Line to replace the existing field label.

Note
The label for the First Level Sequence Number field ultimately will form 
the column heading “Line No.” To make the width of the column heading 
as narrow as possible, you will place “Line” on one line and “No.” below. 
The Label field does not enable you to enter a label on more than one line, 
so you will enter “Line” in the Label field, then add “No.” by adding static 
text later in this tutorial.

6 In the Maximum number of characters field, enter 5 to allow five numeric 
digits to be displayed on the printout.

7 Click OK to exit the dialogue.
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How to customise
the OLD:2 SPRO

SPR1 element

The OLD:2 SPRO SPR1 element (Supplier’s Code for the Traded Unit) contains the 
supplier’s internal reference identifying the ordered item. In this tutorial, MWT 
Manufacturing Co. (the supplier) provides a catalogue to its trading partners (customers). 
The catalogue lists all the items available for ordering, including the supplier’s code for 
each item. Your trading partner will send you the supplier’s number corresponding to each 
item ordered.

In this tutorial, the supplier’s codes do not exceed ten characters, so you will change the 
field and element lengths to ten. In addition, for brevity, you will rename the field label.

Use this procedure to change the field and element lengths and rename the field label for 
the Supplier’s Code for the Traded Unit field.

Step Action

1 Double-click the OLD:2 SPRO SPR1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 10 to allow a ten-character string in this element.

4 Select the Print tab.

5 In the Label field, enter Prod ID to replace the existing field label.

6 In the Maximum number of characters field, enter 10 to allow ten 
characters to be displayed on the printout.

7 Click OK to exit the dialogue.
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How to customise
the OLD:2 CPRO

CPR1 element

The OLD:2 CPRO CPR1 element (Customer’s Item Code) contains the customer’s 
internal reference identifying the ordered item. In this tutorial, your trading partner will 
send you the customer’s item code corresponding to each item ordered. However, you do 
not need this code to be printed on the printout, so you will hide this element.

Use this procedure to hide the Customer’s Item Code field.

How to customise
the OLD:2 UNOR

UNO0 element

The OLD:2 UNOR UNO0 element (Consumer Units in Traded Unit) contains the 
consumer units information. The standard defines the OLD:2 UNOR UNO0 element as a 
string data type. However, your trading partner will send you a number-type element in 
N0 format (formatted with an implicit decimal point and no decimal places). Therefore, 
you will change the data type and the screen and EDI formats to reflect the data your 
partner will send you.

Also, you and your partner have decided that none of the items you will trade contain a 
number of units greater than ten digits. You will change the field and element lengths to 
reflect the smaller number of units. In addition, for brevity, you will rename the field label.

Use this procedure to change the field and element lengths, the data type, and the screen 
and EDI formats, as well as to rename the field label, for the Consumer Units in Traded 
Unit field.

Step Action

1 Double-click the OLD:2 CPRO CPR1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the OLD:2 UNOR UNO0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 10 to allow a ten-digit number in this element.

(Continued on next page)
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How to customise
the OLD:2 UNOR

CD04 element

The OLD:2 UNOR CD04 element (Measure Indicator) contains the abbreviation for the 
ordering measure (e.g. kilograms, metres, litres) for the ordered item. For brevity, you will 
rename the field label.

Use this procedure to rename the field label for the Measure Indicator field.

4 From the Data Type drop-down list box, select Number to allow a 
number data type in this element. Gentran:Server prompts you that 
changing the field’s data type will invalidate its format.

5 Click Yes to proceed with modifying the properties of this element.

6 From the Form Format drop-down list box, select N0 to allow a number 
with an implied decimal point and no decimal places to be displayed on 
the printout.

7 From the File Format drop-down list box, select N0 to indicate that you 
expect a number with an implied decimal point and no decimal places.

8 Select the Print tab.

9 In the Label field, enter Cons. Units to replace the existing field label.

10 In the Maximum number of characters field, enter 10 to allow a ten-digit 
number to be displayed on the printout.

11 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the OLD:2 UNOR CD04 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, enter Unit to replace the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the OLD:2 OQTY

OQT0 element

The OLD:2 OQTY OQT0 element (Number of Traded Units Ordered) contains the total 
number of units ordered (quantity) for each line item, in units defined in the OLD:2 
UNOR CD04 element. The standard defines the OLD:2 OQTY OQT0 element as a string 
data type. However, your trading partner will send you a number-type element in N0 
format (formatted with an implicit decimal point and no decimal places). Therefore, you 
will change the data type and the screen and EDI formats to reflect the data your partner 
will send you.

Also, you know that your trading partner will order no more than 999999 (a six-digit 
number) of any one item, so you will change the maximum length to six for this field. You 
will change the field and element lengths to reflect the smaller quantities. In addition, for 
brevity, you will rename the field label.

Use this procedure to change the field and element lengths, the data type, and the screen 
and EDI formats, as well as to rename the field label, for the Number of Traded Units 
Ordered field.

Step Action

1 Double-click the OLD:2 OQTY OQT0 element. 

System Response
The Element Properties dialogue is displayed.

1 Select the Validation tab.

2 In the Max field, enter 6 to allow a six-digit number in this element.

3 From the Data Type drop-down list box, select Number to allow a 
number data type in this element. Gentran:Server prompts you that 
changing the field’s data type will invalidate its format.

4 Click Yes to proceed with modifying the properties of this element.

5 From the Form Format drop-down list box, select N0 to allow a number 
with an implied decimal point and no decimal places to be displayed on 
the printout.

6 From the File Format drop-down list box, select N0 to indicate that you 
expect a number with an implied decimal point and no decimal places.

7 Select the Print tab.
(Continued on next page)
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How to customise
the OLD:2 OUCT

OUC0 element

The OLD:2 OUCT OUC0 element (Cost Price) contains the price per unit ordered. This 
price is the net cost in pounds (e.g. after deducting line discounts, etc., but before the 
application of VAT) for an item. Your trading partner will send you prices in N4 format 
(formatted with an implicit decimal point and four decimal places), but you want the price 
to be displayed on the printout in R4 format (formatted with an explicit decimal point). 
Therefore, you will change the screen format to reflect how you want the price to look on 
the printout.

Also, you know that the items you sell to Pet Zone are not priced at more than £9999.99 
each, so this field needs a maximum length of only ten (four places for the pounds; four 
places for the pence, if present; one place for the decimal point; and one place for a plus or 
minus sign, if present). You will change the field and element lengths to reflect the prices 
you expect. In addition, you will rename the field label Price Each.

Use this procedure to change the field and element lengths, change the screen format, and 
rename the field label for the Cost Price field.

8 In the Label field, enter Qty Ord to replace the existing field label.

9 In the Maximum number of characters field, enter 6 to allow a six-digit 
number to be displayed on the printout.

10 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the OLD:2 OUCT OUC0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 10 to allow ten numeric digits in this field, 
including a plus or minus sign and a decimal point.

4 From the Form Format drop-down list box, select R4 to allow a number 
with an explicit decimal point and four decimal places to be displayed on 
the printout.

5 Select the Print tab.

6 In the Label field, enter Price Each to replace the existing field label.

7 In the Maximum number of characters field, enter 10 to allow eight digits 
on the printout, including a plus or minus sign and a decimal point.

8 Click OK to exit the dialogue.
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How to customise
the OLD:2 TDES

TDE0 element

The OLD:2 TDES TDE0 element (Traded Unit Descr. Line 1) contains the first line of the 
description of the ordered item. The description will be self-explanatory in the context of 
the rest of the line item information, so you will remove the label from this field.

Use this procedure to remove the field label for the Traded Unit Descr. Line 1 field.

Step Action

1 Double-click the OLD:2 TDES TDEO element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.
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How to customise
the OLD:2 TDES

TDE1 element

The OLD:2 TDES TDE1 element (Traded Unit Descr. Line 2) contains the second line of 
the description of the ordered item. The description will be self-explanatory in the context 
of the rest of the line item information, so you will remove the label from this field.

Use this procedure to remove the field label for the Traded Unit Descr. Line 2 field.

Step Action

1 Double-click the OLD:2 TDES TDE1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, delete the existing field label.

4 Click OK to exit the dialogue.

5 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

The OLD frame now should look like this:
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How to customise
the OTR LORD

element

The OTR LORD element contains the Lines Ordered. You will rename the field label.

Use this procedure to rename the field label for the Lines Ordered field.

Now you are ready to format the fields and their labels to make the fields on the purchase 
order more consistent and visually attractive.

Step Action

1 Double-click the OTR LORD element.

System Response
The Element Properties dialogue is displayed.

2 Select the Print tab.

3 In the Label field, enter Number of Line Items: to replace the existing 
field label.

4 Click OK to exit the dialogue.

5 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

The OTR frame now should look like this:
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Format the Print Form 0

Overview

Introduction In the previous section of this tutorial, you customised the print form for a TRADACOMS 
ANA001 ORDERS release 9 purchase order that you will use to print the data you receive 
from Pet Zone. After successfully customising the fields and elements of the print form, 
you are ready to format the layout of the form.

One form can consist of several frames. Each group (with a maximum use greater than 
one) and repeating segment has a corresponding frame that contains all the groups, 
segments, and elements at that level. When the form is printed, the frames are printed 
consecutively, in the order in which they occur in the form. Each frame is not printed on a 
separate page.

This section explains how to format the form, field by field.
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Resizing the Header Frame

Overview When a printout is produced based on the customised print form, the information is 
arranged according to how the frames and the fields contained on them were arranged 
when the form was compiled. You should eliminate unnecessary space as you arrange the 
fields on each frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the 
upper left corner of the Layout Window. 

Procedure Use this procedure to resize the header frame (containing fields from the ORDHDR group 
and the CLO, ORD, and DIN segments).

Step Action

1 Click the ORDHDR group to display the Order File Header (header) 
frame in the Layout Window.

2 To display more of the form on your screen, click and drag the centre bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want to view. 

Note
You should be able to view the entire width of the frame. If the right side 
of the header frame (and the vertical scroll bar for the frame) are not 
visible in the Layout Window, then move the centre bar between the EDI 
File Format Window and the Layout Window farther to the left so the 
entire frame is displayed in the Layout Window. Another way to view 
more of the frame is to use the horizontal scroll bar at the bottom of the 
Forms main window to bring the right side of the header frame into view.

3 To resize the header frame, click and drag the right side of the frame 
approximately to the 20 cm mark on the horizontal ruler (a form with a 
width of 20 cm can be printed on an A4 sheet of paper).

Note
Use the horizontal ruler at the top of the frame to help you resize the 
frame.
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Adding a Title to the Form

Overview You want the form to have a title designating the standard agency (TRADACOMS), the 
version (ANA001), the type of message (purchase order), the release (9), and the trading 
partner (Pet Zone) for which this form is used. You will add a title to the print form by 
adding static text.

Procedure Use this procedure to add and position the title for the form.

Step Action

1 Click Add Text on the Main Toolbar. 

System Response
A text box is added to the current frame, displayed in the upper left corner 
of the frame. If the template is larger than the frame (there is a scroll bar 
on the right side of the frame), the static text is displayed in the upper left 
corner of the part of the template that is displayed, not at the top of the 
template.

2 Select the new text field and enter TRADACOMS ANA001 ORDERS 
Release 9. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

3 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

4 Select the new text field and enter Pet Zone. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

System Response
The static text you added is displayed in the upper left corner of the frame.
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Centring the Text 

Overview This section describes how to center text on a form.

Procedure Use this procedure to centre the static text at the top of the purchase order form.

Step Action

1 Click and drag the first line of static text (TRADACOMS ANA001 
ORDERS Release 9) so that the text is centred on the first line of the 
frame.

2 Click and drag the second line of static text (Pet Zone) so that the text is 
centred on the second line of the frame.

The header frame now should look like this:
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Arranging the Header Fields

Overview By default, each field and its associated label are displayed on their own line. However, it 
is common for purchase orders and forms to arrange some fields in columns of 
information. The first fields you rearrange will be the header fields, which are the fields 
associated with the ORDHDR group and the CLO, ORD, and DIN segments.

You prevented some of the field labels from being printed (by removing the field label in 
the Label field of the Display Properties dialogue). For these fields, the fields will be 
displayed on your print form, but their associated labels will not. 

Note
If you forget which unlabelled field contains what data, you can click the field. Its 
associated element will be highlighted in the EDI File Format Window, providing you 
with a description of the field.

How to resize the
header fields

When you customised the element properties in the previous section of this chapter, you 
changed the display length (on the Display Properties dialogue) for some of the fields on 
the header frame. The fields that are displayed in the Layout Window currently reflect the 
default display lengths for the fields. To reflect the new sizes of the fields on the Layout 
Window, you must select the fields for which you changed the display lengths, then resize 
the fields.

Note
If a field and its corresponding field label move together, the Lock Labels to Fields option 
is turned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels 
option.

Use this procedure to resize the fields on the header frame.

Step Action

1 Select the Latest Delivery Date and Order Date fields.

2 Select Size to Length from the Display menu. 

System Response
The selected fields will be resized to the lengths specified in the 
Maximum number of characters field of the Display Properties dialogue 
for each field.

Note
If you accidentally format a form component in a way you did not intend, 
select Undo from the Display menu to undo your last formatting action.
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How to move and
align the header

fields and field
labels

Use this procedure to move and align the fields and field labels on the header frame.

Note
If a field is not in the part of the frame that currently is displayed, use the scroll bar to 
scroll down the frame until you locate the hidden field(s).

Step Action

1 Select each field individually and drag it closer to its respective field label. 
(Do not move fields that are not labelled.)

2 Select the Order Number label and field and drag them to the upper left 
corner on the frame (below the heading).

Note
To select more than one field or field label, click and drag the mouse 
diagonally across all the fields and field labels you want to select. When 
you release the mouse button, all the fields and field labels completely 
included within the space formed by dragging the mouse will have 
handles, indicating that they were selected.

3 Select the Order Date label and field and drag them to the right of the 
Order Number label and field (at approximately 12.5 cm on the horizontal 
ruler).

4 Select the Order Type label and field and drag them below the Order 
Number label and field.

5 Select the Latest Delivery Date field and drag it below the Order Date 
label and field.

6 Select the Customer label and field and drag them below the Order Type 
label and field.

7 Select the following fields and drag them below the Customer field:

◗ Customer’s Address Line 1
◗ Customer’s Address Line 2
◗ Customer’s Address Line 3
◗ Customer’s Address Line 4
◗ Customer’s Post Code

8 Select the Location label and field and drag them below the Customer’s 
Post Code field.

(Continued on next page)
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9 Select the following fields and drag them below the Location field:

◗ Customer’s Address Line 1
◗ Customer’s Address Line 2
◗ Customer’s Address Line 3
◗ Customer’s Address Line 4
◗ Customer’s Post Code

10 Select the following field labels:

◗ Order Number
◗ Order Type
◗ Customer
◗ Location

11 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

12 Select the Order Date and Latest Delivery Date field labels.

Note
To select more than one item on a frame, click the first item, then press 
CTRL and click the second item.

13 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

14 Select the Order Type and Order Number fields (in that order).

15 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the Order Type and 
Order Number fields are aligned.

16 Select the Order Date and Latest Delivery Date fields (in that order).

17 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the Latest Delivery 
Date and Order Date fields are aligned.

18 Select all the Customer and Location fields (Customer’s Address Line 1, 
Customer’s Address Line 2, Customer’s Address Line 3, Customer’s 
Address Line 4, and Customer’s Post Code).

19 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected fields are 
aligned.

(Continued on next page)

 (Contd)
Step Action
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20 Click the Lock Labels button on the Main Toolbar to turn on the Lock 
Labels function. When you select a field, its corresponding field label will 
be selected also.

21 Select the Order Number and Order Date fields. (Their field labels will 
be selected, too, because you have the Lock Labels function turned on.)

22 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of the selected labels and fields 
are aligned.

23 Select the Order Type and Latest Delivery Date fields. (Their field 
labels will be selected, too.)

24 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of the selected labels and fields 
are aligned.

25 Select the Customer field. (Its field label will be selected, too.)

26 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of the Customer label and field 
are aligned.

27 Select the Location label and field. (Its field label will be selected, too.)

28 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of the Location label and field 
are aligned.

29 To resize the frame, click and drag the bottom of the frame to just below 
the Customer’s Post Code field for the Location address.

(Continued on next page)
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30 Click the Lock Labels button on the Main Toolbar to turn off the Lock 
Labels function.

The header frame now should look like this:

 (Contd)
Step Action
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Arranging the Line Item (OLD) Fields

Overview The fields that contain information about each line item for the purchase order are 
contained on a separate frame. To access this frame, select the OLD group.

You prevented some of the field labels from being displayed, so you will see all of the 
fields in the layout of your print form, but not all of the associated labels. In case you have 
forgotten which unlabelled field contains what data, you can click the field. The name of 
the element will be highlighted in the EDI File Format Window.

Before you arrange the line item fields and their frame, first you will resize the frame to 
give it the same width as the other frames. You will then move and resize the fields and 
field labels, as well as add static text to the form.

How to resize the
line item (OLD)

frame

Use this procedure to resize the line item (OLD) frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the 
upper left corner of the Layout Window.

Step Action

1 Click the OLD group to display the line item (OLD) frame in the Layout 
Window.

2 Click and drag the right side of the frame to the 20 cm mark on the 
horizontal ruler (a form with a width of 20 cm can be printed on an A4 
sheet of paper).

Note
Use the ruler at the top of the frame to help you resize the frame.
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How to resize the
line item fields

Use this procedure to resize the line item fields.

How to complete
the line no. column

heading

You can add column headings (using static text) to the frame to change the way the field 
labels are displayed in the form. Currently, each field label in the form consists of one line 
of text. 

In this tutorial, you want to label the Line field “Line No.” You do not want the label to 
extend beyond the margins of the field that it labels, so you will place “Line” on one line 
on the frame and “No.” on the line below.

Use this procedure to add and position static text.

Step Action

1 Select the following fields:

◗ Line
◗ Prod ID
◗ Cons. Units
◗ Qty Ord
◗ Price Each

Note
To select more than one field on a frame, click the first field, then press 
CTRL and click the second field.

2 Select Size to Length from the Display menu. All selected fields will be 
resized to the lengths specified in the Maximum number of characters 
field of the Element Properties dialogue for each field.

Step Action

1 Select all the fields and field labels on the frame.

Note
To select more than one field or field label, click and drag the mouse 
diagonally across all the fields and field labels you want to select.

2 Click and drag them to the bottom portion of the frame. You will be 
arranging the fields at the top of the frame, so moving the fields and field 
labels out of the way initially will give you room to work with at the top of 
the frame.

3 Click Add Text on the Main Toolbar. Text is added to the current frame, 
displayed in the upper left corner of the frame. If the template is larger 
than the frame (there is a scroll bar on the right side of the frame), the 
static text is displayed in the upper left corner of the part of the template 
that is displayed, not at the top of the template.

(Continued on next page)
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Adding lines
separating column

headings and fields

In this print form, rectangular boxes are used to designate fields. The boxes make it easy 
to distinguish fields from field labels and static text. In the printed report, there will not be 
rectangular boxes surrounding the data in the fields. The printed field data and the field 
labels tend to look the same on the printout (same typeface, same size text, no boldface or 
italic type). You can make the field labels and static text stand out from the fields 
containing the actual data by adding lines separating the labels from the fields. You will 
add static text to the form to add the separating lines.

You will add the following lines of static text (hyphens) to the form:

When you finish adding the static text and moving each line of static text to its proper 
location, the line item (OLD) frame should look like this:

You will add all of the static text, then move each static text to its proper location.

4 In the new text field, enter No. (note the full stop included in the text).

Note
This field already has a label named “Line”. To complete the 
identification of this field, you will add static text with the name “No.” 
After you add the static text for this field, you will move “No.” below 
“Line” to create a column heading for the fields containing the line item 
number.

The text you added is displayed in the upper left corner of the frame.

5 Select the static text you added (“No.”) and drag it to the bottom of the 
frame. Moving the static text out of the way will give you more room at 
the top of the frame.

Step Action

Static Text
Number of 
Hyphens Placement on Form

------- Seven Below the No. static text

------------- Thirteen Below the Prod ID field label

-------- Eight Below the Qty Ord field label

-------- Eight Below the Unit field label

------------- Thirteen Below the Cons. Units field label

------------- Thirteen Below the Price Each field label
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Procedure Use this procedure to add and position separating lines (------) in the form.

Step Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame, 
displayed in the upper left corner of the frame. If the template is larger 
than the frame (there is a scroll bar on the right side of the frame), the 
static text is displayed in the upper left corner of the part of the template 
that is displayed, not at the top of the template.

2 Select the new text field and enter ------- (seven hyphens). This series of 
hyphens will form a separating line between the words Line No. and the 
field below. The Text Properties dialog is displayed as you are typing. 
Click OK to add the text.

3 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

4 Select the new text field and enter ------------- (thirteen hyphens). This 
series of hyphens will form a separating line between the words Prod ID 
and the field below. The Text Properties dialog is displayed as you are 
typing. Click OK to add the text.

5 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

6 Select the new text field and enter -------- (eight hyphens). This series of 
hyphens will form a separating line between the words Qty Ord and the 
field below. The Text Properties dialog is displayed as you are typing. 
Click OK to add the text.

7 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

8 Select the new text field and enter -------- (eight hyphens). This series of 
hyphens will form a separating line between the word Unit and the field 
below. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

9 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

10 Select the new text field and enter ------------- (thirteen hyphens). This 
series of hyphens will form a separating line between the words Cons. 
Units and the field below. The Text Properties dialog is displayed as you 
are typing. Click OK to add the text.

11 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

(Continued on next page)
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Moving the line
item fields, labels,

and separating
lines

The line item (OLD) frame now contains all of the fields, labels, and separating lines that 
will be arranged on the form to create columns of information. Now you are ready to move 
the fields, labels, and separating lines to their proper locations on the frame.

How to arrange
the Line No.

column

Use this procedure to arrange the Line No. column on the line item (OLD) frame.

How to arrange
the Prod ID

column

Use this procedure to arrange the Prod ID column on the line item (OLD) frame.

12 Select the new text field and enter ----------- (thirteen hyphens). This series 
of hyphens will form a separating line between the words Price Each and 
the field below. The Text Properties dialog is displayed as you are typing. 
Click OK to add the text.

The separating lines (static text) you added are displayed in the upper left 
corner of the frame.

13 Select all the static text you added and drag it to the bottom of the frame. 
Moving the static text out of the way will give you more room at the top of 
the frame.

Note
To select more than one field or field label, click and drag the mouse 
diagonally across all the fields and field labels you want to select.

 (Contd)
Step Action

Step Action

1 Select the Line field label and drag it to the upper left corner on the frame.

2 Select the No. static text and drag it below the Line field label.

3 Select the first separating line you added (seven hyphens) and drag it 
below the No. static text.

4 Select the Line field and drag it below the separating line you just moved.

Step Action

1 Select the Prod ID field label and drag it to the right of the No. static text.

2 Select the second separating line you added (thirteen hyphens) and drag it 
below the Prod ID field label.

3 Select the Prod ID field and drag it below the separating line you just 
moved.
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How to arrange
the Qty Ord

column

Use this procedure to arrange the Qty Ord column on the line item (OLD) frame.

How to arrange
the unit column

Use this procedure to arrange the Unit column on the line item (OLD) frame.

How to arrange
the cons. units

column

Use this procedure to arrange the Cons. Units column on the line item (OLD) frame.

Step Action

1 Select the Qty Ord field label and drag it to the right of the Prod ID field 
label.

2 Select the third separating line you added (eight hyphens) and drag it 
below the Qty Ord field label.

3 Select the Qty Ord field and drag it below the separating line you just 
moved.

Step Action

1 Select the Unit field label and drag it to the right of the Qty Ord field 
label.

2 Select the fourth separating line you added (eight hyphens) and drag it 
below the Unit field label.

3 Select the Unit field and drag it below the separating line you just moved.

Step Action

1 Select the Cons. Units field label and drag it to the right of the Unit field 
label.

2 Select the fifth separating line you added (thirteen hyphens) and drag it 
below the Cons. Units field label.

3 Select the Cons. Units field and drag it below the separating line you just 
moved.
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How to arrange
the price each

column

Use this procedure to arrange the Price Each column on the line item (OLD) frame.

How to move the
description fields

The description fields (Traded Unit Descr. Line 1 and Traded Unit Descr. Line 2) will not 
be placed in a column. Rather, these fields will be placed below the rest of the fields on the 
line item (OLD) frame.

Use this procedure to move the description fields.

How to resize the
line item (OLD)

frame

You should resize the line item (OLD) frame to eliminate unnecessary space resulting 
from arranging the fields on the frame.

To resize the frame, click and drag the bottom of the frame to just below the description 
fields.

The line item (OLD) frame now should look like this:

Step Action

1 Select the Price Each field label and drag it to the right of the Cons. Units 
field label.

2 Select the sixth separating line you added (thirteen hyphens) and drag it 
below the Price Each field label.

3 Select the Price Each field and drag it below the separating line you just 
moved.

Step Action

1 Select the Traded Unit Descr. Line 1 and Traded Unit Descr. Line 2 
fields.

Note
To select more than one field or field label, click and drag the mouse 
diagonally across all the fields and field labels you want to select.

2 Drag them below the row of fields near the top of the frame.
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How to align rows One of the remaining tasks in formatting the line item frame is to align the fields, field 
labels, and static text. First, you will align the items in rows to give the form a consistent 
appearance. Then, you will align the items in columns later in this tutorial.

Use this procedure to align the fields, field labels, and static text by row (horizontally).

Step Action

1 Select the following field labels and static text: 

◗ No.
◗ Prod ID
◗ Qty Ord
◗ Unit
◗ Cons. Units
◗ Price Each

Note
To select a group of items, click and drag the mouse diagonally across all 
the items you want to select.

2 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of all selected field labels and 
static text are aligned in a row.

3 Select all the separating lines between column headings and fields.

4 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of all selected static text are 
aligned in a row.

5 Select the following fields:

◗ Line No.
◗ Prod ID
◗ Qty Ord
◗ Unit
◗ Cons. Units
◗ Price Each

6 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of all selected fields are aligned 
in a row.

7 Select all the separating lines between column headings and fields.
(Continued on next page)
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How to align
columns

Now, you will align the fields, field labels, and static text in columns to help give the form 
a consistent appearance.

Use this procedure to align the fields, field labels, and static text in columns.

8 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of all selected static text are 
aligned in a row.

9 ◗ Select the following fields:
◗ Line No.
◗ Prod ID
◗ Qty Ord
◗ Unit
◗ Cons. Units
◗ Price Each

10 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of all selected fields are aligned 
in a row.

 (Contd)
Step Action

Step Action

1 Select the Line No. column heading, its separating line, and the Line No. 
field.

Note
To select a group of items, click and drag the mouse diagonally across all 
the items you want to select.

2 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. All selected items are left-aligned in a 
column.

3 Select the Prod ID column heading, its separating line, the Prod ID field, 
and both description fields (Traded Unit Descr. Line 1 and Traded Unit 
Descr. Line 2).

Note
To select more than one item on a frame, click the first item, then press 
CTRL and click the second item.

(Continued on next page)
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4 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. All selected items are left-aligned in a 
column.

5 Select the Qty Ord column heading, its separating line, and the Qty Ord 
field.

6 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. All selected items are left-aligned in a 
column.

7 Select the Unit column heading, its separating line, and the Unit field.

8 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. All selected items are left-aligned in a 
column.

9 Select the Cons. Units column heading, its separating line, and the Cons. 
Units field.

10 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. All selected items are left-aligned in a 
column.

11 Select the Price Each column heading, its separating line, and the Price 
Each field.

12 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. All selected items are left-aligned in a 
column.

The line item (OLD) frame now should look like this:

 (Contd)
Step Action
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Creating the line
item frame without

column headings

You have completed formatting the line item (OLD) frame so that the line item 
information will be displayed in columns and rows. If you were to register the translation 
object now with Gentran:Server and run EDI data through the translation object, then you 
would see that the column headings would be repeated for every line item. 

The column headings need to be printed on the printout only once, so you will copy and 
paste the OLD group to create a second OLD group (named OLD:3). The formatting in the 
OLD group will be retained in the OLD:3 group. You will change the maximum use of the 
first OLD group to one (so that the column headings are printed only once). Then, you will 
remove the column headings in the OLD:3 group from the area that will be printed, 
leaving only the fields for printing the information on the printout.

In addition, you will change the maximum use of the OLD:3 group to 999,998. Your 
partner can send you up to 999,999 line items, so the total maximum use of both OLD 
groups does not need to exceed 999,999. The maximum use of the OLD group will be 
changed to one, and the maximum use of the OLD:3 group will be changed to 999,998.

How to copy and
paste the OLD

group

Use this procedure to copy and paste the OLD group.

Step Action

1 Select the OLD group.

2 Click Copy on the Main Toolbar.

3 Select Paste on the Main Toolbar to paste the OLD group after the 
existing OLD group. 

System Response
Gentran:Server prompts you to specify whether you want the contents of 
the clipboard pasted as a child (subordinate) of the selected group, or at 
the same level as the group.

4 Click the Paste after selected item (at the same level) radio button to 
paste the Clipboard contents after the original OLD group.

5 Click OK to exit the dialogue. The pasted group is named OLD:3.
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How to change the
maximum use of

the OLD group

Use this procedure to change the maximum use of the OLD group.

Step Action

1 Click the OLD group with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu. 

System Response
The Group Properties dialogue is displayed.

3 In the Max Usage field, enter 1 to indicate that this group can be used only 
once in each purchase order.

4 Click OK to exit the Group Properties dialogue.
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How to change the
maximum use of

the OLD:3 group

Use this procedure to change the maximum use of the OLD:3 group.

How to move the
OLD:3 column

headings below the
print area

Use this procedure to move the column headings on the second line item frame (OLD:3) 
below the print area, so the headings will not be printed.

Step Action

1 Click the OLD:3 group with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu. 

System Response
The Group Properties dialogue is displayed.

3 In the Max Usage field, enter 999998 to indicate that this group can be 
used up to 999,998 times in each purchase order.

4 Click OK to exit the Group Properties dialogue.

Step Action

1 Click Generate Layout on the Main Toolbar to refresh the display of the 
print form.

2 Select the OLD:3 group. Its corresponding frame is displayed in the 
Layout Window.

(Continued on next page)
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3 Select all of the column headings and separating lines on the frame, and 
drag them below the bottom of the frame so they are not displayed. These 
items still will be included in the print form, but they will not be printed 
on the printout.

Note
To select more than one field label or static text, click and drag the mouse 
diagonally across all the items you want to select.

4 Select all of the fields on the frame, and drag them to the top of the frame.

5 To resize the frame, click and drag the bottom of the frame to just below 
the description fields (Traded Unit Descr. Line 1 and Traded Unit Descr. 
Line 2).

The second line item (OLD:3) frame now should look like this:

Step Action
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Arranging the Order Trailer (OTR) Field

Overview The Number of Line Items field (OTR group) for the purchase order is contained on a 
separate frame than the rest of the purchase order information because this field contains 
summary information that you want to be printed at the bottom of the form.

You will resize the Order Trailer (OTR) frame to give it the same width as the header and 
line item frames.

How to move the
order trailer
(OTR) field

Use this procedure to move the Number of Line Items field on the Order Trailer (OTR) 
frame.

You have completed your Purchase Order form and you are ready to compile the form.

Step Action

1 Select the Number of Line Items field and drag it to the right of its field 
label.

2 Select the Number of Line Items label and field.

Note
To select more than one field label or static text, click and drag the mouse 
diagonally across all the items you want to select.

3 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu. The tops of the Number of Line Items 
label and field are aligned.

4 To resize the Order Trailer (OTR) frame, click and drag the bottom of the 
frame to just below the Number of Line Items label and field.

5 Select Save from the File menu to save the form. 

The Order Trailer (OTR) frame now should look like this:
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Finalise the Form 0

Overview

Introduction Now that you have created and customised the print form, you are ready to compile the 
form to generate the translation object (*.TPL) that Gentran:Server uses before you print 
the report and test the compiled translation object.
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Compiling the Form

Overview The Compile function compiles the form. The form that you create using Gentran:Server 
is a source form. When that source form is compiled, the result is a compiled translation 
object.

This translation object must be registered with the Gentran:Server system before you can 
use it. You will use the Compile function after the form is completed and saved.

Procedure Use this procedure to compile the form.

Step Action

1 Select Compile from the File menu to display the Run-Time Translation 
Object Name dialogue.

2 Click Save to accept the translation object name (pettordp.tpl) in the File 
name field.

This name for the compiled translation object (.TPL file) is the same 
filename as the source form (.STP file). Preserving the same filename 
(with different file extensions) ensures that the relationship between the 
source form and the compiled translation object remains evident.

CAUTION
BE VERY CAREFUL NOT TO OVERLAY THE SOURCE 
FORM WITH THE COMPILED TRANSLATION OBJECT. 
USE THE .TPL FILE EXTENSION TO DISTINGUISH THE 
COMPILED TRANSLATION OBJECT.

(Continued on next page)
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3 The system will compile the form and generate an error report. The error 
report is displayed in the Compile Errors dialogue. 

4 Click OK to exit the Compile Errors dialogue. The date on which you 
compiled the form is loaded automatically into the Compiled on field on 
the Translation Object Details dialogue.

Note
If the Compile Errors dialogue contains errors, you must fix the 
problem(s) by redoing the appropriate section of the tutorial. Recompile 
the form after you correct the error(s) and save the form.

5 Select Save from the File menu to save the form.

 (Contd)
Step Action
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Printing the Report

Overview The Gentran:Server report enables you to validate and review the translation object, and 
make modifications as needed. If you review the report and determine that the translation 
object is incorrect, you should reiterate the form creation process as many times as 
necessary (make the modifications, save the form, recompile the form, and print the report 
again).

Procedure Use this procedure to print the Gentran:Server report.

Step Action

1 Select Print from the File menu to access the Print Options dialogue.

2 Click OK to accept the defaults on this dialogue (all options marked), so 
the report includes all sections and only the activated form components. 

System Response
The Print dialogue is displayed.

3 Do you need to change setup options (to select a specific printer, paper 
orientation, or size and source of paper) ? 

◗ If yes, click Properties. Set the appropriate options. Click OK to 
begin the print process.

◗ If no, click OK to begin the print process.
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Testing the Translation Object

Overview Before you can use the TRADACOMS ORDERS Pet Zone print translation object, you 
must test the translation object to verify that there are no errors in it. To test the translation 
object, you must have a file containing test data. For this tutorial, you will use the 
PETTSTT2.INT test file.

Procedure Use this procedure to test the print translation object you just created.

Step Action

1 Register the PETTORDP.TPL translation object with Gentran:Server. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on registering a translation object.

2 Import the PETZONE4.PAR partner relationship into Gentran:Server. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on importing a partner.

The default path for the partner is: 
C:\GENSRVNT\TUTORIAL\PETZONE4.PAR

3 Verify (in Partner Editor) that the ORDERS Pet Zone print translation 
object is selected for the Inbound Relationship. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on selecting inbound translation objects.

4 Use the Process File option in Gentran:Server to process the data file 
(PETTSTT2.INT) through the translation object. The data file is located 
in the TUTORIAL subfolder under the folder where Gentran:Server is 
installed. 

The default path for the data file is: 
C:\GENSRVNT\TUTORIAL\PETTSTT2.INT

5 After the message is translated, it is located in the in Documents in 
Gentran:Server. Print the message to ensure that the message was 
translated correctly and that the printout looks the way you want it to look. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on printing messages.



Testing the Translation Object Creating a Print Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

2 - 102



-1

Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

CHAPTER

3 - 1

3

Creating a Screen Entry Form

Contents Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 3
◗ Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 3
◗ Phases of Designing a Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 5
◗ Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 6

Analyze the EDI File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 7
◗ Basic Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 7

Design and Create the Form  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 18
◗ Verifying the Global EDI Date Formats  . . . . . . . . . . . . . . . . . . . . . . . 3 - 18
◗ Defining the Type of Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 20
◗ Activating Groups, Segments, and Elements . . . . . . . . . . . . . . . . . . . . 3 - 25
◗ Verifying EDI Delimiters and Adding Frame Help Text . . . . . . . . . . . 3 - 29

Modify Form Components  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 32
◗ Promoting and Changing the Maximum Use of Segments and Groups 3 - 32
◗ Modifying the Maximum Use of the REF Segment  . . . . . . . . . . . . . . 3 - 33
◗ Modifying the Maximum Use of the N3 Segment . . . . . . . . . . . . . . . . 3 - 35
◗ Promoting the N1 Group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 36
◗ Changing the Maximum Use of the ITD Segment . . . . . . . . . . . . . . . . 3 - 37
◗ Changing the Maximum Use of  the DTM Segment . . . . . . . . . . . . . . 3 - 39
◗ Changing the Maximum Use of the PID Group . . . . . . . . . . . . . . . . . . 3 - 40
◗ Changing the Maximum Use of the DTM:2 Segment . . . . . . . . . . . . . 3 - 42
◗ Changing the Maximum Use of the CAD Segment . . . . . . . . . . . . . . . 3 - 43
◗ Generating the Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 44

Customize the EDI Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 47
◗ Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 47
◗ Customizing the BIG Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 49
◗ Customizing the REF Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 55
◗ Customizing the N1 Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 58
◗ Customizing the N1:3 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 59
◗ Customizing the N3:3 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 63



Creating a Screen Entry Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

3 - 2

◗ Customizing the N4:3 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 65
◗ Customizing the N1:4 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 68
◗ Customizing the N3:4 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 71
◗ Customizing the N4:4 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 73
◗ Customizing the ITD Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 76
◗ Customizing the DTM Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 78
◗ Customizing the IT1 Group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 82
◗ Customizing the IT1 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 84
◗ Customizing the PID Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 103
◗ Customizing the PID:2 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 104
◗ Customizing the DTM:2 Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 107
◗ Customizing the CAD Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 110
◗ Customizing the TDS Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 115
◗ Customizing the CTT Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 116

Format the Screen Entry Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 117
◗ Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 117
◗ Resizing the Invoice Frame  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 118
◗ Arranging the Fields on the Invoice Frame  . . . . . . . . . . . . . . . . . . . . 3 - 120
◗ Arranging the Fields on the Line Items Frame  . . . . . . . . . . . . . . . . . 3 - 135
◗ Changing the Invoice Frame Title  . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 144

Finalize the Form  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 - 146
◗ Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 146
◗ Compiling the Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 147
◗ Printing the Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 149
◗ Testing the Translation Object . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 - 150



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Screen Entry Form Introduction 3 - 3

Overview 0

Introduction

In this chapter This chapter includes the following topics associated with creating a screen entry form:

◗ Form analysis
◗ Creating, saving, and setting up a new form
◗ Customising the form, including the groups, segments, and elements
◗ Formatting the form, including fields and field labels
◗ Finalising the form.

Note
Press F1 from any area of the system to access the online Help for that function. The 
online Help system contains field definitions and other detailed information.

Purpose of this
tutorial

This tutorial explains how to customise and format a form before it is compiled into a 
translation object. The form that you create is a source form. When that source form is 
compiled, the result is a compiled translation object. You must register the translation 
object with Gentran:Server to be able to use the translation object (to enter EDI data in 
messages of that type).

Form criteria Gentran:Server generates a basic form based on the following criteria you specify:

◗ Type of form (e.g. screen entry or print)
◗ Standard agency (e.g. TRADACOMS, EDIFACT)
◗ Standard version (e.g. ANA001, 92.1)
◗ Message type (e.g. ORDERS, INVOIC)
◗ Release (message version) (e.g. 9)

Mandatory
components

All mandatory groups, segments, composites, and elements for the standard, version, and 
message you specify are available for use (activated) when Gentran:Server creates a form. 
Only these mandatory form components (groups, segments, composites, and elements) are 
activated automatically. You must activate additional form components that you want to 
be displayed in the screen entry form, and then customise and format the form so that it is 
appropriate and useful for your company’s needs.
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Before you begin Before you begin to customise a screen entry form, you should be familiar with the 
following elements of form design:

◗ EDI standards (how EDI standards work and how the information your users need is 
translated to and from the standards)

◗ Your users (the individuals who will be using the screen entry forms to enter EDI 
data)

◗ Your trading partners (the organisations receiving the EDI data that your users enter 
in the screen entry form)

You can create a different screen entry form for each combination of message, trading 
partner, and standard version. There is no limit to the number of screen entry forms you 
can create, and the number of screen entry forms you create is not affected by the number 
of print forms you create.

Recommendation
We recommend that you mock up a layout of the screen entry form the way you ultimately 
want it to look. As you are designing the layout, you should take into consideration the 
people who will be using the translation object. Make sure that the form makes sense to 
the people who will be using it. By analysing your company’s needs before you actually 
create the screen entry form, you will reduce the amount of time spent later on redesigning 
or reformatting the form.
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Phases of Form Design

Overview This table lists the phases of form design.

Phase Description

1 Analyse the EDI file.

2 Design and create the form.

3 Modify form components.

4 Customise the EDI data.

5 Format the form.

6 Finalise the translation object.
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Getting Started

Overview This tutorial is meant to be completed in its entirety. We strongly recommend that you 
complete each task sequentially. The purpose of completing each task in this tutorial in 
sequential order, as if it were your own scenario, is not only to teach you how to perform 
the individual tasks, but also to teach you a logical approach and methods that should be 
used when you create your own form.

This section guides you in completing the steps in the first phase of form design. In this 
section, you will create a new screen entry form based on a scenario we have defined for 
you. This section includes the basics of creating the form, such as defining the scenario 
and analysing the purpose of the form, creating and saving the form, and setting up the 
form. Later in this chapter, you can find techniques for customising the segments, 
elements, and groups in the form, as well as for formatting the organisation and 
appearance of the form.

Screen entry form
scenario

For this tutorial, you will create a screen entry form for the INVOIC message (invoice), 
using the TRADACOMS ANA001 release 9 standard. The steps involved in creating this 
form are broken down into manageable pieces so that you can learn the tasks and 
procedures involved in creating a screen entry form. Then, you can apply the knowledge 
gained from using this tutorial to create your screen entry forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a wide 
variety of pet supplies for pet stores. One of your trading partners, Pet Zone (a large pet 
supply retailer), orders products from your company. Your company then invoices Pet 
Zone for those products. You will create a form that your data entry users will use to enter 
EDI data for the invoice that you will send to Pet Zone. From discussions with Pet Zone, 
you know the requirements for the invoices that they receive from you. In this tutorial, you 
will invoice one order per message only. You will not use settlement discounts.
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Analyse the EDI File 0

Basic Tasks

Introduction To analyse the EDI file, first you must determine what data you need to send your trading 
partner and what data your trading partner expects to receive. It is important to analyse the 
data in this way so that the invoice will contain all the necessary information, and so that 
your company can bill your partner correctly for the order you shipped to them. You and 
your partner must agree on which standard, version, message, and release you will be 
using. In this tutorial, you are using a TRADACOMS ANA001 INVOIC release 9 invoice. 
It is important to know the information your partner expects you to send in the invoice, 
and what data will be contained in each element used.

It is very helpful to review the EDI standard that you will use before analysing the EDI 
file. We recommend that you obtain an EDI standard manual for the standard and version 
that you will use. Standard manuals are available from EDI standard agencies.

After discussing with your partner what you will send, determining which segments and 
elements your partner requires, and reviewing the EDI standard, you can list the items that 
you will need to use (activate). When Gentran:Server generates the EDI file format, the 
system includes all the groups, segments, composites, and elements that are defined by the 
standard agency for the version of the message you selected. The system activates all the 
groups, segments, composites, and elements that are defined as mandatory (must be 
present) by the standard. The system does not enable you to deactivate mandatory groups, 
segments, composites, and elements.

Form analysis The first step in creating a form is the analysis of the form requirements. If the analysis 
you perform is complete, you will have all the information you need to create the form in 
an efficient and logical manner. If you omit this critical step and proceed directly to 
creating the form, it is likely that creating the form will be a much longer and arduous 
task, and the form may not work the way you need it to, due to oversights and omissions.

Creating a screen entry form for the TRADACOMS INVOIC message requires several 
steps. Some steps are performed at the message level (such as activating form 
components), and others are iterative steps that are performed for each group, segment, or 
element in the form. In this analysis phase, you must determine what EDI data you will 
send Pet Zone, as well as what information Pet Zone requires to process the invoice. The 
fields on the form must account for all information that you expect to send to Pet Zone.



Basic Tasks Creating a Screen Entry Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

3 - 8

Mandatory
components

This table lists the groups, segments, composites, and elements that have been defined as 
mandatory by the standards committee for a TRADACOMS ANA001 INVOIC release 9 
invoice, and are activated automatically when you create a new form.

Group Group Segment Composite Element Description

CLO Customer’s Location

CLOC

IRF Invoice References

INVN Invoice Number

IVDT Date of Invoice

TXDT Tax-Point Date

ODD

ILD

STL VAT Rate Invoice Sub Trailer

SEQA:7 First Level Sequence Number

CD12:2 VAT Rate Category Code

VATP:2 VAT Rate Percentage

NRIL Number of Item Lines

LVLA Lines Sub-Total (Excluding 
VAT)

EVLA Extended Sub-Total Amount 
(Excluding VAT)

ASDA Extended Sub-Total Amount 
(After Settlement Discount 
Has Been Applied)

VATA VAT Amount Payable

APSI Payable Sub-Total Amount 
Including Settlement 
Discount

(Continued on next page)
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Required
components

When translating data, the system does not process groups, segments, composites, and 
elements that are not activated. Therefore, you must make available (activate) the groups, 
segments, composites, and elements that are not defined as mandatory by the standard, but 
that you have determined that you need to use in the form.

For this tutorial, the form components that are required (need to be activated) and are not 
mandatory for the standard are the following:

Note
When you activate a conditional group, segment, or composite, the mandatory subordinate 
segments, composites, and elements are activated automatically. A conditional group, 
segment, or composite is used only if there is EDI data available for an element contained 
in it.

TLR Invoice Trailer

NSTL Number of Total Segments

LVLT Lines Total Amount 
(Excluding VAT)

EVLT Total Extended Amount Ex 
Settlement Discount

ASDT Total Amount Exc VAT Inc 
Sett

TVAT Total VAT Amount Payable

TPSI Total Payable Inc Settlement

 (Contd)
Group Group Segment Composite Element Description

Element Description
Data
Type Length

Constant, Code Value, 
or Format to Be 

Assigned

Customer’s Location (CLO Segment) (Already Activated)

CLO CLOC CLO0 Customer’s ANA Location 
Code

String 13 Format = 9

CLO CLOC CLO1 Customer’s Own Location 
Code

String 17

CLO CNAM Customer’s Name String 40

CLO CADD CAD0 Customer’s Address Line 1 String 35

(Continued on next page)
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CLO CADD CAD1 Customer’s Address Line 2 String 35

CLO CADD CAD2 Customer’s Address Line 3 String 35

CLO CADD CAD3 Customer’s Address Line 4 String 35

CLO CADD CAD4 Customer’s Post Code String 8

Settlement Terms (PYT Segment)

PYT PAYT Terms of Payment String 40

Data Narrative (DNA Segment)

DNA GNAR 
GNA0

General Narrative Line 1 String 40

DNA GNAR 
GNA1

General Narrative Line 2 String 40

DNA GNAR 
GNA2

General Narrative Line 3 String 40

DNA GNAR 
GNA3

General Narrative Line 4 String 40

Order and Delivery Terms (ODD Group) (Already Activated)

Order and Delivery Terms (ODD:2 Segment)

ODD:2 ORNO 
ORN0

Customer’s Order Number String 17

ODD:2 ORNO 
ORN2

Date Order Placed by 
Customer

Dt/Tm 6 Screen Format = 
DD/MM/YY

ODD:2 DELN 
DEL0

Delivery Note Number String 17

ODD:2 DELN 
DEL1

Date of Despatch by 
Supplier

Dt/Tm 6 Screen Format = 
DD/MM/YY

Invoice Line Details (ILD Group in ODD Group) (Already Activated)

Invoice Line Details (ILD:2 Segment)

ILD:2 SPRO SPR0 EAN-13 Code for the 
Traded Unit

String 13

(Continued on next page)

Element Description
Data
Type Length

Constant, Code Value, 
or Format to Be 

Assigned
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Segment analysis For each segment activated (either mandatory or optional), you must ask the following 
questions:

◗ Will the segment have a maximum use greater than one?
◗ What composites and elements need to be activated for the segment?
This table describes the segment components used in this tutorial.

ILD:2 SPRO SPR1 Supplier’s Code for the 
Traded Unit

String 30

ILD:2 CPRO CPR1 Customer’s Item Code String 30

ILD:2 QTYI QTY0 Number of Order Units 
Invoice

String 15 Format = N0 (Number 
data type)

ILD:2 QTYI 
CD04:2

Measure Indicator String 6 Any valid code

ILD:2 TDES TDE0 Traded Unit Descr. Line 1 String 40

Element Description
Data
Type Length

Constant, Code Value, 
or Format to Be 

Assigned

Component Description

Group Contains related segments and/or groups that repeat in sequence 
until either the group data ends or the maximum number of times 
that the loop is allowed to repeat is exhausted.

Repeating segment Consists of elements that repeat (in sequence) until the segment 
data ends or the maximum number of times the segment is 
allowed to repeat is exhausted.

Composite Contains two or more component data elements or subelements. 
Composites are defined by the EDI standards that use them 
(EDIFACT, TRADACOMS, and certain ANSI X12 standards).

Maximum use Refers to the number of times that a segment can be used within 
the structure in which the segment is defined. For example, if a 
segment can be used only once within a group, but the group can 
be used multiple times, the segment still has a maximum use of 
one within each occurrence of the group. The standard defines 
the maximum number of times a segment can be used, but you 
must determine how many times a segment will be used, based 
on what you will be sending your trading partner.

Elements Each segment contains elements. Some elements are mandatory 
and others are optional to the standard but necessary for your 
needs. You must define all the elements that you will be sending 
Pet Zone for each segment.
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Customisation
tasks

Gentran:Server generates a form based on the groups, segments, composites, and elements 
you activate. At this point, the form is compliant with the standard and it contains all the 
necessary components based on the data you will send Pet Zone. However, you need to 
customise the form components to produce a form that is easy to use to enter data in a 
logical manner.

This table lists the required customisation tasks described in this tutorial.

Form Component Description Customisation Task

INVOIC file Invoice Details Use an extended rule to calculate the VAT 
summary for the fields in the STL and TLR 
segments.

CLO CLOC CLO0 
element

Customer’s ANA 
Location Code

Your users will enter the ANA code for the 
customer’s location to which the invoiced 
items are to be shipped as a string data type 
accepting numeric characters only. 
Therefore, you will designate the 
appropriate string format for this element. 
Also, you will change the field label to 
“Location ANA Code.”

CLO CLOC CLO1 
element

Customer’s Own 
Location Code

Your users will enter a string no longer than 
ten characters in this element, so you will 
change the maximum length for this 
element to ten. Also, you will change the 
field label to “Location Own Code.”

CLO CNAM 
element

Customer’s 
Name

Your users will enter a string no longer than 
thirty-five characters in this element, so you 
will change the maximum length for this 
element to thirty-five. Also, you will 
shorten the field label to “Name.”

CLO CADD CAD0 
element

Customer’s 
Address Line 1

You will shorten the field label for this 
element to “Address Line 1.”

CLO CADD CAD1 
element

Customer’s 
Address Line 2

You will shorten the field label for this 
element to “Address Line 2.”

CLO CADD CAD2 
element

Customer’s 
Address Line 3

You will shorten the field label for this 
element to “Address Line 3.”

CLO CADD CAD3 
element

Customer’s 
Address Line 4

You will shorten the field label for this 
element to “Address Line 4.”

CLO CADD CAD4 
element

Customer’s Post 
Code

You will shorten the field label for this 
element to “Post Code.”

(Continued on next page)
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IRF segment Invoice 
References

You and your trading partner will use this 
segment only once, so you will change the 
maximum use of this segment to one.

IRF INVN element Invoice Number You will shorten the field label for this 
element to “Invoice No.” In addition, you 
will set up the document name (which 
enables you to differentiate between 
messages in the document browsers in 
Gentran:Server) for this element.

IRF IVDT element Date of Invoice Your users will enter the invoice date in 
DD/MM/YY format (not YYMMDD 
format, the default format defined by the 
standard). Therefore, you will change the 
screen format accordingly. You will change 
the maximum length for this field and 
element to eight (to accommodate the 
longer date format). In addition, you will 
change the field label to “Invoice Date.”

IRF TXDT element Tax-Point Date Your users will enter the tax-point date in 
DD/MM/YY format (not YYMMDD 
format, the default format defined by the 
standard). Therefore, you will change the 
screen format accordingly. You will change 
the maximum length for this field and 
element to eight (to accommodate the 
longer date format).

PYT segment Settlement Terms You and your trading partner will use this 
segment only once, so you will change the 
maximum use of this segment to one.

PYT SEQA element First Level 
Sequence 
Number

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object. Also, 
you will define a constant value for this 
field, as this field will always have the same 
value (because each invoice corresponds to 
only one purchase order).

PYT PAYT element Terms of 
Payment

You will shorten the field label for this 
element to “Payment Terms.”

(Continued on next page)
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Form Component Description Customisation Task
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DNA segment Data Narrative You and your trading partner will use this 
segment only once, so you will change the 
maximum use of this segment to one.

DNA SEQA:2 
element

First Level 
Sequence 
Number

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object. Also, 
you will define a constant value for this 
field, as this field will always have the same 
value (because each invoice corresponds to 
only one purchase order).

DNA GNAR GNA0 
element

General Narrative 
Line 1

You will shorten the field label for this 
element to “Invoice Notes.”

DNA GNAR GNA1 
element

General Narrative 
Line 2

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

DNA GNAR GNA2 
element

General Narrative 
Line 3

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

DNA GNAR GNA3 
element

General Narrative 
Line 4

The data in this element will be self-
explanatory, so you will remove the label 
from this field.

ODD group Order and 
Delivery Terms

You and your trading partner will use this 
group only once, so you will change the 
maximum use of this group to one. You will 
promote this group so that the fields in this 
group are placed on the main Invoice 
Details frame.

ODD:2 SEQA 
element

First Level 
Sequence 
Number

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object. Also, 
you will define a constant value for this 
field, as this field will always have the same 
value (because each invoice corresponds to 
only one purchase order).

ODD:2 ORNO 
ORN0 element

Customer’s Order 
Number

You will change the field label for this 
element to “Customer’s P.O. No.”

(Continued on next page)
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Form Component Description Customisation Task



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Screen Entry Form Basic Tasks 3 - 15

ODD:2 ORNO 
ORN2 element

Date Order 
Placed by 
Customer

Your users will enter the purchase order 
date in DD/MM/YY format (not 
YYMMDD format, the default format 
defined by the standard). Therefore, you 
will change the screen format accordingly. 
You will change the maximum length for 
this field and element to eight (to 
accommodate the longer date format). In 
addition, you will shorten the field label to 
“P.O. Date.”

ODD:2 DELN 
DEL0 element

Delivery Note 
Number

You will add Help text to this field.

ODD:2 DELN 
DEL1 element

Date of Despatch 
by Supplier

Your users will enter the delivery date in 
DD/MM/YY format (not YYMMDD 
format, the default format defined by the 
standard). Therefore, you will change the 
screen format accordingly. You will change 
the maximum length for this field and 
element to eight (to accommodate the 
longer date format). In addition, you will 
shorten the field label to “Delivery Date.”

ILD group in the 
ODD group

Invoice Line 
Details

You will add the more descriptive title 
“Line Items” to the group description to 
label the fields contained on the ILD:2 
frame. In addition, you will use an extended 
rule to calculate the extended line cost for 
the line items, and to convert the VAT rate 
percentage from a string (its data type in the 
partner database) to a number (the data type 
required in the VAT Rate Percentage 
element).

ILD:2 SEQA 
element

First Level 
Sequence 
Number

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object. Also, 
you will define a constant value for this 
field, as this field will always have the same 
value (because each invoice corresponds to 
only one purchase order).

(Continued on next page)
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ILD:2 SEQB 
element

2nd Level 
Sequence No.

You will use the Loop Count standard rule 
to count the number of this iteration of the 
group in this field (to provide a count of the 
number of line items in the invoice). You 
will instruct the system to display the value 
from this field in the first column in the 
Line Items list box on the Invoice Details 
frame. Also, the line item number will be 
no longer than five digits, so you will 
change the maximum length for this 
element to five. In addition, you will 
shorten the field label to “Item No.” and 
make the field display-only (as the users 
will not need to enter a value in this field).

ILD:2 SPRO SPR0 
element

EAN-13 Code for 
the Traded Unit

You will shorten the field label for this 
element to “EAN Code.”

ILD:2 SPRO SPR1 
element

Supplier’s Code 
for the Traded 
Unit

You will instruct the system to display the 
value from this field in the second column 
in the Line Items list box on the Invoice 
Details frame. Also, you will change the 
field label to “Supplier’s Product Code.”

ILD:2 CPRO CPR1 
element

Customer’s Item 
Code

You will change the field label for this 
element to “Customer’s Product Code.”

ILD:2 QTYI QTY0 
element

Number of Order 
Units Invoice

Your users will enter the quantity as a 
number with N0 format (formatted with an 
implicit decimal point and no decimal 
places). Therefore, you will change the data 
type from String to Number and the screen 
and EDI formats to N0 formats. You will 
instruct the system to display the value 
from this field in the third column in the 
Line Items list box on the Invoice Details 
frame. Also, the quantity will be no longer 
than five digits, so you will change the 
maximum length for this element to five. In 
addition, you will shorten the field label to 
“Quantity.”

(Continued on next page)
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ILD:2 QTYI 
CD04:2 element

Measure 
Indicator

Your users can enter any of the measure 
indicator codes that the standard designates 
as valid codes. You will load the entire code 
list for this element, which will create a 
drop-down list box containing valid codes 
from which users can select. Also, you will 
change the field label to “Unit of Measure.”

ILD:2 AUCT AUC0 
element

Cost Price 
(Excluding VAT)

Your users will enter the unit price in R4 
format (formatted with an explicit decimal 
point and up to four decimal places). 
Therefore, you will change the screen 
format to R4. You will instruct the system 
to display the value from this field in the 
fourth column in the Line Items list box on 
the Invoice Details frame. Also, you will 
change the field label to “Unit Price (Ex. 
VAT).”

ILD:2 LEXC 
element

Extended Line 
Cost (Excluding 
VAT)

The extended line cost will be formatted as 
an R4 number (formatted with an explicit 
decimal point and up to four decimal 
places). Therefore, you will change the 
screen format to R4. In addition, you will 
prevent this field from being displayed in 
the screen entry translation object, as users 
will not need to enter or view a value in this 
field.

ILD:2 CD12 
element

VAT Rate 
Category Code

You will use a Select standard rule so that 
all of the available codes from the VAT rate 
category code table (VATCODES table) 
will be available in a drop-down list box for 
your screen entry translation object users. 
Also, you will shorten the field label to 
“VAT Code.”

(Continued on next page)
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ILD:2 VATP 
element

VAT Rate 
Percentage

You will create a temporary storage field 
for the VAT rate (with a string data type, to 
accommodate the VAT rate from the partner 
database). The extended rule you used on 
the ILD group will convert the string data in 
the temporary storage field to a number, 
then place the number in the ILD:2 VATP 
element (which has a number data type) and 
delete the value from the temporary field. 
You will prevent the ILD:2 VATP field 
from being displayed on the screen entry 
translation object.

ILD:2 TDES TDE0 
element

Traded Unit 
Descr. Line 1

You will shorten the field label for this 
element to “Description.”

STL segment VAT Rate Invoice 
Sub Trailer

You will add the more descriptive title 
“VAT Summary” to the group description to 
label the fields contained on the STL frame.

STL SEQA:7 
element

First Level 
Sequence 
Number

This element is required in the invoice, but 
screen entry translation object users will not 
need to enter a value in this field (this field 
will be assigned a value in an extended rule 
used on the INVOIC file). You will prevent 
this field from being displayed in the screen 
entry translation object.

STL CD12:2 
element

VAT Rate 
Category Code

You will instruct the system to display the 
value from this field in the first column in 
the VAT Summary list box on the Invoice 
Details frame. Also, you will shorten the 
field label to “VAT Code” and make the 
field display-only (as users will not need to 
enter a value in this field).

STL VATP:2 
element

VAT Rate 
Percentage

The VAT rate will be displayed in the 
screen entry translation object in R3 format 
(formatted with an explicit decimal point 
and up to three decimal places). Therefore, 
you will change the screen format to R3. 
You will instruct the system to display the 
value from this field in the second column 
in the VAT Summary list box on the Invoice 
Details frame. Also, you will shorten the 
field label to “VAT rate” and make the field 
display-only (as users will not need to enter 
a value in this field).

(Continued on next page)
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STL NRIL element Number of Item 
Lines

This field will be assigned a value in an 
extended rule (used on the INVOIC file). 
You will change the field label to “Number 
of Line Items” and make the field display-
only (as users will not need to enter a value 
in this field).

STL LVLA element Lines Sub-Total 
(Excluding VAT)

The lines subtotal will be displayed in the 
screen entry translation object in R2 format 
(formatted with an explicit decimal point 
and up to two decimal places). Therefore, 
you will change the screen format to R2. 
You will instruct the system to display the 
value from this field in the third column in 
the VAT Summary list box on the Invoice 
Details frame. Also, you will make this 
field display-only (as users will not need to 
enter a value in this field) and make minor 
changes to the field label.

STL EVLA element Extended Sub-
Total Amount 
(Excluding VAT)

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object (this 
field will be assigned a value in the 
extended rule used on the INVOIC file).

STL ASDA element Extended Sub-
Total Amount 
(After Settlement 
Discount Has 
Been Applied)

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object (this 
field will be assigned a value in the 
extended rule used on the INVOIC file).

STL VATA element VAT Amount 
Payable

The VAT amount payable will be displayed 
in the screen entry translation object in R2 
format (formatted with an explicit decimal 
point and up to two decimal places). 
Therefore, you will change the screen 
format to R2. Also, you will make this field 
display-only (as users will not need to enter 
a value in this field).

(Continued on next page)
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STL APSI element Payable Sub-
Total Amount 
Including 
Settlement 
Discount

The payable subtotal will be displayed in 
the screen entry translation object in R3 
format (formatted with an explicit decimal 
point and up to three decimal places). 
Therefore, you will change the screen 
format to R3. Also, you will make this field 
display-only (as users will not need to enter 
a value in this field) and shorten the field 
label to “Payable Subtotal (Inc. Sett. 
Disc.).”

TLR NSTL element Number of Total 
Segments

This element is required in the invoice, but 
is not meaningful for your purposes. You 
will prevent this field from being displayed 
in the screen entry translation object (this 
field will be assigned a value in the 
extended rule used on the INVOIC file).

TLR LVLT element Lines Total 
Amount 
(Excluding VAT)

The invoice amount (excluding VAT) will 
be displayed in the screen entry translation 
object in R2 format (formatted with an 
explicit decimal point and up to two 
decimal places). Therefore, you will change 
the screen format to R2. Also, you will 
make this field display-only (as users will 
not need to enter a value in this field).

TLR EVLT element Total Extended 
Amount Ex 
Settlement 
Discount

The invoice amount (excluding settlement 
discount) will be displayed in the screen 
entry translation object in R2 format 
(formatted with an explicit decimal point 
and up to two decimal places). Therefore, 
you will change the screen format to R2. 
Also, you will make this field display-only 
(as users will not need to enter a value in 
this field).

TLR ASDT element Total Amount 
Exc VAT Inc Sett

The invoice amount (excluding VAT, 
including settlement discount) will be 
displayed in the screen entry translation 
object in R2 format (formatted with an 
explicit decimal point and up to two 
decimal places). Therefore, you will change 
the screen format to R2. Also, you will 
make this field display-only (as users will 
not need to enter a value in this field).

(Continued on next page)
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TLR TVAT element Total VAT 
Amount Payable

The VAT total will be displayed in the 
screen entry translation object in R2 format 
(formatted with an explicit decimal point 
and up to two decimal places). Therefore, 
you will change the screen format to R2. 
Also, you will make this field display-only 
(as users will not need to enter a value in 
this field).

TLR TPSI element Total Payable Inc 
Settlement

The total invoice amount will be displayed 
in the screen entry translation object in R2 
format (formatted with an explicit decimal 
point and up to two decimal places). 
Therefore, you will change the screen 
format to R2. Also, you will make this field 
display-only (as users will not need to enter 
a value in this field).

 (Contd)
Form Component Description Customisation Task
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Design and Create the Form 0

Verifying the Global EDI Date Formats

Introduction Gentran:Server enables you to customise the global EDI date formats (for all forms). You 
can specify the default EDI format of dates for both six-character dates and eight-
character dates. When you customise the global EDI date formats, the settings are valid 
for all forms created in the current session of Gentran:Server. However, you can override 
the default date formats for an individual element on the Element Properties dialogue for 
that element.

You must verify that you are using the correct global date formats the first time you use 
Gentran:Server. Typically, you will verify the global EDI date formats one time only. You 
can change the default date formats if they do not match the formats you intend to use.

Procedure Use this procedure to verify the global EDI date formats.

Step Action

1 Select Preferences from the Options menu to display the Preferences 
dialog. The Preferences dialog is a property sheet that enables you to set 
global defaults for Gentran:Server.

2 Verify that the Standard Formats tab displays the default date formats that 
are used when elements are read from the standards database.

3 Verify that the Six-character dates drop-down list box contains 
YYMMDD to define the format of the six-character EDI dates in your 
forms.

4 Verify that the Eight character dates drop-down list box contains 
YYYYMMDD to define the format of the eight-character EDI dates in 
your forms.

5 Click OK to accept the default date formats for 6- and 8-character date 
fields and exit the Preferences dialog.

Note
To change the order in which the date formats appear in the Six-character 
dates and Eight character dates drop-down list boxes or to add a new date 
format to the lists, select Date Formats from the Options menu.
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Defining the Type of Form

Overview The first task in creating a new form is to define the type of form and EDI standard, 
version, transaction (message), and release. In this tutorial, you are creating a screen entry 
form so that your data entry users can enter EDI data in an invoice translation object in 
Gentran:Server. Instead of defining the INVOIC message to the system yourself, you want 
Gentran:Server to use the standards database on your system to build the invoice 
according to the TRADACOMS standard.

Procedure Use this procedure to create the new screen entry form.

Important
After you create a new form, it is important to define the details of the form and save it. 
The Save function writes (saves) the currently-selected form to disk.

Step Action

1 Select New from the File menu to display the New Form Wizard.

2 From the Translation Object Function drop-down list box, accept the 
default value Screen entry to indicate that the translation object you are 
creating is a screen entry translation object.

3 From the Data Source drop-down list box, select the ODBC data source 
that you wish to use.

4 From the Agency drop-down list box, select [A] Tradacoms, which is the 
EDI standard you will use for this translation object.

5 From the Version drop-down list box, select [ANA001], which is the 
version of the standard you will use for this translation object. The 
versions that are available depend on which standard you selected.

(Continued on next page)
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6 From the Transaction drop-down list box, select [INVOIC] INVOICE 
DETAILS, which is the transaction set (message) you will use for this 
translation object. The messages that are available depend on which 
standard and version you selected.

7 From the Release drop-down list box, select 9, which is the message 
version you will use for this translation object. The message versions that 
are available depend on which message (transaction) you selected.

8 Click OK to create the EDI file (it may take a few seconds to create the 
file). The form is displayed as follows:

9 Select Save from the File menu. 

System Response
The Translation Object Details dialogue is displayed.

Note
If you have performed any function that invalidates the current format of 
the translation object, the Save function is not available (dimmed) until 
you regenerate the layout (click Generate Layout on the Main Toolbar).

10 In the Author field, enter your name. This field usually contains the name 
of the person who created the form.

(Continued on next page)
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11 In the Description field, enter Screen TRADACOMS INVOIC Pet 
Zone. This field is used to provide a brief explanation of the compiled 
translation object that will enable you to differentiate it from similar 
translation objects in Gentran:Server. For example, “Screen 
TRADACOMS INVOIC Pet Zone” is the description of a screen entry 
translation object for a TRADACOMS ANA001 invoice (INVOIC) for 
partner Pet Zone.

12 Verify that Screen entry is selected from the Translation Object Function 
drop-down list box.

13 In the Major version field, enter 1 to designate the version number for this 
translation object.

14 In the Minor version field, accept the default value 0 that designates the 
release number for this translation object.

Note
When you make a major change to this form, increase the version to the 
next higher sequential number (e.g. 2.0, 3.0). If you make a minor change 
to the form, increase the release to the next higher sequential number (e.g. 
2.1, 2.2).

15 The Input and Output fields (Agency, Version, Transaction, Release, and F 
Group) contain information only if the Input and/or Output sides of the 
form are of EDI format. For this tutorial, do not change the information in 
these fields.

Note
The system allows you to change the information in the Input and Output 
fields, but modifying this information does not alter the content of the 
form. An example of when you might want to alter these fields is when 
you want the form to reflect a standard version that is not loaded on your 
system. You can change the version on this dialogue, and then physically 
alter the form to be compliant with that version.

(Continued on next page)
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16 Click OK to save the translation object details and access the Save As 
dialogue.

17 Verify that the Save in drop-down list box reflects the drive\folder where 
Gentran:Server is installed. The default is GENSRVNT\Forms. If the 
selected drive is not the correct one, select the appropriate drive.

18 In the File name field, enter pettinvs.stp to replace the default file name. 
You allocate a filename to a form when you save the form for the first time 
or use the Save As function to save a copy of the form under a different 
name. The name of the form must be one to eight unique characters that 
define the form in a meaningful way. For example, “PETTINVS” is the 
name of a screen entry form for a TRADACOMS invoice message 
(INVOIC) for partner Pet Zone.

The default file extension for forms is .STP. Using this extension 
distinguishes source form files from other types of files, such as compiled 
translation objects. The naming conventions in 
the Gentran:Server Forms Integration subsystem are as follows:

◗ The source form (form created in Gentran:Server) should be named 
using the file extension .STP (e.g. PETTINVS.STP).

◗ The compiled translation object (translation object that is the result of 
compiling the source form) should be named using the same filename 
that was allocated to the source form, but with the file extension .TPL 
(e.g. PETTINVS.TPL).

Recommendation
We recommend that you use these naming conventions to distinguish 
source forms and compiled translation objects from other types of files. 
We also recommend that you use the same filename (different file 
extension) for a source form and the translation object that was compiled 
from it.

(Continued on next page)
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Recommendation
We recommend that you save the form as often as possible, to mitigate the possible loss of 
additions or modifications in the event of a hardware or system error.

19 Click Save to save the form.

 (Contd)
Step Action



Activating Groups, Segments, Composites, and Elements Creating a Screen Entry Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

3 - 28

Activating Groups, Segments, Composites, and Elements

Overview When Gentran:Server generates the form, the system includes all the groups, segments, 
composites, and elements that are defined by the standard agency (TRADACOMS) for the 
version (ANA001), message (INVOIC), and release (9) you selected. The system activates 
all the groups, segments, composites, and elements that are defined as mandatory (must be 
present) by the standard. The system does not enable you to deactivate the mandatory 
groups, segments, and elements.

Example In the example below, the INVOIC group, CLO segment, and CLO CLOC composite are 
mandatory for the invoice. You do not need to activate these components. The CLO 
CLOC CLO0, CLO CLOC CLO1, and CLO CLOC CLO2 elements are not mandatory, so 
they are dimmed on the form. To view the segments, composites, and elements in a group, 
segment, or composite on your form, double-click the form component in the EDI File 
Format Window (left side of the Forms main window). To activate an inactive form 
component, click Activate on the Main Toolbar, then click the form component. The 
component is no longer dimmed.

When translating data, the system does not process groups, segments, composites, and 
elements that are not activated. Therefore, you must activate the groups, segments, 
composites, and elements that are not defined as mandatory by the standard, but that you 
have determined that you need to use in the form.
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Groups, segments,
composites, and
elements used in

this tutorial

This table lists the groups, segments, composites, and elements to be used in this tutorial.

Group Group Segment Composite Element

CLO
(already 
activated)

CLOC
(already 
activated)

CLO0

CLO1

CNAM

CADD CAD0

CAD1

CAD2

CAD3

CAD4

PYT PAYT

DNA GNAR GNA0

GNA1

GNA2

GNA3

ODD
(already
activated)

ODD:2 ORNO
(mandatory for 
ODD:2)

ORN0

ORN2

DELN
(mandatory for 
ODD:2)

DEL0

DEL1

ILD
(already 
activated)

ILD:2 SPRO
(mandatory for 
ILD:2)

SPR0

SPR1

CPRO CPR1

QTYI
(mandatory for 
ILD:2)

QTY0

CD04:2

TDES TDE0
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Procedure Use this procedure to activate the required groups, segments, composites, and elements.

Step Action

1 Double-click the groups, segments, and composites listed in the table 
below to open them. This table lists all the segments, composites, and 
elements that you need to activate. Opening all the necessary groups, 
segments, and composites before you start to activate enables you to scroll 
down the form and activate the segments, composites, and elements 
sequentially.

Note
When you activate a conditional group, segment, or composite, the 
mandatory subordinate segments, composites, and elements are activated 
automatically.

2 Click Activate on the Main Toolbar.

3 Click each inactive segment that you need to use. Clicking these segments 
will activate the segments.

Note
If you accidentally click a segment that you did not mean to activate, click 
the segment with the right mouse button to access the shortcut menu. 
Select Deactivate from the shortcut menu.

4 Click each inactive composite that you need to use. Clicking these 
composites will activate the composites.

Note
If you accidentally click a composite that you did not mean to activate, 
click the composite with the right mouse button to access the shortcut 
menu. Select Deactivate from the shortcut menu.

5 Click each inactive element that you need to use. Clicking these elements 
will activate the elements. When you activate an element in a screen entry 
form, either the tag “Edit Box” or the tag “Drop Down” is displayed 
before that element’s description. “Edit Box” indicates that the element is 
formatted as a field. “Drop Down” indicates that the element is formatted 
as a drop-down list box because you applied a standard rule that allows a 
selection of multiple items.

Note
If you accidentally click an element that you did not mean to activate, 
click the element with the right mouse button to access the shortcut menu. 
Select Deactivate from the shortcut menu.

6 Click Activate on the Main Toolbar to turn activation mode off.
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Verifying EDI Delimiters and Adding Frame Help Text

Overview You are using an EDI standard that contains composite elements, so you must verify that 
Gentran:Server is specifying the correct delimiters. Delimiters are flags that you define to 
the system as separating specific EDI components. Delimiters are necessary for all 
variable field-length standards, because the data is compressed (and the leading zeroes and 
trailing blanks are removed). The fields vary in length, so the system needs a flag to 
determine where one element ends and another begins. For example, an element delimiter 
marks the beginning of a new element.

Important
Although verifying EDI delimiters in Gentran:Server is mandatory only if you are using a 
standard with composite elements or subelements, we recommend that you perform this 
task regardless of which standard you use.

In addition, you will add frame Help text so screen entry translation object users can 
access online Help for the Invoice Details frame.

EDI delimiters
table

This table lists the valid EDI delimiters.

Field
TRADACOMS 

Default Character
TRADACOMS 

Default Hex Value

Tag Delimiter = (equal sign) Ox3D

Segment Delimiter ’ (apostrophe) 0x27

Element Delimiter + (plus sign) 0x2B

Sub Element Delimiter : (colon) 0x3A

Decimal Separator . (full stop) 0x2E

Release Character ? (question mark) 0x3F
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Procedure Use this procedure to verify EDI delimiters and add frame Help text.

Step Action

1 Click the Invoic file icon with the right mouse button and select 
Properties from the shortcut menu to display the File Format Properties 
dialogue.

2 Select the Display tab.

(Continued on next page)
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3 In the Frame Help Text list box, enter the following text (press Enter at 
the end of each line of text below):

This frame contains information pertaining
to the entire invoice message (INVOIC).
For online Help on an individual field on
this frame, select the field and press F1.

Note
Pressing Enter creates line breaks for the online Help that the screen entry 
translation object users in Gentran:Server view when they press F1. If you 
do not create line breaks, the online Help will be displayed on one line of 
text in the online Help pop-up window (the text will not wrap to the next 
line), and text that extends beyond the width of the user’s monitor will not 
be displayed.

When you generate the form (display the fields in the Layout Window), 
there is one frame in the Layout Window (right side of Forms main 
window) for every group and repeating segment in the EDI File Format 
Window (left side of Forms main window). Entering frame Help text for 
the group or segment corresponding to each frame enables screen entry 
translation object users to access context-sensitive Help text for the frame.

4 Select the Delimiters tab to access the Delimiters dialogue.

(Continued on next page)
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5 Verify that the correct delimiters are being used for the TRADACOMS 
standard. If the delimiters differ from the default values listed in the 
previous table, you can enter either the character or the hexadecimal value 
in the correct field.

Note
If you use the default hex value, the value must begin with “0x” (the 
number zero and the letter “x”).

The Stream segments check box on the Delimiters dialogue currently is 
not marked. For this tutorial, do not mark this check box, so the translator 
will continue to insert a carriage return after every segment. If the Stream 
segments check box is marked, then a carriage return is not used after 
every segment, and the segments are “streamed.”

6 Click OK to save the delimiters and exit the Delimiters dialogue.

 (Contd)
Step Action
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Modify Form Components 0

Changing the Maximum Use of Segments and Groups

Introduction Changing the maximum use of a segment or group changes the maximum number of times 
the segment or group can be used. A segment or group with a maximum use greater than 
one repeats (loops), and is placed on a separate frame than the segment or group to which 
it is subordinate. A segment or group with a maximum use of one does not repeat, and its 
fields are displayed on the same frame as the group to which it is subordinate.

In this tutorial, you will change the maximum use of the groups and segments before you 
generate the form (display the fields in the Layout Window). By customising the group 
and segment properties first, all fields are placed on their appropriate frames the first time 
you generate the form. If you change the maximum use of the groups and segments after 
you generate the form, the fields will be placed on several more frames than will be 
present ultimately in the form. Therefore, changing the group and segment properties 
before you first generate the form enables the fields to be placed on as few frames as 
necessary.
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Changing the Maximum Use of the IRF Segment

Overview The IRF segment contains the Invoice References for the invoice. In this tutorial, the IRF 
segment will be used for the invoice number, invoice date, and tax-point date. The 
standard allows the IRF segment to be used up to 999,999 times in one invoice. In this 
tutorial, you will use the IRF segment only once per invoice. You will change the 
maximum use of the IRF segment to one, which will place the associated fields on the 
main Invoice Details frame with the majority of the invoice fields.

Procedure Use this procedure to change the maximum use of the IRF segment.

Step Action

1 Click the IRF segment with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu. 

System Response
The EDI Segment Properties dialogue is displayed.

3 Select the Looping tab.

4 In the Max Usage field, enter 1 to designate that this segment can be used 
only once per invoice.

5 Click OK to exit the EDI Segment Properties dialogue.
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Changing the Maximum Use of the PYT Segment 

Overview The PYT segment contains the Settlement Terms for the invoice. In this tutorial, the PYT 
segment will be used for the describing the terms of payment. The standard allows the 
PYT segment to be used up to 999,999 times in one invoice. In this tutorial, you will use 
the PYT segment only once per invoice. You will change the maximum use of the PYT 
segment to one, which will place the associated fields on the main Invoice Details frame 
with the majority of the invoice fields.

Procedure Use this procedure to change the maximum use of the PYT segment.

Step Action

1 Click the PYT segment with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialogue is displayed.

3 Select the Looping tab.

4 In the Max Usage field, enter 1 to designate that this segment can be used 
only once per invoice.

5 Click OK to exit the EDI Segment Properties dialogue.
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Changing the Maximum Use of the DNA Segment 

Overview The DNA segment contains the Data Narrative for the invoice. In this tutorial, the DNA 
segment will be used for narrative (descriptive text) describing information that cannot be 
sent in a coded form. The standard allows the DNA segment to be used up to 999,999 
times in one invoice. In this tutorial, you will use the DNA segment only once per invoice. 
You will change the maximum use of the DNA segment to one, which will place the 
associated fields on the main Invoice Details frame with the majority of the invoice fields.

Procedure Use this procedure to change the maximum use of the DNA segment.

Step Action

1 Click the DNA segment with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu. 

System Response
The Segment Properties dialogue is displayed.

3 Select the Looping tab.

4 In the Max Usage field, enter 1 to designate that this segment can be used 
only once per invoice.

5 Click OK to exit the Segment Properties dialogue.
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Changing the Maximum Use of the ODD Group 

Overview The ODD group contains the Order and Delivery Terms information for the invoice. In 
this tutorial, the ODD group will be used for information about the customer’s order 
number, the date the order was placed, and the delivery number and date. The standard 
allows the ODD group to be used up to 999,999 times per invoice (because you are 
addressing only one order with this invoice). In this tutorial, you will use the ODD group 
only once per invoice. You will change the maximum use of the ODD group to one, which 
will place the associated fields on the main Invoice Details frame with the majority of the 
invoice fields.

Procedure Use this procedure to change the maximum use of the ODD group.

Step Action

1 Click the ODD group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialogue is displayed.

2 Select the Looping tab.

3 In the Max Usage field, enter 1 to designate that this group can be used 
only once per invoice.

4 Select the Display tab.
(Continued on next page)
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5 Click the Promote group to parent frame check box to promote this 
group. The fields in this group will be displayed on the same frame as the 
fields in the parent group (INVOIC).

Note
Although this group has a maximum use of one, if you do not mark the 
Promote group to parent frame check box, then the fields in this group will 
not be displayed on the same frame in the Layout Window as the fields in 
the parent group.

6 Click OK to exit the Group Properties dialogue.

 (Contd)
Step Action
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Generating the Form

Overview Generating a form is different from compiling a form. When you compile a form, the 
source form is translated into a compiled translation object. When you generate a form, 
the fields of the form are displayed on a frame in the Layout Window (right side of the 
Forms main window), based on the groups, segments, and elements that are activated. 

Note
You can, and should, regenerate (or refresh) the form several times as you customise and 
format the form to ensure that you are viewing the most recent changes to the Layout 
Window.

Procedure Use this procedure to generate the print form based on the groups, segments, and elements 
you activated.

Step Action

1 Select the INVOIC file icon. Selecting the INVOIC file icon before you 
generate the layout enables you to view the beginning of the invoice 
layout in the Layout Window after the layout is generated. However, 
selecting the INVOIC file icon is not a required prerequisite to generating 
the layout.

(Continued on next page)
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2 Click Generate Layout on the Main Toolbar.

System Response
The layout of the screen entry form will be displayed in the Layout 
Window.

Note
You should regenerate the form periodically as you customise the screen 
entry form to ensure that the most recent changes to the frame are 
reflected in the Layout Window.

 (Contd)
Step Action
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After generating
the form

After you generate the form, there is one field on the right side of your screen (Layout 
Window) for every activated element on the left side of your screen (EDI File Format 
Window). You can click either the field or its corresponding element to select it. To access 
the Element Properties dialogue for a field or element, either double-click the element, or 
use the right mouse button to click the field or element, and then select Properties from the 
shortcut menu.

Note
When you first generate the form, each field in the Layout Window is labelled with the 
same name as its corresponding element in the EDI File Format Window. As you 
customise the form, however, you will change some of the labels and remove others, so all 
the fields will not be labelled the same as their corresponding elements. Even though you 
will change or remove some field labels, each field still corresponds to one element.

When the screen entry form is generated, the fields associated with each non-repeating 
segment or group are displayed on a frame in the Layout Window. If a segment or group is 
defined as repeating, then a list box is displayed on the parent frame, and the fields for that 
repeating segment or group are displayed on a separate frame. 

All frames in a screen entry form are titled. The default title for each frame is its message, 
group, or segment name, but you can change the default titles to better identify the 
information that will be entered.
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Customise the EDI Data 0

Overview

Introduction You can customise the form, including the properties of each type of form component 
(group, segment, and element).

Customising the form is an iterative process. This tutorial guides you through all the steps 
involved in customising the form, component by component. When you create forms, you 
usually will activate the form components you need to use, customise and format the form 
components, then compile the form and test the translation object (and print a report, if 
necessary). As you substantially customise the form, you usually will compile and print 
the form several times to view your changes before the form truly is finalised.

This section explains how to customise the form components for each sequential 
component in this tutorial.

How to set up the
document name

We recommend that you set up a Document Name for each form. The document name 
makes the identification of a document created by the form easier in Gentran:Server. 
Setting up the document name enables you to differentiate between documents in the 
document browsers in Gentran:Server. If you set up the document name in the Forms 
Integration subsystem, the Name field of the document browsers that contain this message 
in Gentran:Server will contain the data from that element. You can choose any element as 
the document name, but we strongly recommend that you select an element that occurs 
only once in the message and has a data type of string. For a TRADACOMS ANA001 
INVOIC release 9 invoice, the document name usually is the Invoice Number.

Use this procedure to set up the document name.

Step Action

1 Double-click the IRF INVN element. 

System Response
The Element Properties dialogue is displayed.

Recommendation
In this tutorial, we recommend that you select this element because it is a 
non-recurring and mandatory element, and it will help identify this 
message meaningfully in Gentran:Server.

2 Select the Use Standard Rule tab.

3 Select the Update option from the drop-down list.
(Continued on next page)



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Screen Entry Form Overview 3 - 45

4 From the Table/Group drop-down list box, select Document record to 
indicate that you are updating the document record in Gentran:Server.

5 From the Column/Field drop-down list box, select Document Name to 
indicate that you are updating the Name field (in the Gentran:Server 
document browsers that contain this message) with the contents of the IRF 
INVN element.

The dialogue now should look like this:

6 Click OK to set up the document name.

 (Contd)
Step Action
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Customising the CLO Segment

Overview The CLO segment (Customer’s Location) contains details about the specific customer 
location pertaining to this invoice. In this tutorial, the CLO segment contains details 
relating to the specific Pet Zone store you are invoicing.

Customising the
CLO CLOC CLO0

element

The CLO CLOC CLO0 element (Customer’s ANA Location Code) contains the code 
assigned by the Article Numbering Association for the customer’s location. In this 
tutorial, your users will enter the customer’s ANA location code (which they will obtain 
from the purchase order for the invoiced items). 

Your trading partner, Pet Zone, uses a string of numbers for the ANA location code, so 
you will create a syntax token that allows only numbers in the screen and EDI formats of 
the data. Syntax tokens enable you to designate a “token” that defines ranges of characters 
and/or numbers that are allowed to be used for a string-type element. The characters 
defined in the syntax token are used while compliance checking each element to ensure 
that the data in the element falls within the range of allowed characters.

In addition to creating a syntax token to be used for the screen and EDI formats of the 
data, you will rename the field label to make it shorter and add Help text to the field.

How to create a
syntax token

Use this procedure to create a syntax token.

Step Action

1 Select Syntax Tokens from the Edit menu to display the Syntax Tokens 
dialogue.

(Continued on next page)
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2 The Token column contains the value designated as the syntax token for 
each existing syntax token. The Token contains a range of characters that, 
when applied to an element, dictate the way that element must be 
formatted. If the element is not formatted as specified, the system will 
generate a compliance error.

The Allowed character ranges column contains the range(s) of characters 
that are permitted for each existing syntax token. Each range consists of a 
pair of characters that define the start and end characters.

3 Click New to access the Edit Syntax Token dialogue.

4 In the Token field, enter 9 to designate the unique one-character 
alphanumeric value that the system will recognise as containing the 
allowed range of characters you designate.

The Character Ranges list box contains the character range or ranges that 
you defined for this token. You can define more than one character range 
for each token.

5 Click New to access the Edit Character Range dialogue, which enables 
you to create a character range.

Note
Gentran:Server uses the ANSI character set when determining the start-
end range.

6 In the Start character field, enter 0, which is the character that begins the 
allowed token range.

7 In the End character field, enter 9, which is the character that terminates 
the allowed token range.

(Continued on next page)
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How to change the
CLO CLOC CLO0

element and field
properties

Use this procedure to change the screen and EDI formats for the data, rename the field 
label, and add Help text to the Customer’s ANA Location Code field.

8 Click OK to exit the Edit Character Range dialogue.

9 Click OK to save the syntax token and exit the Edit Syntax Token 
dialogue.

10 Click Close to exit the Syntax Tokens dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the CLO CLOC CLO0 element.

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Form Format field, enter 9, which is the name of the syntax token 
you just created for allowing users to enter data with only the characters 
0–9 in this element.

4 In the File Format field, enter 9, which is the name of the syntax token you 
just created for allowing the EDI data to consist of only the characters 0–9 
in this element.

5 Select the Display tab.

6 In the Label field, enter Location ANA Code to replace the existing field 
label.

7 Select the Help tab.

8 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the EAN location number identifying this customer’s 
location. You must enter a numeric value in this field.

9 Click OK to exit the dialogue.
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How to customise
the CLO CLOC

CLO1 element

The CLO CLOC CLO1 element (Customer’s Own Location Code) contains the code 
assigned by the customer for the location to which the invoiced items are to be delivered. 
In this tutorial, your users will enter the customer’s own location code (which you have 
obtained from Pet Zone). 

In this tutorial, you know that Pet Zone’s own location code will not exceed ten characters, 
so you will change the field and element lengths to ten. In addition, you will rename the 
field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add 
Help text to the Customer’s Own Location Code field.

Step Action

1 Double-click the CLO CLOC CLO1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 10 to allow a ten-character string in this element.

4 Select the Display tab.

5 In the Label field, enter Location Own Code to replace the existing field 
label.

6 In the Display Length field, enter 10 to allow ten characters to be entered 
in this field.

7 Select the Help tab.

8 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the customer’s own location number identifying the 
location to which the invoiced items are to be delivered.
The customer’s location number may not exceed 10
alphanumeric characters.

9 Click OK to exit the dialogue.
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How to customise
the CLO CNAM

element

The CLO CNAM element (Customer’s Name) contains the customer’s registered legal 
name.

In this tutorial, you want the Customer’s Name field to be the same length as the address 
fields that follow (in the CLO CADD composite), so you will change the field and element 
lengths for the Customer’s Name field to thirty-five. In addition, you will rename the field 
label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add 
Help text to the Customer’s Name field.

Step Action

1 Double-click the CLO CNAM element.

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 35 to allow a thirty-five-character string in this 
element.

4 Select the Display tab..

5 In the Label field, enter Name to replace the existing field label.

6 In the Display Length field, enter 35 to allow thirty-five characters to be 
entered in this field.

7 Select the Help tab.
(Continued on next page)
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How to customise
the CLO CADD

CAD0 element

The CLO CADD CAD0 element (Customer’s Address Line 1) contains the first line of the 
customer’s address. You will rename the field label to shorten it and add Help text to this 
field.

Use this procedure to rename the field label and add Help text to the Customer’s Address 
Line 1 field.

8 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the customer’s name. The name may not exceed 35 
alphanumeric characters.

9 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the CLO CADD CAD0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Address Line 1 to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the first line of the customer’s address. This address line 
may not exceed 35 alphanumeric characters.

6 Click OK to exit the dialogue.
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How to customise
the CLO CADD

CAD1 element

The CLO CADD CAD1 element (Customer’s Address Line 2) contains the second line of 
the customer’s address. You will rename the field label to shorten it and add Help text to 
this field.

Use this procedure to rename the field label and add Help text to the Customer’s Address 
Line 2 field.

How to customise
the CLO CADD

CAD2 element

The CLO CADD CAD2 element (Customer’s Address Line 3) contains the third line of 
the customer’s address. You will rename the field label to shorten it and add Help text to 
this field.

Use this procedure to rename the field label and add Help text to the Customer’s Address 
Line 3 field.

Step Action

1 Double-click the CLO CADD CAD1 element.

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Address Line 2 to replace the existing field label.

4 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the second line of the customer’s address. This 
address line may not exceed 35 alphanumeric characters.

5 Click OK to exit the dialogue.

Step Action

1 Double-click the CLO CADD CAD2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Address Line 3 to replace the existing field label.

4 Select the Help tab.
(Continued on next page)
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How to customise
the CLO CADD

CAD3 element

The CLO CADD CAD3 element (Customer’s Address Line 4) contains the fourth line of 
the customer’s address. You will rename the field label to shorten it and add Help text to 
this field.

Use this procedure to rename the field label and add Help text to the Customer’s Address 
Line 4 field.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the third line of the customer’s address. This address
line may not exceed 35 alphanumeric characters.

6 Click OK to exit the dialogue.

Step Action

Step Action

1 Double-click the CLO CADD CAD3 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Address Line 4 to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the fourth line of the customer’s address. This address
line may not exceed 35 alphanumeric characters.

6 Click OK to exit the dialogue.
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How to customise
the CLO CADD

CAD4 element

The CLO CADD CAD4 element (Customer’s Post Code) contains the post code of the 
customer’s address. You will rename the field label to shorten it and add Help text to this 
field.

Use this procedure to rename the field label and add Help text to the Customer’s Post 
Code field.

Step Action

1 Double-click the CLO CADD CAD4 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Post Code to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the post code of the customer’s address. The post 
code may not exceed 8 alphanumeric characters.

6 Click OK to exit the dialogue.
(Continued on next page)
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7 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

The Invoice Details frame now should look like this:

 (Contd)
Step Action
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Customising the IRF Segment

Overview The IRF segment (Invoice References) contains details about the invoice, such as the 
invoice number, invoice date, and tax-point date. This segment, and all the elements 
contained in it, must be present in the invoice. You already changed the maximum use for 
this segment, so that this segment will be used only once in an invoice.

How to customise
the IRF INVN

element

The IRF INVN element (Invoice Number) contains the number assigned by the supplier 
for this invoice (in this tutorial, you are the supplier). You will rename the field label to 
shorten it and add Help text to this field. (You already set up this element as the document 
name.)

Use this procedure to rename the field label and add Help text to the Invoice Number field.

Step Action

1 Double-click the IRF INVN element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Invoice No. to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the invoice number. The invoice number may not
exceed 17 alphanumeric characters.

6 Click OK to exit the dialogue.



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Screen Entry Form Customising the IRF Segment 3 - 57

How to customise
the IRF IVDT

element

The IRF IVDT element (Date of Invoice) contains the invoice date. You will change the 
screen format for the invoice date to DD/MM/YY. Also, this element is defined by the 
standard to be a six-digit date. In this tutorial, your users will enter the invoice date as an 
eight-digit date, so you will change the element and field lengths to accommodate the 
longer date. In addition, you will rename the field label and add Help text to this field.

Use this procedure to change the screen format, change the field and element lengths, 
rename the field label, and add Help text to the Date of Invoice field.

Step Action

1 Double-click the IRF IVDT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators 
(/), to be contained in this element

4 From the Form Format drop-down list box, select DD/MM/YY to indicate 
that this field on the translation object will accept a date entered in the 
format DD/MM/YY.

5 Select the Display tab.

6 In the Label field, enter Invoice Date to replace the existing field label.

7 In the Display Length field, enter 8 to allow the entire date to be 
displayed, including separators (/).

8 Select the Help tab.

9 In the Help Text list box, enter the following text:

Enter the invoice date. Use the format DD/MM/YY.

10 Click OK to exit the dialogue.
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How to customise
the IRF TXDT

element

The IRF TXDT element (Tax-Point Date) contains the date on which the VAT is applied. 
The tax-point date often is the same as the invoice date. You will change the screen format 
for the tax-point date to DD/MM/YY. Also, this element is defined by the standard to be a 
six-digit date. In this tutorial, your users will enter the invoice date as an eight-digit date, 
so you will change the element and field lengths to accommodate the longer date. In 
addition, you will add Help text to this field.

Use this procedure to change the screen format, change the field and element lengths, and 
add Help text to the Date of Invoice field.

Step Action

1 Double-click the IRF TXDT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators 
(/), to be contained in this element.

4 From the Form Format drop-down list box, select DD/MM/YY to indicate 
that this field on the translation object will accept a date entered in the 
format DD/MM/YY.

5 Select the Display tab.

6 In the Display Length field, enter 8 to allow the entire date to be 
displayed, including separators (/).

7 Select the Help tab.

8 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the tax-point date. The tax-point date is the date the 
VAT was applied. Use the format DD/MM/YY.

9 Click OK to exit the dialogue.

(Continued on next page)
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10 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

The Invoice Details frame now should look like this:

 (Contd)
Step Action
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Customising the PYT Segment

Overview The PYT segment (Settlement Terms) specifies the settlement terms that apply to the 
invoice. You already changed the maximum use of the PYT segment to one.

How to customise
the PYT SEQA

element

The PYT SEQA element (First Level Sequence Number) contains the sequence number 
for the PYT segment. According to the standard, this number starts at one and increases 
for each occurrence of the PYT segment. You already changed the maximum use of the 
PYT segment to one (indicating that you will use the PYT segment only once per invoice). 
You will define a constant value for this field, designating that the constant “ONE” (which 
has a value of “1”) is always the value in the PYT SEQA element. Then, you will prevent 
this field from being displayed in the screen entry form, since users will not need to enter 
a value in this field.

Use this procedure to define a constant and hide the First Level Sequence Number field.

Step Action

1 Double-click the PYT SEQA element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option from the drop-down list.

4 Click Edit to access the Map Constants dialogue.
(Continued on next page)
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5 Click New to access the Edit Constant dialogue.

6 In the ID field, enter ONE to identify the constant.

7 From the Type drop-down list box, select Integer to indicate that the 
literal constant will be formatted as an integer (number) data type (not 
containing decimal places).

8 In the Value field, enter 1 to indicate that the First Level Sequence 
Number field must contain the value 1. This value is the actual value of 
the literal constant.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialogue.

11 In the Constants drop-down list box, select 1 to identify the constant that 
will be used for this element. 

The dialogue now should look like this:

12 Select the Display tab.

(Continued on next page)

 (Contd)
Step Action
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How to customise
the PYT PAYT

element

The PYT PAYT element (Terms of Payment) contains the description of the settlement 
terms. You will rename the field label and add Help text to this field.

Use this procedure to rename the field label and add Help text to the Terms of Payment 
field.

13 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

14 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the PYT PAYT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Payment Terms to replace the existing field 
label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the payment terms. The payment terms may not exceed 
40 alphanumeric characters.

6 Click OK to exit the dialogue.
(Continued on next page)
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7 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

The Invoice Details frame now should look like this:

 (Contd)
Step Action



Customising the DNA Segment Creating a Screen Entry Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

3 - 64

Customising the DNA Segment

Overview The DNA segment (Data Narrative) contains narrative (descriptive text) pertaining to the 
invoice. The standard allows this segment to be used up to 999,999 times in an invoice. 
Your users will use this segment only once per segment, so you already changed the 
maximum use to one.

How to customise
the DNA SEQA:2

element

The DNA SEQA:2 element (First Level Sequence Number) contains the sequence number 
for the DNA segment. According to the standard, this number starts at one and increases 
for each occurrence of the DNA segment. You already changed the maximum use of the 
DNA segment to one (indicating that you will use the DNA segment only once per 
invoice). You will use the constant “ONE” (which has a value of “1”), so that “1” is 
always the value in the DNA SEQA:2 element. Then, you will prevent this field from 
being displayed in the screen entry form, since users will not need to enter a value in this 
field.

Step Action

1 Double-click the DNA SEQA:2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Standard Rule tab.

3 Select the Use Constant option from the drop-down list.

4 In the Constants drop-down list box, select 1 to identify the constant that 
will be used for this element. 

5 Select the Display tab.

6 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

7 Click OK to exit the dialogue.
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How to customise
the DNA GNAR

GNA0 element

The DNA GNAR GNA0 element (General Narrative Line 1) contains descriptive text 
pertaining to the invoice. Users can enter up to four lines (each with up to forty characters) 
of descriptive text. For this tutorial, you will rename the field label Invoice Notes and add 
Help text to this field.

Use this procedure to rename the field label and add Help text to the General Narrative 
Line 1 field.

How to customise
the DNA GNAR

GNA1 element

The DNA GNAR GNA1 element (General Narrative Line 2) contains the second line of 
descriptive text pertaining to the invoice. Users can enter up to four lines (each with up to 
forty characters) of descriptive text. For this tutorial, only the first line of descriptive text 
(General Narrative Line 1) will be labelled. Therefore, you will remove the field label for 
the General Narrative Line 2 field and add Help text to this field.

Use this procedure to remove the field label and add Help text to the General Narrative 
Line 2 field.

Step Action

1 Double-click the DNA GNAR GNA0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Invoice Notes to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the first line of the invoice notes. The invoice notes 
consist of descriptive text that pertains to the entire invoice. 
This line of invoice notes may not exceed 40 alphanumeric 
characters.

6 Click OK to exit the dialogue.

Step Action

1 Double-click the DNA GNAR GNA1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, delete the existing field label.
(Continued on next page)
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How to customise
the DNA GNAR

GNA2 element

The DNA GNAR GNA2 element (General Narrative Line 3) contains the third line of 
descriptive text pertaining to the invoice. Users can enter up to four lines (each with up to 
forty characters) of descriptive text. For this tutorial, only the first line of descriptive text 
(General Narrative Line 1) will be labelled. Therefore, you will remove the field label for 
the General Narrative Line 3 field and add Help text to this field.

Use this procedure to remove the field label and add Help text to the General Narrative 
Line 3 field.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the second line of the invoice notes. The invoice 
notes consist of descriptive text that pertains to the entire 
invoice. This line of invoice notes may not exceed 40 
alphanumeric characters.

6 Click OK to exit the dialogue.

Step Action

Step Action

1 Double-click the DNA GNAR GNA2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the third line of the invoice notes. The invoice 
notes consist of descriptive text that pertains to the entire 
invoice. This line of invoice notes may not exceed 40 
alphanumeric characters.

6 Click OK to exit the dialogue.
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How to customise
the DNA GNAR

GNA3 element

The DNA GNAR GNA3 element (General Narrative Line 4) contains the fourth line of 
descriptive text pertaining to the invoice. Users can enter up to four lines (each with up to 
forty characters) of descriptive text. For this tutorial, only the first line of descriptive text 
(General Narrative Line 1) will be labelled. Therefore, you will remove the field label for 
the General Narrative Line 4 field and add Help text to this field.

Use this procedure to remove the field label and add Help text to the General Narrative 
Line 4 field.

Step Action

1 Double-click the DNA GNAR GNA3 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the fourth line of the invoice notes. The invoice 
notes consist of descriptive text that pertains to the entire 
invoice. This line of invoice notes may not exceed 40 
alphanumeric characters.

6 Click OK to exit the dialogue.

(Continued on next page)
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7 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

The section of the Invoice Details frame that contains the fields in the 
DNA segment now should look like this:

 (Contd)
Step Action
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Customising the ODD Group

Overview The ODD group contains the Order and Delivery Terms information for the invoice. In 
this tutorial, the ODD group will be used for information about the customer’s order 
number, the date the order was placed, and the delivery number and date. The standard 
allows the ODD group to be used up to 999,999 times per invoice. In this tutorial, you will 
use the ODD group only once per invoice. You already changed the maximum use of the 
ODD group to one, which placed the associated fields on the main Invoice Details frame 
with the majority of the invoice fields.

How to customise
the ODD:2 SEQA

element

The ODD:2 SEQA element (First Level Sequence Number) contains the sequence number 
for the ODD:2 segment. According to the standard, this number starts at one and increases 
for each occurrence of the ODD:2 segment. The ODD:2 segment has a maximum use of 
only one, so the value in the ODD:2 SEQA element will always be “1”. You will use the 
constant “ONE” (which has a value of “1”), so that “1” is always the value in the ODD:2 
SEQA:2 element. Then, you will prevent this field from being displayed in the screen 
entry form, since users will not need to enter a value in this field.

Step Action

1 Double-click the ODD:2 SEQA element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Standard Rule tab.

3 Select the Use Constant option from the drop-down list.
(Continued on next page)
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4 From the Constants drop-down list box, select 1 to identify the constant 
that will be used for this element. 

The dialogue now should look like this:

5 Select the Display tab.

6 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

7 Click OK to exit the dialogue.

 (Contd)
Step Action
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How to customise
the ODD:2 ORNO

ORN0 element

The ODD:2 ORNO ORN0 element (Customer’s Order Number) contains the number 
assigned by the customer to identify the order. You will rename the field label and add 
Help text to this field.

Use this procedure to change the field label for the Customer’s Order Number field.

Step Action

1 Double-click the ODD:2 ORNO ORN0 element. 

System Response
The Element Properties dialogue is displayed.

(Continued on next page)
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2 Click Display to access the Display Properties dialogue.

3 In the Label field, enter Customer’s P.O. No. to replace the existing field 
label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the customer’s purchase order number. The purchase 
order number may not exceed 17 alphanumeric characters.

6 Click OK to exit the dialogue.

 (Contd)
Step Action
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How to customise
the ODD:2 ORNO

ORN2 element

The ODD:2 ORNO ORN2 element (Date Order Placed by Customer) contains the date on 
which the customer placed the purchase order. You will change the screen format for the 
purchase order date to DD/MM/YY. Also, this element is defined by the standard to be a 
six-digit date. In this tutorial, the purchase order date will be printed as an eight-digit date, 
so you will change the element and field lengths to accommodate the longer date. For 
brevity, you will change the field label to P.O. Date. 

Use this procedure to change the screen format, change the element and field lengths, and 
rename the field label for the Date Order Placed by Customer field.

Step Action

1 Double-click the ODD:2 ORNO ORN2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators 
(/), to be contained in this element.

4 From the Form Format drop-down list box, select DD/MM/YY to indicate 
that this field on the translation object will accept a date entered in the 
format DD/MM/YY.

5 Select the Display tab.

6 In the Label field, enter P.O. Date to replace the existing field label.

7 In the Display Length field, enter 8 to allow the entire date, including 
separators (/), to be displayed.

8 Select the Help tab.

9 In the Help Text list box, enter the following text:

Enter the purchase order date. Use the format DD/MM/YY.

10 Click OK to exit the dialogue.
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How to customise
the ODD:2 DELN

DEL0 element

The ODD:2 DELN DEL0 element (Delivery Note Number) contains the number 
corresponding to the delivery note. The only customising you will perform for this field is 
adding Help text. 

Use this procedure to add Help text to the Delivery Note Number field.

How to customise
the ODD:2 DELN

DEL1 element

The ODD:2 DELN DEL1 element (Date of Despatch by Supplier) contains the date on 
which the order was delivered. You will change the screen format for the delivery date to 
DD/MM/YY. Also, this element is defined by the standard to be a six-digit date. In this 
tutorial, the delivery date will be printed as an eight-digit date, so you will change the 
element and field lengths to accommodate the longer date. For brevity, you will change 
the field label to P.O. Date. 

Use this procedure to change the screen format, change the element and field lengths, and 
rename the field label for the Date of Despatch by Supplier field.

Step Action

1 Double-click the ODD:2 DELN DEL0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Help tab.

3 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the number corresponding to the delivery note. The 
delivery note number may not exceed 17 alphanumeric 
characters.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the ODD:2 DELN DEL1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 8 to allow the entire date, including separators 
(/), to be contained in this element.

4 From the Screen Format drop-down list box, select DD/MM/YY to 
indicate that this field on the translation object will accept a date entered 
in the format DD/MM/YY.

(Continued on next page)
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5 Select the Display tab.

6 In the Label field, enter Delivery Date to replace the existing field label.

7 In the Display Length field, enter 8 to allow the entire date, including 
separators (/), to be displayed.

8 Select the Help tab.

9 In the Help Text list box, enter the following text:

Enter the delivery date. Use the format DD/MM/YY.

10 Click OK to exit the dialogue.

Step Action
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Customising the ILD Group

Overview The ILD group (Invoice Line Details) contains the line item detail for each item invoiced. 
The standard allows the ILD group to be used up to 999,999 times per invoice.

The fields associated with the ILD group are arranged on the Ild frame, which is separate 
from the Invoice Details frame that you have been working with thus far in this tutorial. 
Your users will complete the fields on the Ild frame for each item in the invoice. The list of 
all line items in the invoice will be displayed in a list box on the Invoice Details frame. In 
that list box, the invoiced items will be displayed line by line, forming columns of 
information.

Procedure Use this procedure to rename the ILD frame and list box, provide a description for the ILD 
group, and add Help text to the line items list box.

Step Action

1 Click the ILD group with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu. 

System Response
The Group Properties dialogue is displayed.

3 In the Desc field, enter Line Items to describe the group.

4 Select the Display tab.
(Continued on next page)



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Screen Entry Form Customising the ILD Group 3 - 77

5 In the Frame Caption field, enter Line Items to rename the frame.

6 In the List Caption field, enter Line Items to rename the list box that is 
displayed on the Invoice Details frame (listing the line items entered on 
the Line Items frame).

7 In the Frame Help Text list box, enter the following text (press Enter at 
the end of each line of text below):

This frame contains line item detail
information. For online Help on an 
individual field on this frame, select the 
field and press F1.

8 In the Listbox Help Text list box, enter the following text (press Enter at 
the end of each line of text below):

This list box contains the line item detail for
the invoice. The data in this list box is
entered or changed on the Line Items
frame. To enter a new line item, click the
list box and click New. To modify an
existing line item, click that item and click
Open.

9 Click OK to exit the Group Properties dialogue.

 (Contd)
Step Action
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Customising the ILD:2 Segment

Overview The ILD:2 segment (Invoice Line Details) contains the line item detail for each item 
invoiced. For some of the elements in the ILD:2 segment, you only need to add Help text 
and rename the field labels so they more accurately reflect your company’s needs. With 
other elements, you will change the maximum lengths for some of the fields, use 
accumulators to calculate the number of line items, or define a constant value.

The ILD:2 group is subordinate to the Invoice Details frame, so Gentran:Server creates a 
separate frame (the Line Items frame) to contain the group data (the line item details). The 
system also creates a list box (the Line Items list box) on the Invoice Details frame to 
allow the user to access the items in the list box. Each set of data is displayed as a row in 
the list box. After you customise the line item fields, the Line Items list box will contain 
these four columns of data: Item, Product, Qty, and Price.
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How to customise
the ILD:2 SEQA

element

The ILD:2 SEQA element (First Level Sequence Number) contains the sequence number 
for the ODD group (the parent group in which the ILD:2 SEQA element resides). 
According to the standard, this number starts at one and increases for each occurrence of 
the ODD group. The ODD group has a maximum use of only one, so the value in the 
ILD:2 SEQA element will always be “1”. You will use the constant “ONE” (which has a 
value of “1”), so that “1” is always the value in the ILD:2 SEQA:2 element. Then, you will 
prevent this field from being displayed in the screen entry form, since users will not need 
to enter a value in this field.

Use this procedure to use a constant and hide the First Level Sequence Number field.

Step Action

1 Double-click the ILD:2 SEQA element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Use Standard Rule tab.

3 Select the Use Constant option.

4 From the Constants drop-down list box, select 1 to identify the constant 
that will be used for this element. 

5 Select the Display tab.

6 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

7 Click OK to exit the dialogue.
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Customising the
ILD:2 SEQB

element

The ILD:2 SEQB element (Second Level Sequence No.) contains the second-level 
sequence number for the ILD:2 segment in the ILD group (the subordinate group in which 
the ILD:2 SEQB element resides). According to the standard, this number starts at one and 
increases for each occurrence of the ILD group. You will use the Loop Count function to 
obtain the value of the current loop count, and then you will make this field display-only 
(since the users will not need to enter a value in this field). Also, since the value in this 
field reflects the sequential number for each line item, you will rename the field label Item 
No. 

You will create a list box definition for this element to include the item number in the list 
box. Also, you know that your users will enter no more than 99,999 line items per invoice. 
Each line item will be numbered sequentially, starting with one, so you need a maximum 
length of only five digits for this field. You will change the field and element lengths for 
this field to five.

Use this procedure to rename the field label, change the field and element lengths, add 
Help text, and create the list box definition for the Second Level Sequence No. field.

Step Action

1 Double-click the ILD:2 SEQB element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 5 to allow a five-digit number in this element.

4 Select the Use Standard Rule tab.

5 Select the Loop Count option from the drop-down list.

6 In the Groups drop-down list box, select ILD to identify the loop for 
which you want to obtain the current value of the loop count. The ILD 
group is a nested group (the ODD group is the parent group of the ILD 
group).

7 Select the Display tab.

8 In the Display section, click the Display radio button to make this field 
display-only.

9 In the Label field, enter Item No. to replace the existing field label

10 In the Display Length field, enter 5 to allow five numeric digits to be 
displayed in the field.

11 Select the Summary List tab.
(Continued on next page)
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How to customise
the ILD:2 SPRO

SPR0 element

The ILD:2 SPRO SPR0 element (EAN-13 Code for the Traded Unit) contains the number 
of the thirteen-digit European Article Number allocated to the unit of trade (the invoiced 
item). In this tutorial, you will rename the field label to shorten it and add Help text to this 
field.

Use this procedure to rename the field label and add Help text to the EAN-13 Code for the 
Traded Unit field.

12 Select the Display this field in summary list check box to turn this 
option on. The value in the Item No. field will be displayed in a column in 
the Line Items list box.

13 In the Column Width field, enter 8 to set the width of this column in the 
Line Items list box.

Note
The column width should be wider than the actual content of the column. 
The extra space that is not used for the content of the column will provide 
white space separating the columns. If the width for each column is the 
exact width of the data, then there will not be space separating the 
columns of data.

14 From the Sequence drop-down list box, select 1 to indicate that this field 
will be the first column in the list box.

15 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the ILD:2 SPRO SPR0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter EAN Code to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the EAN code for the invoiced item. The EAN code 
must be exactly 13 alphanumeric characters long.

6 Click OK to exit the dialogue.
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How to customise
the ILD:2 SPRO

SPR1 element

The ILD:2 SPRO SPR1 element (Supplier’s Code for the Traded Unit) contains the 
supplier’s internal reference identifying the invoiced item (in this tutorial, your company 
is the supplier). You will rename the field label and add Help text to this field.

Also, you will create a list box definition for this element to include the supplier’s product 
code in the Line Items list box on the Invoice Details frame.

Use this procedure to rename the field label, add Help text, and create the list box 
definition for the Supplier’s Code for the Traded Unit field.

Step Action

1 Double-click the ILD:2 SPRO SPR1 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Supplier’s Product Code to replace the existing 
field label.

4 Select the Summary List tab.

5 Click the Display this field in summary list check box to turn this option 
on. The value in the Supplier’s Product Code field will be displayed in a 
column in the Line Items list box.

6 In the Column Width field, enter 33 to set the width of this column in the 
Line Items list box.

Note
The column width should be wider than the actual content of the column. 
The extra space that is not used for the content of the column will provide 
white space separating the columns. If the width for each column is the 
exact width of the data, then there will not be space separating the 
columns of data.

7 From the Sequence drop-down list box, select 2 to indicate that this field 
will be the second column in the list box.

8 Select the Help tab.

9 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the supplier’s product code for the invoiced item. The 
product code may not exceed 30 alphanumeric characters.

10 Click OK to exit the dialogue.
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How to customise
the ILD:2 CPRO

CPR1 element

The ILD:2 CPRO CPR1 element (Customer’s Item Code) contains the customer’s internal 
reference identifying the invoiced item. Your users can obtain this information from the 
customer’s purchase order. In this tutorial, you will rename the field label and add Help 
text to this field.

Use this procedure to rename the field label and add Help text to the Customer’s Item 
Code field.

How to customise
the ILD:2 QTYI

QTY0 element

The ILD:2 QTYI QTY0 element (Number of Order Units Invoiced) contains the quantity 
of invoiced items for this line item. You will create a list box definition for this element to 
include the quantity invoiced in the list box on the Invoice Details frame. For brevity, you 
will rename the field label. Also, the standard defines this field as a string data type, and 
allows up to fifteen alphanumeric characters in this element. However, your users will 
enter number-type data in N0 format (formatted with an implicit decimal point and no 
decimal places). Therefore, you will change the data type and the screen and EDI formats 
to reflect the data your users will enter.

In addition, your users will enter quantities no greater than five digits (e.g. 99,999). You 
will change the field and element lengths to reflect the smaller data length. Then, you will 
add Help text to this field.

(Continued on next page)

Step Action

1 Double-click the ILD:2 CPRO CPR1 element.

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Customer’s Product Code to replace the existing 
field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the customer’s product code for the invoiced item. The 
code may not exceed 30 alphanumeric characters.

6 Click OK to exit the dialogue.
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Use this procedure to change the data type and screen and EDI formats, rename the field 
label, change the field and element lengths, add Help text, and create the list box definition 
for the Number of Order Units Invoiced field.

Step Action

1 Double-click the ILD:2 QTYI QTY0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 In the Max field, enter 5 to allow a five-digit number in this element.

4 From the Data Type drop-down list box, select Number to allow a 
number data type in this element. Gentran:Server prompts you that 
changing the field’s data type will invalidate its format.

5 Click Yes to proceed with modifying the properties of this element.

6 From the Form Format drop-down list box, select N0 to indicate that this 
field will accept a number with an implied decimal point and no decimal 
places.

7 From the File Format drop-down list box, select N0 to format the EDI 
data with an implied decimal point and no decimal places.

8 Select the Display tab.

9 In the Label field, enter Quantity to replace the existing field label.

10 In the Display Length field, enter 5 to allow five numeric digits to be 
displayed in the field.

11 Select the Summary List tab.

12 Click the Display this field in summary list check box to turn this option 
on. The value in the Quantity field will be displayed in a column in the 
Line Items list box on the Invoice Details frame.

(Continued on next page)
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How to customise
the ILD:2 QTYI
CD04:2 element

The ILD:2 QTYI CD04:2 element (Measure Indicator) contains the abbreviation for the 
measure of the invoiced item (e.g. kilometres, metres, litres). You want all the available 
codes from Code Values List 4 to be available to your screen entry users, so you will load 
the entire code list. Loading the code list in this element causes a drop-down list box to be 
displayed on the Invoice Details frame (instead of a field). Users will select an appropriate 
code from the list box, instead of entered a value in the field.

After you specify the code list table to use for the drop-down list box for the Measure 
Indicator field, you will rename the field label and add Help text to the field.

Use this procedure to load Code Values List 4 from the standard, rename the field label, 
and add Help text to the Measure Indicator field.

13 In the Column Width field, enter 8 to set the width of this column in the 
Line Items list box.

Note
The column width should be wider than the actual content of the column. 
The extra space that is not used for the content of the column will provide 
white space separating the columns. If the width for each column is the 
exact width of the data, then there will not be space separating the 
columns of data.

14 From the Sequence drop-down list box, select 3 to indicate that this field 
will be the third column in the list box.

15 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the quantity of this invoiced item. The quantity may not 
exceed 5 digits.

16 Click OK to exit the dialogue.

Step Action

Step Action

1 Double-click the ILD:2 QTYI CD04:2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Standard Rule tab.

3 Select the Use Code option.
(Continued on next page)
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4 Click Edit to access the Edit Code List dialogue.

The Table ID field contains CD04, the name of the element for which this 
code list table will be used. The Desc field contains “Measure Indicator”, 
the description of the element for which this code list table will be used.

5 Click Load to access the Load Code List dialogue. You will be prompted 
to select an ODBC data source name. Select the appropriate DSN and 
click OK to access the Load Code List dialogue. The Codes In Standard 
list box contains the entire code list.

(Continued on next page)

 (Contd)
Step Action
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How to customise
the ILD:2 AUCT

AUC0 element

The ILD:2 AUCT AUC0 element (Cost Price (Excluding VAT)) contains the price per unit 
invoiced. This price is the cost in pounds before line discounts and VAT have been 
applied. The EDI data will be formatted in N4 format (formatted with an implicit decimal 
point and four decimal places), but your users will enter the price in the translation object 
in R4 format (formatted with an explicit decimal point). Therefore, you will change the 
screen format to reflect how you want the price to be entered in the translation object.

You will create a list box definition for this element to include the unit price in the list box 
on the Invoice Details frame. Also, you will rename the field label and add Help text to 
this field.

(Continued on next page)

6 Click Add All to move all of the codes in the code list table to the Codes 
Selected list box.

Note
Adding all the codes in the list (by using Add All) creates a much larger 
form than if you use only selected codes. However, it is necessary for your 
users to have all the codes available from which to choose.

7 Click OK to load the code list table and exit the Load Code List dialogue.

8 Click Close to exit the Edit Code List dialogue.

9 Click the Raise a compliance error check box to specify that, for 
compliance reasons, the element must contain one of the codes from Code 
Values List 4 (nothing else is valid for that element).

10 Select the Display tab.

11 In the Label field, enter Unit of Measure to replace the existing field 
label.

12 Select the Help tab.

13 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Select the unit of measure for this invoiced item from the 
drop-down list box.

14 Click OK to exit the dialogue.

 (Contd)
Step Action
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Use this procedure to change the screen format, rename the field label, add Help text, and 
create the list box definition for the Cost Price (Excluding VAT) field.

Step Action

1 Double-click the ILD:2 AUCT AUC0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R4 to indicate that this 
field will accept a number with an explicit decimal point and up to four 
decimal places.

4 Select the Display tab.

5 In the Label field, enter Unit Price (Ex. VAT) to replace the existing field 
label.

6 Select the Summary List tab.

7 Click the Display this field in summary list check box to turn this option 
on. The value in the Unit Price (Ex. VAT) field will be displayed in a 
column in the Line Items list box on the Invoice Details frame.

8 In the Column Width field, enter 14 to set the width of this column in the 
Line Items list box.

Note
You do not need to make the column width for this field wider than the 
actual content of the column. The data from this field will form the last 
column in the list box, and you do not need to leave white space between 
the last column and the side of the list box.

9 From the Sequence drop-down list box, select 4 to indicate that this field 
will be the third column in the list box.

10 Select the Help tab.

11 In the Help Text list box, enter the following text:

Enter the unit price for this invoiced item.

12 Click OK to exit the dialogue.
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How to customise
the ILD:2 LEXC

element

The ILD:2 LEXC element (Extended Line Cost (Excluding VAT)) contains the price per 
unit invoiced, after any line discounts have been applied. This price is the net cost in 
pounds (e.g. after deducting line discounts, etc., but before the application of VAT). The 
EDI data will be formatted in N4 format (formatted with an implicit decimal point and 
four decimal places), but your users will enter the price in the translation object in R4 
format (formatted with an explicit decimal point). Therefore, you will change the screen 
format to reflect how you want the price to be formatted in the translation object.

Also, you will prevent this field from being displayed in the translation object. The 
extended line cost will be calculated automatically when users click STORE on the Line 
Items frame when they use this translation object in Gentran:Server. You can hide this 
field because users will not need to enter the value in the field.

Use this procedure to change the screen format for the Extended Line Cost (Excluding 
VAT) field, and prevent this field from being displayed.

Step Action

1 Double-click the ILD:2 LEXC element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R4 to indicate that this 
field will accept a number with an explicit decimal point and up to four 
decimal places.

4 Select the Display tab.
(Continued on next page)
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How to calculate
the extended price

You want to automate the calculation that results in the extended price for each line item, 
so that the screen entry users who use your invoice translation object do not have to 
perform this calculation manually. A simple way to perform this calculation is to use an 
extended rule to define the operation in the ILD group. You define extended rule with the 
Gentran:Server proprietary programming language, which gives you access to the entire 
Gentran:Server internal storage area.

Use this procedure to define an extended rule to calculate the extended price.

5 Click the Hidden radio button to prevent this field from being displayed 
in the translation object.

6 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Click the ILD group (in the ODD group) with the right mouse button to 
access the shortcut menu.

2 Select Extended Rules from the shortcut menu. 

System Response
The Loop Level Extended Rules dialogue is displayed.

3 Click the On Store radio button to indicate that you want the rule to be 
executed when you store a group.

4 In the Editor list box, enter the following extended rule:

#LEXC = #QTY0 * #AUC0;

This extended rule means that the value of the ILD:2 LEXC field is equal 
to the product of the values in the ILD:2 QTYI QTY0 and ILD:2 AUCT 
AUC0 fields. In other words, the quantity invoiced for one line item, 
multiplied by the price (excluding VAT) for each unit invoiced, equals the 
extended price (excluding VAT).

5 Click Compile to compile the extended rule and verify that this rule does 
not cause errors or warnings. 

If you receive any errors or warnings when you compile the rule, verify 
that you entered the rule exactly as it is written in step 4 above. After you 
make any change to the extended rule to correct it, click Compile again. 
Repeat this process until there are no errors generated.

6 Click OK to add the extended rule to the form and exit the Loop Level 
Extended Rules dialogue.
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How to customise
the ILD:2 CD12

element

The ILD:2 CD12 element (VAT Rate Category Code) contains the code from Codes 
Values List 12 to designate the VAT rate category for this invoiced item (e.g. standard rate, 
exemption from VAT, higher rate, etc.). You will use a Select standard rule on the VAT 
Rate Category Code field, but first you need to create a temporary VATP element.

Gentran:Server enables you to use selected information from the Gentran:Server partner 
database in your forms via a Select standard rule. You can map information from your 
trading partner’s profile in the Partner Editor to a selected element in the form. The 
information that you can use in the form includes any fields in a table (location, lookup, or 
cross-reference) or data from the partner record.

For this form, you need to map the appropriate VAT rate based on the code in the ILD:2 
CD12 element from a lookup table, to look up data that you will map (via a standard rule) 
to the temporary VATP_TEMP field that you create. When you use tables, you must 
decide whether to create a code table in Gentran:Server that can be used only with this 
form, or to add the table to either the partner relationship or the internal system partner in 
Partner Editor. In this tutorial, you will set up the table you use under the internal system 
partner (Internal System User) so the table can be used globally.

In this tutorial, you need to extract information from a lookup table and insert it into the 
form. A lookup table is used when you want to supplement data before it is sent to your 
partner. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information on lookup tables.

Note
You do not need to create this lookup table (INVATCO.LKP). It is included with the 
tutorial data that is provided when you install Gentran:Server.

After you use the Select function, all the available codes from the selected table will be 
available in a drop-down list box (instead of a field) on the Invoice Details frame. Users 
will select an appropriate code from the drop-down list box, instead of entered a value in 
the field.

In addition to using the Select function, you will rename the field label and add Help text 
to the field.
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How to create a
temporary VATP

element

Use this procedure to create a temporary VATP element.

How to change the
ILD:2 CD12

element and field
properties

Use this procedure to use the Select function, rename the field label, and add Help text to 
the VAT Rate Category Code field.

Step Action

1 Select the ILD:2 VATP element.

2 Click Copy on the Main Toolbar.

3 Select the ILD:2 SCRF composite, which is the last form component in 
the ILD:2 segment. The ILD:2 SCRF composite is the composite after 
which you want the ILD:2 VATP element to be pasted.

4 Click Paste on the Main Toolbar to paste the ILD:2 VATP element. 

System Response
Gentran:Server prompts you to specify whether you want the contents of 
the Clipboard pasted as a child (subordinate) of the selected composite, or 
at the same level as the composite.

5 Click the Paste after selected item (at the same level) radio button to 
paste the Clipboard contents after the ILD:2 SCRF composite. A new 
element (ILD:2 VATP:2) is created. The ILD:2 VATP:2 element is an 
exact copy of the ILD:2 VATP element.

6 Click OK to exit the dialogue.

Note
You should rename the ILD:2 VATP:2 element to give it a more 
descriptive name.

7 Double-click the ILD:2 VATP:2 element. 

System Response
The Element Properties dialogue is displayed.

8 In the Name field, enter VATP_TEMP to replace the existing field label.

9 Click OK to exit the Element Properties dialogue. The ILD:2 VATP:2 
element is renamed ILD:2 VATP_TEMP.

Step Action

1 Double-click the ILD:2 CD12 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Standard Rule tab.
(Continued on next page)
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3 Select the Select option.

4 In the Table drop-down list box, select Division lookup. You are using the 
Division lookup because the VAT codes do not vary on a partner-by-
partner basis, so you can use the Internal System User partner and map 
from any field on the Lookup Entry dialogue (in Partner Editor in 
Gentran:Server). You will be able to set up the lookup only once, 
regardless of the number of partners with which you will use this 
translation object.

5 In the Sub Table field, enter VATCODES, which is the name of the table 
name for the Internal System User partner that you will import.

6 In the Map From list box, select Text 1, which is the field on the Lookup 
Entry dialogue in Partner Editor from which the contents will be mapped.

7 In the Map To list box, select VATP_TEMP, which is the temporary 
VATP element you just created. The system will map the value from 
Partner Editor to the VATP_TEMP element.

The dialogue now should look like this:

8 Select the Display tab.

9 In the Label field, enter VAT Code to replace the existing field label.

10 Select the Help tab.
(Continued on next page)

 (Contd)
Step Action
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How to customise
the ILD:2 VATP

element

The ILD:2 VATP element (VAT Rate Percentage) contains the percentage rate for the VAT 
category code. Screen entry translation object users will not need to enter a value in this 
field because Gentran:Server will look up the percentage in the VATCODES table in 
Partner Editor and place the result in the ILD:2 VATP element automatically. You will 
prevent the ILD:2 VATP element from being displayed on the translation object.

Use this procedure to hide the VAT Rate Percentage field.

How to customise
the ILD:2

VATP_TEMP
element

The ILD:2 VATP_TEMP element (VAT Rate Percentage) is the temporary element you 
created to map the VAT rate percentage in the VATCODES division lookup table. To map 
from the partner database to the VATP_TEMP field, the target field (VATP_TEMP) needs 
to be a string-type element. You will use the ILD:2 VATP_TEMP element to convert the 
VAT rate percentage (a string) into a real number (the data type required in the ILD:2 
VATP field). For compliance reasons, you cannot change the data type in the ILD:2 VATP 
element; therefore, you created the ILD:2 VATP_TEMP element, whose data type you 
may change. 

(Continued on next page)

11 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Select the VAT code for this invoiced item from the 
drop-down list box.

12 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the ILD:2 VATP element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

4 Click OK to exit the dialogue.
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The system will be able to look up the VAT rate percentage (a string data type) in the 
VATCODES table, and map the string to the ILD:2 VATP_TEMP element. Later, you will 
add an extended rule to the ILD group to convert the string in the ILD:2 VATP_TEMP 
element to a number in the ILD:2 VATP element, then remove all data from the ILD:2 
VATP_TEMP element (so that element is empty). After having executed these functions, 
the system will have converted a string data type to a real number, maintaining the 
integrity of the data and the compliance of the invoice.

Use this procedure to hide the VAT Rate Percentage field and change the data type for this 
field to string.

Step Action

1 Double-click the ILD:2 VATP_TEMP element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 Click the Mandatory check box to make this element conditional.

4 In the Min field, enter 0 for the minimum number of digits allowed for 
this element.

5 From the Data Type drop-down list box, select String to allow a string 
data type in this element. Gentran:Server prompts you that changing the 
field’s data type will invalidate its format.

6 Click Yes to proceed with modifying the properties of this element.

7 Select the Display tab.

8 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

9 Click OK to exit the dialogue.
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How to convert
strings into real

numbers

You created the ILD:2 VATP_TEMP element as a temporary element for converting 
strings into numbers. The first step in converting strings into elements, in this tutorial, was 
to create the ILD:2 VATP_TEMP element so that the system will use that element to look 
up the VAT rate percentage (a string data type) in the VATCODES table, then map the 
string to the ILD:2 VATP_TEMP element. The next step is to use an extended rule in the 
ILD group to convert the string in the ILD:2 VATP_TEMP element into a real number that 
can be used in the ILD:2 VATP element, and then delete any data left in the temporary 
element (ILD:2 VATP_TEMP).

Use this procedure to define an extended rule to convert strings into numbers.

Step Action

1 Click the ILD group (in the ODD group) with the right mouse button to 
access the shortcut menu.

2 Select Extended Rules from the shortcut menu. 

System Response
The Loop Level Extended Rules dialogue is displayed.

3 Click the On Store radio button to indicate that you want the rule to be 
executed when you store a group. (The extended rule you added to 
calculate an extended price is displayed in the Editor list box of the Loop 
Level Extended Rules dialogue.) When the screen entry users click Store 
on the Line Items frame in Gentran:Server, all On Store extended rules in 
the Loop Level Extended Rules dialogue will be executed.

4 On the next two lines in the Editor list box, enter the following extended 
rule:

#VATP = ATON(#VATP_TEMP);
empty(#VATP_TEMP);

The ATON function tells the system to convert the string data in the 
ILD:2 VATP_TEMP element into a real number.

The calculation you entered on the first line places the number data in the 
ILD:2 VATP element.

The empty function sets the value of the ILD:2 VATP_TEMP field to null.

5 Click Compile to compile the extended rule and verify that this rule does 
not cause errors or warnings. 

If you receive any errors or warnings when you compile the rule, verify 
that you entered the rule exactly as it is written in step 4 above. After you 
make any change to the extended rule to correct it, click COMPILE again. 
Repeat this process until there are no errors generated.

6 Click OK to add the extended rule to the form and exit the Loop Level 
Extended Rules dialogue.
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How to customise
the ILD:2 TDES

TDE0 element

The ILD:2 TDES TDE0 element (Traded Unit Descr. Line 1) contains the description of 
the invoiced item. You will rename the field label to shorten it and add Help text to this 
element.

Use this procedure to rename the field label and add Help text to the Traded Unit Descr. 
Line 1 field.

Step Action

1 Double-click the ILD:2 TDES TDE0 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 In the Label field, enter Description to replace the existing field label.

4 Select the Help tab.

5 In the Help Text list box, enter the following text (press Enter at the end 
of each line of text below):

Enter the description of the invoiced item. The description 
may not exceed 40 alphanumeric characters.

6 Click OK to exit the dialogue.

(Continued on next page)
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How to customise
the STL segment

The STL segment (VAT Rate Invoice Sub Trailer) contains the invoice amounts relating to 
the VAT rate. All monetary values in this segment are in pounds. You will use an extended 
rule to perform the calculations that will be displayed in the fields in the STL segment. 
Screen entry translation object users will be able to view the values in these fields (in the 
VAT Summary frame), but will not be able to change the values. 

Reference
See Producing the VAT Summary and the Invoice Trailer on page 3 - 115 for details on 
how to add the extended rule.

The fields associated with the STL segment are arranged on the Stl frame. Your users will 
complete the fields on the STL frame for each VAT rate calculation. The list of all VAT 
rates in the invoice will be displayed in a list box on the Invoice Details frame. In that list 
box, the VAT rates will be displayed for each line item, forming columns of information.

(Continued on next page)

7 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

The Line Items frame now should look like this:

 (Contd)
Step Action
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Use this procedure to rename the STL frame and list box, provide a description for the 
STL segment, and add Help text to the list box.

Step Action

1 Click the STL segment with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu. 

System Response
The EDI Segment Properties dialogue is displayed.

3 Select the Display tab.

4 In the Frame Caption field, enter VAT Summary to rename the frame.

5 In the List Caption field, enter VAT Summary to rename the list box that 
is displayed on the Invoice Details frame (listing the VAT rates entered on 
the VAT Summary frame).

6 In the Frame Help Text list box, enter the following text (press Enter at 
the end of each line of text below):

This frame contains VAT summary 
information. All the fields on this frame are 
display-only. You may view the values in 
these fields, but you cannot change any of 
the values. All calculations will be updated 
when you click the Recalculate button on 
the Invoice Details frame.

(Continued on next page)
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How to customise
the STL SEQA:7

element

The STL SEQA:7 element (First Level Sequence Number) contains the sequence number 
for the STL segment. This element is mandatory, but your screen entry translation object 
users will not need to enter a value in this field (the value will be assigned in the extended 
rule you add later in this tutorial in the INVOIC file). Therefore, you will prevent this field 
from being displayed in the screen entry translation object, since users will not need to 
enter a value in this field.

Use this procedure to hide the First Level Sequence Number field.

7 In the Listbox Help Text list box, enter the following text (press Enter at 
the end of each line of text below):

This list box contains VAT summary 
information. To view details about a VAT 
rate listed in the VAT Summary list box, 
click that VAT rate and click Open. You 
will be able to view the values in these 
fields, but you will not be able to change 
any of them. All calculations will be 
updated when you click the Recalculate 
button on the Invoice Details frame.

8 Click OK to exit the EDI Segment Properties dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the STL SEQA:7 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

4 Click OK to exit the dialogue.
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How to customise
the STL CD12:2

element

The STL CD12:2 element (VAT Rate Category Code) contains the VAT rate category as 
listed in Code Values List 12. You will create a list box definition for this element to 
include the VAT rate category code in the VAT Summary list box on the Invoice Details 
frame. You will make this field display-only, as the screen entry translation object users 
who use this invoice translation object should be able to view, but not change, the value in 
this field. (The values in this field will be assigned in the extended rule you add later in 
this tutorial in the INVOIC file.) Also, you will rename the field label.

Use this procedure to rename the field label, make this field display-only, and create the 
list box definition for the VAT Rate Category Code field.

Step Action

1 Double-click the STL CD12:2 element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

4 In the Label field, enter VAT Code to replace the existing field label.

5 Select the Summary List tab.

6 Click the Display this field in summary list check box to turn this option 
on. The value in the VAT Code field will be displayed in a column in the 
VAT Summary list box on the Invoice Details frame.

7 In the Column Width field, enter 4 to set the width of this column in the 
VAT Summary list box.

Note
The column width should be wider than the actual content of the column. 
The extra space that is not used for the content of the column will provide 
white space separating the columns. If the width for each column is the 
exact width of the data, then there will not be space separating the 
columns of data.

8 From the Sequence drop-down list box, select 1 to indicate that this field 
will be the first column in the list box.

9 Click OK to exit the dialogue.



Customising the ILD:2 Segment Creating a Screen Entry Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

3 - 102

How to customise
the STL VATP:2

element

The STL VATP:2 element (VAT Rate Percentage) contains the percentage rate for the VAT 
category code (in the STL CD12:2 element). The EDI data will be formatted in N3 format 
(formatted with an implicit decimal point and three decimal places), but you want the VAT 
rate percentage to be displayed in the translation object in R3 format (formatted with an 
explicit decimal point). Therefore, you will change the screen format to reflect how you 
want the amount to be formatted in the translation object. 

You will create a list box definition for this element to include the VAT rate percentage in 
the VAT Summary list box on the Invoice Details frame. You will make this field display-
only, as the screen entry translation object users who use this invoice translation object 
should be able to view, but not change, the value in this field. Also, you will rename the 
field label.

Use this procedure to change the screen format, make the field display-only, rename the 
field label, and create the list box definition for the VAT Rate Percentage field.

Step Action

1 Double-click the STL VATP:2 element. 

System Response
The Element Properties dialogue is displayed.

2 From the Form Format drop-down list box, select R3 to indicate that this 
field will display a number with an explicit decimal point and up to three 
decimal places.

3 Select the Display tab.
(Continued on next page)
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How to customise
the STL NRIL

element

The STL NRIL element (Number of Item Lines) contains the number of ILD segments 
with the VAT category code specified in the STL CD12:2 element. You will make this 
field display-only, as the screen entry translation object users who use this invoice 
translation object should be able to view, but not change, the value in this field. Also, you 
will rename the field label.

Use this procedure to make the field display-only and rename the field label for the 
Number of Item Lines field.

4 Click the Displayed but not editable radio button to make this field 
display-only. Users will be able to read the data in this field, but will not 
be able to enter or change a value in this field.

5 In the Label field, enter VAT Rate to replace the existing field label.

6 Select the Summary List tab.

7 Click the Display this field in summary list check box to turn this option 
on. 

System Response
The value in the VAT Rate field will be displayed in a column in the VAT 
Summary list box on the Invoice Details frame.

8 In the Column Width field, enter 9 to set the width of this column in the 
VAT Summary list box.

Note
The column width should be wider than the actual content of the column. 
The extra space that is not used for the content of the column will provide 
white space separating the columns. If the width for each column is the 
exact width of the data, then there will not be space separating the 
columns of data.

9 From the Sequence drop-down list box, select 2 to indicate that this field 
will be the second column in the list box.

10 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the STL NRIL element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.
(Continued on next page)
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How to customise
the STL LVLA

element

The STL LVLA element (Lines Sub-Total (Excluding VAT)) contains the subtotal for this 
line item, before VAT has been applied. The value in this field equals the total of the 
extended line cost (in the ILD:2 LEXC element) for line items with this VAT category 
code. The EDI data will be formatted in N2 format (formatted with an implicit decimal 
point and two decimal places), but you want the lines subtotal (excluding VAT) to be 
displayed in the translation object in R2 format (formatted with an explicit decimal point). 
Therefore, you will change the screen format to reflect how you want the amount to be 
formatted in the translation object. 

You will create a list box definition for this element to include the lines subtotal 
(excluding VAT) in the VAT Summary list box on the Invoice Details frame. You will 
make this field display-only, as the screen entry translation object users who use this 
invoice translation object should be able to view, but not change, the value in this field. 
Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, rename the 
field label, and create the list box definition for the Lines Sub-Total (Excluding VAT) 
field:

3 Click the Displayed but not editable radio button to make this field 
display-only. Users will be able to read the data in this field, but will not 
be able to enter or change a value in this field.

4 In the Label field, enter Number of Line Items to replace the existing 
field label.

5 Click OK to exit the dialogue.

Step Action

Step Action

1 Double-click the STL LVLA element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

4 Select the Display tab.

5 Click the Displayed but not editable radio button to make this field 
display-only. Users will be able to read the data in this field, but will not 
be able to enter or change a value in this field.

(Continued on next page)
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How to customise
the STL EVLA

element

The STL EVLA element (Extended Sub-Total Amount (Excluding VAT)) contains the 
extended subtotal before the VAT has been applied. In this tutorial, the value in the STL 
EVLA element equals the value in the STL LVLA element (because we are not using 
settlement discounts in this tutorial). For this reason, you do not need to display the STL 
EVLA element (the STL LVLA element will be displayed). Therefore, you will prevent 
this field from being displayed in the screen entry translation object, since users will not 
need to enter or view a value in this field (the value will be assigned in the extended rule 
you add later in this tutorial in the INVOIC file).

Use this procedure to hide the Extended Sub-Total Amount (Excluding VAT) field.

6 In the Label field, enter Lines Subtotal (Excluding VAT) to replace the 
existing field label. (Making these slight changes to the field label 
maintains the consistency of labelling in this form.)

7 Select the Summary List tab.

8 Click the Display this field in summary list check box to turn this option 
on. The value in the Lines Subtotal (Excluding Vat) field will be displayed 
in a column in the VAT Summary list box on the Invoice Details frame.

9 In the Column Width field, enter 12 to set the width of this column in the 
VAT Summary list box.

Note
You do not need to make the column width for this field wider than the 
actual content of the column. The data from this field will form the last 
column in the list box, and you do not need to leave white space between 
the last column and the side of the list box.

10 From the Sequence drop-down list box, select 3 to indicate that this field 
will be the third column in the list box.

11 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the STL EVLA element. 

System Response
The Element Properties dialogue is displayed.

(Continued on next page)
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How to customise
the STL ASDA

element

The STL ASDA element (Extended Sub-Total Amount (After Settlement Discount Has 
Been Applied) contains the extended subtotal amount before VAT has been applied. In this 
tutorial, the value in the STL ASDA element equals the value in the STL EVLA element 
(which is equal to the STL LVLA element), because we are not using settlement discounts 
in this tutorial. For this reason, you do not need to display the STL ASDA element (the 
STL LVLA element will be displayed). Therefore, you will prevent this field from being 
displayed in the screen entry translation object, since users will not need to enter or view a 
value in this field (the value will be assigned in the extended rule you add later in this 
tutorial in the INVOIC file).

Use this procedure to hide the Extended Sub-Total Amount (After Settlement Discount 
Has Been Applied) field.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

4 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the STL ASDA element. 

System Response
The Element Properties dialogue is displayed.

(Continued on next page)
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How to customise
the STL VATA

element

The STL VATA element (VAT Amount Payable) contains the VAT amount at the quoted 
VAT rate. The EDI data will be formatted in N2 format (formatted with an implicit 
decimal point and two decimal places), but you want the VAT amount payable to be 
displayed in the translation object in R2 format (formatted with an explicit decimal point). 
Therefore, you will change the screen format to reflect how you want the amount to be 
formatted in the translation object. In addition, you will make this field display-only, as 
the screen entry translation object users who use this invoice translation object should be 
able to view, but not change, the value in this field. Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the VAT Amount Payable field.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

4 Click OK to exit the dialogue.

Step Action

Step Action

1 Double-click the STL VATA element. 

System Response
The Element Properties dialogue is displayed.

2 From the Form Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

3 Select the Display tab.

4 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

5 In the Label field, enter VAT Amount Payable (note that “VAT” contains 
all capital letters) to replace the existing field label. Making these slight 
changes to the field label maintains the consistency of labelling in this 
form.

6 Click OK to exit the dialogue.
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How to customise
the STL APSI

element

The STL APSI element (Payable Sub-Total Amount Including Settlement Discount) 
contains the amount after VAT has been applied. The value in this element equals the sum 
of the values in the STL ASDA and STL VATA elements. The EDI data will be formatted 
in N2 format (formatted with an implicit decimal point and three decimal places), but you 
want the VAT amount payable to be displayed in the translation object in R2 format 
(formatted with an explicit decimal point). Therefore, you will change the screen format to 
reflect how you want the amount to be formatted in the translation object. In addition, you 
will make this field display-only, as the screen entry translation object users who use this 
invoice translation object should be able to view, but not change, the value in this field. 
Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the Payable Sub-Total Amount Including Settlement Discount field.

Step Action

1 Double-click the STL APSI element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

4 Select the Display tab.

5 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

6 In the Label field, enter Payable Subtotal (Inc. Sett. Disc.) to replace the 
existing field label.

7 Click OK to exit the dialogue.
(Continued on next page)
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Customising the
TLR segment

The TLR segment (Invoice Trailer) contains the total invoice amounts. All monetary 
values in this segment are in pounds. You will use an extended rule to perform the 
calculations that will be displayed in the fields in the TLR segment. Screen entry 
translation object users will be able to view the values in these fields (on the Invoice 
Details frame), but will not be able to change the values. See Producing the VAT Summary 
and the Invoice Trailer on page 3 - 115 for details on how to add the appropriate extended 
rule.

8 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.The VAT Summary frame now should look like this:

 (Contd)
Step Action
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Customising the
TLR NSTL

element

The TLR NSTL element (Number of Total Segments) contains the number of STL 
segments in the invoice. You do not need to display the this element, as the screen entry 
translation object users will not need to enter or view a value in this field.

Use this procedure to hide the Number of Total Segments field.

Customising the
TLR LVLT

element

The TLR LVLT element (Lines Total Amount (Excluding VAT)) contains the sum of the 
STL LVLA elements in the preceding STL segments (before VAT is applied). The EDI 
data will be formatted in N2 format (formatted with an implicit decimal point and two 
decimal places), but you want the total amount (excluding VAT) to be displayed in the 
translation object in R2 format (formatted with an explicit decimal point). Therefore, you 
will change the screen format to reflect how you want the amount to be formatted in the 
translation object. In addition, you will make this field display-only, as the screen entry 
translation object users who use this invoice translation object should be able to view, but 
not change, the value in this field. Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the Lines Total Amount (Excluding VAT) field.

Step Action

1 Double-click the TLR NSTL element.

System Response
The Element Properties dialogue is displayed.

2 Select the Display tab.

3 Click the Hidden radio button to prevent the field from being displayed in 
the translation object.

4 Click OK to exit the dialogue.

Step Action

1 Double-click the TLR LVLT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

4 Select the Display tab.
(Continued on next page)
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How to customise
the TLR EVLT

element

The TLR EVLT element (Total Extended Amount Ex Settlement Discount) contains the 
sum of the STL EVLA elements in the preceding STL segments (before VAT is applied). 
The EDI data will be formatted in N2 format (formatted with an implicit decimal point 
and two decimal places), but you want the total amount (excluding settlement discount 
and VAT) to be displayed in the translation object in R2 format (formatted with an explicit 
decimal point). Therefore, you will change the screen format to reflect how you want the 
amount to be formatted in the translation object. In addition, you will make this field 
display-only, as the screen entry translation object users who use this invoice translation 
object should be able to view, but not change, the value in this field. Also, you will rename 
the field label.

Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the Total Extended Amount Ex Settlement Discount field.

5 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

6 In the Label field, enter Invoice Amount (Excluding VAT) to replace the 
existing field label.

7 Click OK to exit the dialogue.

 (Contd)
Step Action

Step Action

1 Double-click the TLR EVLT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

4 Select the Display tab.

5 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

6 In the Label field, enter Invoice Amount (Ex. Settlement Disc.) to 
replace the existing field label.

7 Click OK to exit the dialogue.
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How to customise
the TLR ASDT

element

The TLR ASDT element (Total Amount Exc VAT Inc Sett) contains the sum of the STL 
ASDA elements in the preceding STL segments (before VAT is applied). The EDI data 
will be formatted in N2 format (formatted with an implicit decimal point and two decimal 
places), but you want the total amount (excluding settlement discount and VAT) to be 
displayed in the translation object in R2 format (formatted with an explicit decimal point). 
Therefore, you will change the screen format to reflect how you want the amount to be 
formatted in the translation object. In addition, you will make this field display-only, as 
the screen entry translation object users who use this invoice translation object should be 
able to view, but not change, the value in this field. Also, you will rename the field label.

Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the Total Amount Exc VAT Inc Sett field.

Step Action

1 Double-click the TLR ASDT element.

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Screen Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

4 Select the Display tab.

5 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

6 In the Label field, enter Invoice Amount (Ex. VAT Inc. Sett.) to replace 
the existing field label.

7 Click OK to exit the dialogue.
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How to customise
the TLR TVAT

element

The TLR TVAT element (Total VAT Amount Payable) contains the sum of the STL VATA 
elements in the preceding STL segments. The EDI data will be formatted in N2 format 
(formatted with an implicit decimal point and two decimal places), but you want the total 
amount to be displayed in the translation object in R2 format (formatted with an explicit 
decimal point). Therefore, you will change the screen format to reflect how you want the 
amount to be formatted in the translation object. In addition, you will make this field 
display-only, as the screen entry translation object users who use this invoice translation 
object should be able to view, but not change, the value in this field. Also, you will rename 
the field label.

Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the Total VAT Amount Payable field.

How to customise
the TLR TPSI

element

The TLR TPSI element (Total Payable Inc. Settlement) contains the sum of the STL APSI 
elements in the preceding STL segments. The EDI data will be formatted in N2 format 
(formatted with an implicit decimal point and two decimal places), but you want the total 
amount to be displayed in the translation object in R2 format (formatted with an explicit 
decimal point). Therefore, you will change the screen format to reflect how you want the 
amount to be formatted in the translation object. In addition, you will make this field 
display-only, as the screen entry translation object users who use this invoice translation 
object should be able to view, but not change, the value in this field. Also, you will rename 
the field label.

(Continued on next page)

Step Action

1 Double-click the TLR TVAT element. 

System Response
The Element Properties dialogue is displayed.

2 Select the Validation tab.

3 From the Form Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

4 Select the Display tab.

5 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

6 In the Label field, enter VAT Total to replace the existing field label.

7 Click OK to exit the dialogue.
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Use this procedure to change the screen format, make the field display-only, and rename 
the field label for the Total Payable Inc. Settlement field.

Step Action

1 Double-click the TLR TPSI element. 

System Response
The Element Properties dialogue is displayed.

2 From the Screen Format drop-down list box, select R2 to indicate that this 
field will display a number with an explicit decimal point and up to two 
decimal places.

3 Select the Display tab.

4 Click the Display radio button to make this field display-only. Users will 
be able to read the data in this field, but will not be able to enter or change 
a value in this field.

5 In the Label field, enter Total Invoice Amount (Inc. Sett. Disc.) to 
replace the existing field label.

6 Click OK to exit the dialogue.

7 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

The section of the Invoice Details frame that contains the fields in the 
TLR segment now should look like this:
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Producing the VAT Summary and the Invoice Trailer

Overview Now that you have customised the individual elements in the invoice, one last customising 
task remains: to produce the VAT summary and invoice trailer. The VAT summary and 
invoice trailer calculations include calculating the totals for the invoice for each of the 
different VAT rates and grouping the totals by VAT rate. To produce the VAT summary 
calculations for the invoice, you will use an extended rule to define operations with the 
Gentran:Server proprietary programming language.

There are two sections for extended rules: a declarations section and a statements 
section. The declarations section is used to declare the names and types of any variables 
you will use. The statements section is where you define the operations that you want the 
rule to execute. Within the statements section, you can leave blank lines to visually 
separate portions of an extended rule. (Blank lines are used more often in complex 
extended rules, rather than in simple one- or two-line extended rules.) Leaving a blank line 
does not affect the execution of extended rules.

As you define the operations for the VAT summary calculations, you will enter many lines 
of rules in the Loop Level Extended Rules dialogue. This section describes each of the 
individual operations that you will define, and explains what you should enter in order to 
execute each operation.

Note
As an alternative to entered the extended rule yourself, you may copy the extended rule 
from the example form provided with the tutorial data in the 
C:\GENSRVNT\TUTORIALS subfolder.

You will define the VAT summary and invoice trailer calculations on the INVOIC group 
so that the calculations are run when the screen entry translation object users in 
Gentran:Server either calculates or saves the file. After Gentran:Server stores the data in 
the fields, the system will run the calculations and store them in the appropriate VAT 
summary and invoice trailer fields. The extended rule will be used with the On Store 
function so the system will perform the calculations last, after the group is stored.
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Procedure Use this procedure to access the Loop Level Extended Rules dialogue to define the 
operations for the VAT summary calculations.

How to declare the
variables

Before you begin defining any operations in the statements section of the extended rule, 
you must first define the variables that you will use in the extended rule. Variables consist 
of a name and a data type, and they are used to store values.

For this extended rule, you will use these four variables (all of which have a data type of 
integer).

◗ i (temporary variable assigned any value you define in the extended rule)
◗ j (another temporary variable assigned any value you define in the extended rule)
◗ ildlimit (temporary variable that contains the number of ILD segments)
◗ stllimit (temporary variable that contains the number of STL segments)

Use this procedure to declare the four integer variables listed above.

Step Action

1 Click the INVOIC EDI file icon with the right mouse button to access the 
shortcut menu.

2 Select Extended Rules from the shortcut menu. 

System Response
The Loop Level Extended Rules dialogue is displayed.

3 Click the On Store radio button to indicate that you want the rule to be 
executed when you save or recalculate the screen entry translation object. 
When the screen entry users save or recalculate the Invoice Details frame 
in Gentran:Server, all On Store extended rules in the Loop Level Extended 
Rules dialogue will be executed.

Step Action

1 On the first line in the Editor list box, enter the following declaration:

integer i,j,ildlimit,stllimit;

2 Press Enter twice to insert a blank line after the declarations section.

Note
It is not necessary to include a blank line after the declaration and 
statement sections. However, doing so may improve readability of the 
extended rule.

3 You are now ready to define the statements section of the extended rule.
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How to count the
STL segments and

delete them

The STL segment is a repeating segment, so there is one STL segment for each VAT code 
used in the invoice. You want Gentran:Server to count the STL segments used in the 
invoice (the value from counting the STL segments will be placed in variable “i”). Next, 
you want the system to visit each STL segment and delete the segment. The reason you 
want the system to delete the STL segments is that the system makes the assumption that 
the form has been modified and, therefore, deletes the STL segments to reset the form 
before performing any calculations relating to the STL segments. Finally, you want the 
system to initialise the value of the last STL segment to zero.

Use this procedure to define a statement that counts the STL segments and deletes them, 
then initialises the value of the last STL to zero.

How to count the
ILD groups

The ILD group is a repeating group, so there is one ILD group for each line item in the 
invoice. You want Gentran:Server to count the ILD groups used in the invoice (the value 
from counting the ILD groups will be placed in variable “ildlimit”).

Use this procedure to define a statement that counts the ILD groups.

Step Action

1 On the next line in the Editor list box, enter the following statement:

i=count($STL[*]);
while i > 0 do
begin
   delete($STL[i]);
   i=i-1;
end
stllimit = 0;

2 Press Enter twice to insert a blank line after the statement.

Note
It is not necessary to include a blank line after this statement. However, 
doing so may improve readability of the extended rule.

Step Action

1 On the next line in the Editor list box, enter the following statement:

ildlimit = count($ILD[1][*]);

2 Press Enter twice to insert a blank line after the statement.

Note
It is not necessary to include a blank line after this statement. However, 
doing so may improve readability of the extended rule.
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How to find
compatible VAT

codes in the STL
segments

Now that Gentran:Server has counted (and deleted) the STL segments and counted the 
ILD groups in the invoice, you want the system to determine which VAT code is used for 
each line item (each instance of the ILD group). Next, you want to group the line items 
that use the same VAT code so you can determine the VAT rate percentage (based on each 
VAT code) and then calculate the total VAT payable for each group of line items.

If the system finds a VAT code that is the same in both an ILD group and an STL segment 
(compatible VAT codes), then you want the system to execute the following operations:

◗ Add the extended line cost (ILD:2 LEXC element) into the lines subtotal (ILD:2 
LVLA element) to add the line item from the ILD group to the compatible STL 
segment

◗ Increment a counter in the STL segment of how many of the existing ILD segments 
are compatible with that STL segment

If the system does not find an STL segment with the same VAT code as the ILD group it is 
visiting, then it executes the following operations:

◗ Creates an STL segment with the VAT code of the current ILD group
◗ Sets the number of STL segments (STL SEQA:7 element) to be the number of the last 

STL segment (the current segment, which was just created)
◗ Sets the VAT rate percentage of the STL segment (STL VATP:2 element) to equal the 

VAT rate percentage of the ILD group (ILD:2 VATP element)
◗ Sets the VAT code of the STL segment (STL CD12:2 element) to equal the VAT code 

of the ILD group (ILD:2 CD12 element)
◗ Sets the lines subtotal of the STL segment (STL LVLA element) to be the extended 

line cost of the ILD group (ILD:2 LEXC element)
◗ Sets the number of line items to be “1” (STL NRIL element)
◗ Sets the number of STL segments to be the number of the current STL segment 

(which was just created)

Finally, you want the system to repeat the process described above (finding compatible 
VAT codes in the STL segments and ILD segments) until it has no more ILD groups to 
count (each line item has been assessed).
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Procedure Use this procedure to define a statement that groups line items with the same VAT code.

How to calculate
the VAT amount

and producing the
invoice trailer

Up to this point, the extended rule you have defined instructs Gentran:Server to calculate 
the totals for the invoice for each of the different VAT rates. Now you will define a rule 
that calculates the total VAT amount and produces the invoice trailer.

First, the system will initialise the lines total amount (TLR LVLT element) and the total 
VAT amount payable (TLR TVAT element) to zero. Next, the system will perform the 
following calculations for every STL segment:

◗ Set the VAT amount payable (STL VATA element) equal to the product of the lines 
subtotal (STL LVLA element) and the VAT rate percentage (STL VATP:2 element), 
divided by one hundred (to calculate the VAT payable).

◗ Set the extended subtotal amount (STL EVLA element) equal to the lines subtotal 
(STL LVLA element), because you are not using settlement discounts in this tutorial.

(Continued on next page)

Step Action

1 On the next line in the Editor list box, enter the following statement:
i=1;
while i <= ildlimit do
begin
   j=1;
   while j <= stllimit do
   begin
      if $ILD[1][i].#CD12 = $STL[j].#CD12:2 then
      begin
         $STL[j].#LVLA = $STL[j].#LVLA + $ILD[1][i].#LEXC;
         $STL[j].#NRIL = $STL[j].#NRIL + 1;
         break;
      end
      j=j+1;
   end
   if j > stllimit then
   begin
      $STL[j].#SEQA:7 = j;
      $STL[j].#VATP:2 = $ILD[1][i].#VATP;
      $STL[j].#CD12:2 = $ILD[1][i].#CD12;
      $STL[j].#LVLA = $ILD[1][i].#LEXC;
      $STL[j].#NRIL = 1;
      stllimit = stllimit + 1;
   end
   i=i+1;
end

2 Press Enter twice to insert a blank line after the statement.

Note
It is not necessary to include a blank line after this statement. However, 
doing so may improve readability of the extended rule.
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◗ Set the extended subtotal amount (STL ASDA element) equal to the lines subtotal 
(STL LVLA element), because you are not using settlement discounts in this tutorial.

◗ Set the payable subtotal amount (STL APSI element) equal to the sum of the lines 
subtotal (STL LVLA element) and the VAT amount payable (STL VATA element).

◗ Set the lines total amount (TLR LVLT element) equal to the sum of the lines total 
amount (TLR LVLT element) and the extended subtotal amount (STL EVLA 
element).

◗ Set the total VAT amount payable (TLR TVAT element) equal to the sum of the total 
VAT amount payable (TLR VATA element) and the VAT amount payable (STL VATA 
element).

Finally, you want the system to repeat the calculations described above until all STL 
segments have been processed.

Procedure Use this procedure to define a statement that groups the invoice totals by VAT rate.

Step Action

1 On the next line in the Editor list box, enter the following statement:
#LVLT = 0;
#TVAT = 0;
j=1;
while j <= stllimit do
begin
   $STL[j].#VATA = ($STL[j].#LVLA * $STL[j].#VATP:2) / 
100.0;
   $STL[j].#EVLA = $STL[j].#LVLA;
   $STL[j].#ASDA = $STL[j].#LVLA;
   $STL[j].#APSI = $STL[j].#LVLA + $STL[j].#VATA;

   #LVLT = #LVLT + $STL[j].#LVLA;
   #TVAT = #TVAT + $STL[j].#VATA;

   j=j+1;
end

2 Press Enter twice to insert one blank line after the statement.

Note
It is not necessary to include a blank line after this statement. However, 
doing so may improve readability of the extended rule.
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Completing the
trailer calculations

The final operation that Gentran:Server will execute when processing the extended rule is 
to calculate the line value total and VAT. You want the system to perform these 
calculations:

◗ Set the number of total segments (TLR NSTL element) equal to the count of STL 
segments.

◗ Set the total extended amount (TLR EVLT element) equal to the lines total amount 
(TLR LVLT element).

◗ Set the total amount (TLR ASDT element) equal to the lines total amount (TLR LVLT 
element).

◗ Set the total amount payable (TLR TPSI element) equal to the sum of the lines total 
amount (TLR LVLT element) and the total VAT amount payable (TLR TVAT 
element).

To calculate the line value total and VAT, on the next line in the Editor list box, enter the 
following statement:

#NSTL = stllimit;
#EVLT = #LVLT;
#ASDT = #LVLT;
#TPSI = #LVLT + #TVAT;

Checking what you
entered

Now that you have entered the entire extended rule that will be processed for the INVOIC 
group, your extended rule should look like this:
integer i,j,ildlimit,stllimit;

i=count($STL[*]);
while i > 0 do
begin
   delete($STL[i]);
   i=i-1;
end
stllimit = 0;

ildlimit = count($ILD[1][*]);

i=1;
while i <= ildlimit do
begin
   j=1;
   while j <= stllimit do
   begin
      if $ILD[1][i].#CD12 = $STL[j].#CD12:2 then
      begin
         $STL[j].#LVLA = $STL[j].#LVLA + $ILD[1][i].#LEXC;
         $STL[j].#NRIL = $STL[j].#NRIL + 1;
         break;
      end
      j=j+1;
   end

(Continued on next page)
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   if j > stllimit then
   begin
      $STL[j].#SEQA:7 = j;
      $STL[j].#VATP:2 = $ILD[1][i].#VATP;
      $STL[j].#CD12:2 = $ILD[1][i].#CD12;
      $STL[j].#LVLA = $ILD[1][i].#LEXC;
      $STL[j].#NRIL = 1;
      stllimit = stllimit + 1;
   end
   i=i+1;
end

#LVLT = #TVAT = 0;
j=1;
while j <= stllimit do
begin
   $STL[j].#VATA = ($STL[j].#LVLA * $STL[j].#VATP:2) / 100.0;
   $STL[j].#EVLA = $STL[j].#LVLA;
   $STL[j].#ASDA = $STL[j].#LVLA;
   $STL[j].#APSI = $STL[j].#LVLA + $STL[j].#VATA;

   #LVLT = #LVLT + $STL[j].#LVLA;
   #TVAT = #TVAT + $STL[j].#VATA;

   j=j+1;
end

#NSTL = stllimit;
#EVLT = #LVLT;
#ASDT = #LVLT;
#TPSI = #LVLT + #TVAT;

How to compile the
extended rule

Now that you have entered the extended rule to perform all the INVOIC group-level 
calculations for the invoice, you should compile the extended rule to verify that you have 
entered the rule correctly.

Use this procedure to compile the extended rule.

Now that you have customised all of the elements used in this invoice, you are ready to 
format the fields and labels to make the frames more consistent and visually attractive.

Step Action

1 Click Compile to compile the extended rule.

Note
If you receive any errors or warnings when you compile the rule, verify 
that you entered the rule exactly as it is written in this tutorial. After you 
make any changes to the extended rule to correct it, click Compile again. 
Repeat this process until there are no errors generated.

2 Click OK to add the extended rule to the form and exit the Loop Level 
Extended Rules dialogue.

3 Click Save from the File menu to save the form.
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Format the Screen Entry Form 0

Overview

Introduction In the previous section of this tutorial, you customised the screen entry form for a 
TRADACOMS ANA001 INVOIC release 9 invoice that your users will use to enter data 
to invoice Pet Zone for items that were shipped to them. After successfully customising 
the fields and elements of the screen entry form, you are ready to format the layout of the 
form.

This section explains how to format the form, field by field.

How to resize the
invoice details

frame

When a form is compiled into a translation object, the fields are arranged according to 
how the frames and the fields contained in them were arranged when the form was 
compiled. You should eliminate unnecessary space as you arrange the fields in each frame.

Important
When you resize the frames of a screen entry form, you must resize based on the 
resolution of the target monitor (e.g. the monitor on which the end user will view the 
translation object). For example, if you size the frames of a screen entry form on a Super 
VGA monitor, the compiled translation object may not fit in the display area of a VGA 
monitor.

Use this procedure to resize the Invoice Details frame.

Step Action

1 Click the INVOIC file icon to display the Invoice Details frame in the 
Layout Window.

Note
When the form is generated, the upper left corner of each frame in the 
form is placed in the upper left corner of the Layout Window.

2 To display more of the form on your screen, click and drag the centre bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want to view.

(Continued on next page)
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3 To resize the Invoice Details frame, click and drag the right side of the 
frame approximately to the 14 cm mark on the horizontal ruler so that the 
form is wide enough to format the fields according to the instructions in 
this tutorial.

The Invoice Details frame now should look like this:

 (Contd)
Step Action
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Arranging the Fields on the Invoice Details Frame

Overview You will begin formatting the screen entry form by arranging the fields on the Invoice 
Details frame. You will place the fields in the translation object in a logical order, then 
align the fields to give the frame a consistent and orderly appearance. When you have 
finished arranging the fields, your Invoice Details frame should look like the one in the 
example below (only part of the frame is shown below).

By default, each field and its associated label are displayed on their own line. However, it 
is common for invoices to place two or more fields on a line.

You prevented some of the field labels from being displayed (by removing the field label 
in the Label field of the Display Properties dialogue). For these fields, the fields will be 
displayed on your screen entry form, but their associated labels are not displayed. 

Note
If you forget which unlabelled field contains what data, you can click the field. Its 
associated element will be highlighted in the EDI File Format Window, providing you 
with a description of the field.
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How to resize,
move, and align

the fields

Use this procedure to resize, move, and align the fields on the Invoice Details frame of the 
screen entry form:

Note
If a field and its corresponding field label move together, the Lock Labels to Fields option 
is turned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels 
option.

Step Action

1 Click and drag the bottom of the frame to the bottom of the Forms 
window, so that as many of the fields on the frame are displayed as 
possible.

2 Select the following fields:

Note
To select more than one field, click the first field, then press CTRL and 
click the second field. Repeat the process of pressing CTRL and clicking 
the field for each subsequent field you want to select.

◗ Location Own Code
◗ Name
◗ Invoice Date
◗ Tax-point Date
◗ P.O. Date
◗ Delivery Date

Note
If any of these fields is not in the part of the Invoice Details frame that 
currently is displayed, then use the scroll bar to scroll down the frame 
until you locate the hidden field(s).

3 Select Size to Length from the Display menu. All selected fields will be 
resized to the lengths specified in the Display Length field of the Display 
Properties dialogue for each field.

Note
If you accidentally format a form component in a way you did not intend, 
select Undo from the Display menu to undo your last formatting action.

4 Select each field in the form individually and drag it closer to its 
respective label.

(Continued on next page)
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5 Select all of the items (fields, field labels, list boxes) on the frame and 
drag them a few centimetres lower on the frame. You will be arranging the 
fields at the top of the frame, so moving the fields and field labels out of 
the way initially will give you room to work with at the top of the frame.

Note
To select a group of items, click and drag the mouse diagonally across all 
the fields/labels you want to select. When you release the mouse button, 
all the fields and field labels completely included within the space formed 
by dragging the mouse will have handles, indicating they were selected.

6 Click the Lock Labels button on the Main Toolbar to turn on the Lock 
Labels function. When you select a field, its corresponding field label will 
be selected also.

7 Select the Invoice No. label and field and drag them to the upper left 
corner of the Invoice Details frame. (Their field labels will be selected, 
too, because you have the Lock Labels function turned on.)

8 Select the Invoice Date label and field and drag them to the upper right 
corner of the Invoice Details frame (at approximately 8 cm on the 
horizontal ruler).

9 Select the Tax-point Date label and field and drag them under the Invoice 
Date label and field.

10 Select the Customer’s P.O. No. label and field and drag them under the 
Invoice No. label and field (but not on the same line as the Tax-point Date 
label and field).

11 Select the P.O. Date label and field and drag them below the Tax-point 
Date label and field.

12 Select the Delivery Note Number label and field and drag them below 
the Customer’s P.O. No. label and field.

13 Select the Delivery Date label and field and drag them below the P.O. 
Date label and field.

14 Select the Location ANA Code label and field and drag them below the 
Delivery Note Number label and field (and indented about half a 
centimetre).

Note
You will add static text later in this tutorial to label all the fields providing 
customer details. Therefore, leave extra space between the Delivery Note 
Number and Delivery Date labels and fields, and the Location ANA Code 
and Location Own Code labels and fields, to insert the static text between 
them.

(Continued on next page)
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15 Select the Location Own Code label and field and drag them to the right 
of the Location ANA Code label and field (at approximately 7 cm on the 
horizontal ruler).

16 Select the following fields and labels, and drag them below the Location 
ANA Code label and field:

◗ Name
◗ Address Line 1
◗ Address Line 2
◗ Address Line 3
◗ Address Line 4
◗ Post Code

17 Select the Payment Terms label and field and drag it below the Post Code 
field. (The left margin of the Payment Terms label should be aligned with 
the left margin of the Delivery Note Number label.)

Note
Leave extra space between the Post Code field and label, and the Payment 
Terms field and label, to designate the end of the Customer Details 
section.

18 Select the Invoice Notes label and fields (there are four fields, three of 
which are unlabelled) and drag them below the Payment Terms label and 
field.

19 Select the Line Items label and list box and drag them below the fourth 
Invoice Notes field (the second, third, and fourth Invoice Notes fields are 
unlabelled).

Note
Leave extra space above the Line Items field and list box to add column 
headings (using static text) to label the data in the list box.

20 Click and drag the right or left handle on the Line Items list box until the 
list box is approximately 11.25 cm wide. The list box must be at least 
11.25 cm wide to be able to display all of the summary list data.

Note
Use the horizontal ruler to help you measure width.

21 Select the VAT Summary label and list box and drag them below the Line 
Items label and list box.

Note
Leave extra space above the VAT Summary field and list box to add 
column headings (using static text) to label the data in the list box.

(Continued on next page)
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22 Click and drag the right or left handle on the VAT Summary list box until 
the list box is approximately 4.5 cm wide. The list box must be 
approximately 4.5 cm wide to display all of the summary list data 
appropriately.

23 Select the following fields and labels and drag them below the VAT 
Summary list box (so that the fields and labels are approximately centred 
horizontally on the frame):

◗ Invoice Amount (Excluding VAT)
◗ Invoice Amount (Ex. Settlement Disc.)
◗ Invoice Amount (Ex. VAT Inc. VAT)
◗ VAT Total
◗ Total Invoice Amount (Inc. Sett. Disc.)

24 Click the Lock Labels button on the Main Toolbar to turn off the Lock 
Labels function.

(Continued on next page)
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25 The Invoice Details frame now should look like this (only a portion of the 
frame is displayed below):

Note
Depending on the size of your monitor, you will see more or fewer of the 
fields in the example above. To see fields that are not displayed currently 
on the frame, use the scroll bar to scroll down the frame.

 (Contd)
Step Action



Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005

Creating a Screen Entry Form Arranging the Fields on the Invoice Details Frame 3 - 131

How to align the
fields and field

labels

Now that the fields in the Invoice Details frame are resized and moved to their proper 
locations, you can align the fields and labels. 

Use this procedure to align the fields and field labels on the Invoice Details frame.

Step Action

1 Select the following field labels:

◗ Invoice No.
◗ Customer’s P.O. No.
◗ Delivery Note Number
◗ Payment Terms
◗ Invoice Notes
◗ Line Items
◗ VAT Summary

Note
To select more than one field, click the first field, then press CTRL and 
click the second field. Repeat the process of pressing CTRL and clicking 
the field for each subsequent field you want to select.

2 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

3 Select the following field labels:

◗ Invoice Date
◗ Tax-point Date
◗ P.O. Date
◗ Delivery Date

Note
To select a group of items, click and drag the mouse diagonally across all 
the fields/labels you want to select.

4 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

(Continued on next page)
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5 Select the following field labels:

◗ Location ANA Code
◗ Name
◗ Address Line 1
◗ Address Line 2
◗ Address Line 3
◗ Address Line 4
◗ Post Code

6 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

7 Select the following field labels:

◗ Invoice Amount (Excluding VAT)
◗ Invoice Amount (Ex. Settlement Disc.)
◗ Invoice Amount (Ex. VAT Inc. Sett.)
◗ VAT Total
◗ Total Invoice Amount (Inc. Sett. Disc.)

8 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

(Continued on next page)
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9 Select the following fields:

◗ Invoice No.
◗ Customer’s P.O. No.
◗ Delivery Note Number
◗ Location ANA Code
◗ Name
◗ Address Line 1
◗ Address Line 2
◗ Address Line 3
◗ Address Line 4
◗ Post Code

Note
Select the Location ANA Code field last, so that it is the reference. The 
reference is the item (field, field label, list box, or static text) relative to 
which all other selected items are formatted. The reference is indicated by 
an outline of diagonal lines, whereas all other selected items are outlined 
by a solid line. The last item selected in a group of selected items is the 
reference.

10 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected fields are 
aligned.

11 Select the Line Items and VAT Summary list boxes.

Note
Select the VAT Summary field last, so that it is the reference.

12 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected list boxes 
are aligned.

13 Select the following fields:

◗ Invoice Date
◗ Tax-point Date
◗ P.O. Date
◗ Delivery Date

Note
Select the Tax-point Date field last, so that it is the reference. 

(Continued on next page)
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14 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected fields are 
aligned.

15 Select the following fields:

◗ Payment Terms
◗ Invoice Notes (all four fields)

Note
Select the Payment Terms field last, so that it is the reference. 

16 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected fields are 
aligned.

17 Select the following fields:

◗ Invoice Amount (Excluding VAT)
◗ Invoice Amount (Ex. Settlement Disc.)
◗ Invoice Amount (Ex. VAT Inc. Sett.)
◗ VAT Total
◗ Total Invoice Amount (Inc. Sett. Disc.)

Note
Select the Total Invoice Amount (Inc. Sett. Disc.) field last, so that it is the 
reference. 

18 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected fields are 
aligned.

(Continued on next page)
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19 To align the tops of all of the field labels, fields, and list boxes, select each 
row of items (one row at a time), select Align Controls from the Display 
menu, then select Top from the Align Controls cascading menu. The items 
in each row are listed below:

◗ Invoice No. label and field, Invoice Date label and field
◗ Tax-point Date label and field
◗ Customer’s P.O. No. label and field, P.O. Date label and field
◗ Delivery Note Number label and field, Delivery Date label and field
◗ Location ANA Code label and field, Location Own Code label and 

field
◗ Name label and field
◗ Address Line 1 label and field
◗ Address Line 2 label and field
◗ Address Line 3 label and field
◗ Address Line 4 label and field
◗ Post Code label and field
◗ Payment Terms label and field
◗ Invoice Notes label and field (first Invoice Notes field only)
◗ Line Items label and list box
◗ VAT Summary label and list box
◗ Invoice Amount (Excluding VAT) label and field
◗ Invoice Amount (Ex. Settlement Disc.) label and field
◗ Invoice Amount (Ex. VAT Inc. Sett.) label and field
◗ VAT Total label and field
◗ Total Invoice Amount (Inc. Sett. Disc.) label and field

(Continued on next page)
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Adding static text
to the frame

You will add static text (text that is always included in the screen entry template) to the 
Invoice Details frame for these three purposes.

◗ To label the area of the frame containing customer detail fields
◗ To add column headings to the Line Items list box
◗ To add column headings to the VAT Summary list box
When you moved the fields on the frame, you already left space in the appropriate 
locations for the static text. In this section of the tutorial, you will add the static text and 
move it to the proper locations in the frame.

20 The Invoice Details frame now should look like this:

Note
Depending on the size of your monitor, you will see more or fewer of the 
fields in the example above. To see fields that are not displayed currently 
on the frame, use the scroll bar to scroll down the frame.

 (Contd)
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How to add the
customer details

label

Use this procedure to add static text that will label the group of customer detail fields on 
the frame.

How to add
column headings

to the line items list
box

Gentran:Server labels the fields on the Line Items frame, but does not label the column 
headings for the Line Items list box on the Invoice Details frame. The Line Items list box 
displays the information entered into the fields on the Line Items frame. To label the 
columns in the Line Items list box, you must add the column headings with static text.

After you add the column headings and move each column heading to its proper location, 
the Line Items list box and the column headings should look like this:

(Continued on next page)

Step Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame, 
displayed in the upper left corner of the frame. If the template is larger 
than the frame (there is a scroll bar on the right side of the frame), the 
static text is displayed in the upper left corner of the part of the template 
that is displayed, not at the top of the template.

2 Select the new text field and enter CUSTOMER DETAILS, all in capital 
letters. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

System Response
The text you added is displayed in the upper left corner of the frame.

3 Select the CUSTOMER DETAILS static text and drag it below the 
Delivery Note Number label and field (The left margin of the static text 
should be aligned with the left margin of the Delivery Note Number 
label.).
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Use this procedure to add and position the column headings.

Step Action

1 Click Add Text on the Main Toolbar. 

System Response
Text is added to the current frame, displayed in the upper left corner of the 
frame. If the template is larger than the frame (there is a scroll bar on the 
right side of the frame), the static text is displayed in the upper left corner 
of the part of the template that is displayed, not at the top of the template.

2 Select the new text field and enter Item. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

3 Click and drag it to above the Line Items list box, starting about 1 cm 
from the left margin of the list box (so it looks like the example on 3 - 
137).

4 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

5 Select the new text field and enter Product. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

6 Click and drag it to above the Line Items list box, to the right of the Item 
column heading.

7 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

8 Select the new text field and enter Qty. (note the full stop in the text). The 
Text Properties dialog is displayed as you are typing. Click OK to add the 
text.

9 Click and drag it to above the Line Items list box, nearly 8 cm. from the 
left margin of the list box.

10 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

11 Select the new text field and enter Price. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

12 Click and drag it to above the Line Items list box, near the right margin of 
the list box.

(Continued on next page)
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Adding column
headings to the vat

summary list box

Gentran:Server labels the fields on the VAT Summary frame, but does not label the 
column headings for the VAT Summary list box on the Invoice Details frame. The VAT 
Summary list box displays the information entered into the fields on the Line Items frame. 
To label the columns in the VAT Summary list box, you must add the column headings 
with static text.

After you add the column headings and move each column heading to its proper location, 
the VAT Summary list box and the column headings should look like this:

Use this procedure to add and position the column headings.

13 To ensure that the column headings (static text) you just added are aligned 
properly, select all the static text you just added (Item, Qty., Product, 
Price). Select Align Controls from the Display menu, then select Top 
from the Align Controls cascading menu.

Note
To select a group of items, click and drag the mouse diagonally across all 
the items you want to select.

 (Contd)
Step Action

Step Action

1 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

2 Select the new text field and enter Code. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

3 Click and drag it to above the VAT Summary list box, immediately to the 
right of the left margin of the VAT Summary list box (so it looks like the 
example on 3 - 139).

4 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

5 Select the new text field and enter VAT. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

6 Click and drag it to above the “Code” static text.

(Continued on next page)
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7 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

8 Select the new text field and enter VAT Rate. The Text Properties dialog 
is displayed as you are typing. Click OK to add the text.

9 Click and drag it to above the VAT Summary list box, about 1 cm from the 
left margin of the list box.

10 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

11 Select the new text field and enter Lines Subtotal. The Text Properties 
dialog is displayed as you are typing. Click OK to add the text.

12 Click and drag it to above the VAT Summary list box, nearly to the right 
margin of the list box.

13 To ensure that the column headings (static text) you just added are aligned 
properly, select the following static text:

◗  Code
◗ VAT Rate
◗ Lines Subtotal

14 Select Align Controls from the Display menu, then select Top from the 
Align Controls cascading menu.

Note
To select a group of items, click and drag the mouse diagonally across all 
the items you want to select.

15 Select the VAT and Code static text.

16 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu.

(Continued on next page)
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17 The Invoice Details frame now should look like this:

Note
Depending on the size of your monitor, you will see more or fewer of the 
fields in the example above. To see fields that are not displayed currently 
on the frame, use the scroll bar to scroll down the frame.

 (Contd)
Step Action
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How to set the tab
sequence on the

invoice details
frame

The tab sequence is the order in which the cursor moves from field to field in the screen 
entry translation object when a user presses TAB. When you create a screen entry form, 
the system automatically positions the fields and sets the tab sequence for those fields. 
However, you usually will want to modify the tab sequence of the fields to meet your 
screen entry requirements and the new positions of the fields on the frame.

Use this procedure to set the tab sequence for the fields on the Invoice Details frame.

Step Action

1 Select Set Tab Order from the Display menu. Numbers are displayed in 
the fields on the frame to indicate the current tab sequence.

Note
Depending on the size of your monitor, you will see more or fewer of the 
fields in the example above. To see fields that are not displayed currently 
on the frame, use the scroll bar to scroll down the frame.

(Continued on next page)
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2 Click the fields and list boxes listed below in the order in which they are 
listed. As you click each field, the tab sequence number for that field will 
change to the next sequential number in the tab sequence.

Note
If you click a field out of sequence, you must begin setting the tab 
sequence again. To start over, select Set Tab Order from the Display menu 
so that the tab sequence numbers are no longer displayed in the fields on 
the frame, and then begin these steps again.

a. Invoice No.
b. Invoice Date
c. Tax-point Date
d. Customer’s P.O. No.
e. P.O. Date
f. Delivery Note Number
g. Delivery Date
h. Location ANA Code
i. Location Own Code
j. Name
k. Address Line 1
l. Address Line 2
m. Address Line 3
n. Address Line 4
o. Post Code
p. Payment Terms
q. Invoice Notes (first field)
r. Invoice Notes (second field, unlabelled)
s. Invoice Notes (third field, unlabelled)
t. Invoice Notes (fourth field, unlabelled)
u. Line Items
v. VAT Summary
w. Invoice Amount (Excluding VAT)
x. Invoice Amount (Ex. Settlement Disc.)
y. Invoice Amount (Ex. VAT Inc. Sett.)
z. VAT Total
aa. Total Invoice Amount (Inc. Sett. Disc.)

(Continued on next page)
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3 The new tab sequence should look like this:

Note
When you click the last field in the sequence (Total Invoice Amount (Inc. 
Sett. Disc.)), the tab sequence is set, and the tab sequence numbers no 
longer are displayed in the fields.

Note
Depending on the size of your monitor, you will see more or fewer of the 
fields in the example above. To see fields that are not displayed currently 
on the frame, use the scroll bar to scroll down the frame.

 (Contd)
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Arranging the Fields on the Line Items Frame

Overview Now that the fields, labels, and static text are arranged on the Invoice Details frame, you 
are ready to arrange the fields on the Line Items frame. You will place the fields in a 
logical order, then align the fields (as you did with the fields on the Invoice Details frame) 
to give the frame a consistent and orderly appearance. When you finish arranging the 
fields, the Line Items frame in your form should look like the one in the example below.

How to resize the
line items frame

Before you begin arranging the fields on the Line Items frame, you should resize the frame 
so that it is the same width as the Invoice Details frame. When this form is compiled into a 
translation object, the fields will be arranged according to how the frames and the fields 
contained on them were arranged when the form was compiled. You should eliminate 
unnecessary space as you arrange the fields on each frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the 
upper left corner of the Layout Window.

Step Action

1 Click the ILD group (in the ODD group) to display the Line Items frame 
in the Layout Window.

2 To resize the Line Items frame, click and drag the right side of the frame 
to the 14 cm mark on the ruler so that the form is wide enough to format 
the fields according to the instructions in this tutorial.

Note
Use the horizontal ruler at the top of the frame to help you resize the 
frame.

(Continued on next page)
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How to resize the
fields

Use this procedure to resize the fields on the Line Items frame of the screen entry form.

3 To display more of the form on your screen, click and drag the centre bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want to view.

The Line Items frame now should look like this:

 (Contd)
Step Action

Step Action

1 Select the following fields:

◗ Item No.
◗ Quantity

Note
To select more than one field, click the first field, then press CTRL and 
click the second field. Repeat the process of pressing CTRL and clicking 
the field for each subsequent field you want to select.

2 Select Size to Length from the Display menu. All selected fields will be 
resized to the lengths specified in the Display Length field of the Display 
Properties dialogue for each field.
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How to move and
align the fields

Use this procedure to move and align the fields on the Line Items frame of the screen entry 
form.

Step Action

1 Select the Unit of Measure field and drag its bottom handle so that the 
field is long enough for four codes to be displayed in it when the drop-
down part of the drop-down list is open (approximately 2 cm on the 
vertical ruler).

Note
Use the vertical ruler to the left of the frame to help you measure length.

2 Select the VAT Code and Unit of Measure fields (in that order).

Note
Select the Unit of Measure field last, so that it is the reference.

3 Select Size Equally from the Display menu. The VAT Code field is the 
same size as the Unit of Measure field.

Note
The Unit of Measure and VAT Code drop-down list boxes have slightly 
different appearances. When the Exclusive check box is marked in the 
Advanced section of the Field Properties dialogue, the text box is attached 
to the drop-down arrow. When the Exclusive check box is not marked, 
there is a gap between the text box and the drop-down arrow.

4 Select each field and list box on the frame individually and move it closer 
to its respective label.

5 Click the Lock Labels button on the Main Toolbar to turn on the Lock 
Labels function. When you select a field, its corresponding field label will 
be selected also.

6 Select the Item No. label and field and drag them to the upper left corner 
of the frame. (When you select the field, its label will be selected, too, 
because you have the Lock Labels function turned on.)

7 Select the EAN Code label and field and drag them to the upper right 
corner of the frame.

8 Select the following fields and labels and drag them below the Item No. 
label and field:

◗ Supplier’s Product Code
◗ Customer’s Product Code
◗ Quantity

9 Select the Unit of Measure label and list box and drag them to the right of 
the Quantity label and field.

(Continued on next page)



Arranging the Fields on the Line Items Frame Creating a Screen Entry Form

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

3 - 148

Resizing the line
items frame

To resize the Line Items frame, click and drag the bottom of the frame to below the 
Description label and field.

Note
Allow enough space between the Description label and field, and the bottom of the frame, 
for the VAT Code drop-down list box to be opened.

The Line Items frame now should look like this:

10 Select the Unit Price (Ex. VAT) label and field and drag them below the 
Quantity label and field.

11 Select the VAT Code label and field and drag them under the Unit of 
Measure label and list box.

12 Select the Description label and field and drag them below the Unit Price 
(Ex. VAT) label and field.

13 Click the Lock Labels button on the Main Toolbar to turn off the Lock 
Labels function.

 (Contd)
Step Action
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How to align the
fields and field

labels

Use this procedure to align the fields and field labels on the Line Items frame.

Step Action

1 Select the following field labels:

◗ Item No.
◗ Supplier’s Product Code
◗ Customer’s Product Code
◗ Quantity
◗ Unit Price (Ex. VAT)
◗ Description

Note
To select more than one field, click the first field, then press CTRL and 
click the second field. Repeat the process of pressing CTRL and clicking 
the field for each subsequent field you want to select.

2 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

3 Select the following fields:

◗ Item No.
◗ Supplier’s Product Code
◗ Customer’s Product Code
◗ Quantity
◗ Unit Price (Ex. VAT)

Note
Select the Customer’s Product Code field last, so that it is the reference.

4 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected fields are 
aligned.

5 Select the following labels:

◗ EAN Code
◗ Unit of Measure
◗ VAT Code

Note
To select a group of items, click and drag the mouse diagonally across all 
the fields and labels you want to select.

(Continued on next page)
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6 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.

7 Select the following field and list boxes:

◗ EAN Code
◗ Unit of Measure
◗ VAT Code

Note
Select the Unit of Measure list box last, so that it is the reference.

8 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected items are 
aligned.

9 Select the Description and EAN Code fields.

Note
Select the EAN Code field last, so that it is the reference.

10 Select Align Controls from the Display menu, then select Right from the 
Align Controls cascading menu. The right margins of the of the selected 
fields are aligned.

(Continued on next page)
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11 To align the tops of all of the field labels, fields, and list boxes, select each 
row of items (one row at a time), select Align Controls from the Display 
menu, then select Top from the Align Controls cascading menu. The items 
in each row are listed below:

◗ Item No. label and field and EAN Code label and field
◗ Supplier’s Product Code label and field
◗ Customer’s Product Code label and field
◗ Quantity label and field and Unit of Measure label and drop-down list 

box
◗ Unit Price (Ex. VAT) label and field and VAT Code label and drop-

down list box
◗ Description label and field

The Line Items frame now should look like this:

 (Contd)
Step Action
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How to set the tab
sequence on the
line items frame

Use this procedure to set the tab sequence of the fields on the Line Items frame.

Step Action

1 Select Set Tab Order from the Display menu. Numbers are displayed in 
the fields on the frame to indicate the current tab sequence.

2 Click the fields listed on the next page in the order in which they are 
listed. As you click each field, the tab sequence number for that field will 
change to the next sequential number in the tab sequence you are now 
setting.

Note
It is important to click each field in the order listed below. If you click a 
field out of sequence, you must begin setting the tab sequence again. To 
start over, select Set Tab Order from the Display menu so that the tab 
sequence numbers are no longer displayed in the fields on the frame, and 
then begin these steps again.

a. EAN Code
b. Supplier’s Product Code
c. Customer’s Product Code
d. Quantity
e. Unit of Measure
f. Unit Price (Ex. VAT)
g. VAT Code
h. Description
i. Item No.

Note
The Item No. field is the last field in the tab sequence, although it is the 
first field in the layout of the Line Items frame. This field is display-only, 
displaying the next consecutive line item number (the line item number is 
generated by an extended rule in the ILD group). By placing the Item No. 
field last in the tab sequence, this field can be skipped easily by users 
entering data. The first field in the sequence is the EAN Code field, which 
is the first field into which users can enter a value.

(Continued on next page)
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10 The new tab sequence for the Line Items frame should look like this:

Note
When you click the last field in the sequence (Item No.), the tab sequence 
is set, and the tab sequence numbers no longer are displayed in the fields.

 (Contd)
Step Action
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Arranging the Fields on the VAT Summary Frame

Overview Just as you arranged the fields, labels, and static text on the Invoice Details and Line Items 
frames, now you will arrange the items on the VAT Summary frame. You will place the 
fields in a logical order, then align the fields to give the frame a consistent and orderly 
appearance. When you finish arranging the fields, the VAT Summary frame in your form 
should look like the one in the example below.

How to resize the
VAT summary

frame

Before you begin arranging the fields on the VAT Summary frame, you should resize the 
frame so that it is the same width as the Invoice Details and Line Items frames. When this 
form is compiled into a translation object, the fields will be arranged according to how the 
frames and the fields contained on them were arranged when the form was compiled. You 
should eliminate unnecessary space as you arrange the fields on each frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the 
upper left corner of the Layout Window.

Step Action

1 Click the STL segment to display the VAT Summary frame in the Layout 
Window.

2 To resize the VAT Summary frame, click and drag the right side of the 
frame to the 14 cm mark on the ruler, so that all the fields on the frame are 
visible. After you arrange the fields on this frame, you will resize the VAT 
Summary frame so that it matches the other frames in the invoice.

Note
Use the horizontal ruler at the top of the frame to help you resize the 
frame.

(Continued on next page)
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3 To display more of the form on your screen, click and drag the centre bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want to view.

The VAT Summary frame now should look like this:

 (Contd)
Step Action
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How to resize the
VAT code field

Gentran:Server bases the lengths of fields on the widths of lowercase letters. For example, 
if a field has a display length (defined on the Display Properties dialogue) of five, then 
Gentran:Server produces a field with a length able to accommodate the average width of 
lowercase letters.

The VAT Code field will contain a code in an uppercase letter. Therefore, you should 
adjust the width of the field to prevent the code in the VAT Code field from being 
truncated.

Use this procedure to resize the VAT Code field.

How to move and
align the fields

Use this procedure to move and align the fields on the VAT Summary frame of the screen 
entry form.

Step Action

1 Select the VAT Code field.

2 Drag its right or left handle so the field is approximately twice as wide as 
its original width.

Step Action

1 Select the VAT Amount Payable and Payable Subtotal (Inc. Sett. Disc.) 
fields and labels, and drag them closer to the Lines Subtotal (Excluding 
VAT) field and label.

Note
You may need to temporarily adjust the width of the frame so that the 
Payable Subtotal (Inc. Sett. Disc.) field is visible.

2 Select all of the fields on the frame.

Note
Select the VAT Amount Payable field last, so that it is the reference.

3 Select Align Controls from the Display menu, then select Left from the 
Align Controls cascading menu. The left margins of the selected field 
labels are aligned.
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How to resize the
VAT summary

frame

Use this procedure to resize the VAT Summary frame.

Whereas in the Invoice Details and Line Items frame you set the tab sequence for the 
fields on the frames, you do not need to set the tab sequence for the VAT Summary frame. 
All the fields on this frame (other than the hidden fields) are display-only. Screen entry 
translation object users will not be able to enter a value in any of the fields, so the tab 
sequence is irrelevant.

Step Action

1 Click and drag the bottom of the frame to below the Payable Subtotal (Inc. 
Sett. Disc.) label and field.

The VAT Summary frame now should look like this:
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Changing the Invoice Details Frame Title

Overview The system automatically titles the frames in a screen entry form when the form is created, 
based on the name of the file, segment(s), or group(s). You can modify the frame titles (for 
example, at the file or message level) to distinguish one form from the others. The parent 
frame of the invoice currently is titled Invoice Details. You will give this frame a more 
descriptive title to distinguish it from other invoices that your company uses.

Procedure Use this procedure to change the frame title.

You have completed your Invoice form. Now, you are ready to finalise the form.

Step Action

1 Click the INVOIC file icon with the right mouse button to access the 
shortcut menu.

2 Select Properties from the shortcut menu. 

System Response
The File Format Properties dialogue is displayed.

3 In the Frame Caption field, enter TRADACOMS ANA001 INVOIC 
Release 9 - Pet Zone.

4 Click the OK button. 

System Response
The new frame title is displayed in the frame title in the Layout Window.

5 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

6 Select Save from the File menu to save the form. 
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Finalise the Form 0

Overview

Introduction Now that you have created and customised a screen entry form, you are ready to compile 
the form to generate the translation object (*.TPL) that Gentran:Server uses before you 
print the report and test the compiled translation object.
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Compiling the Form

Overview The Compile function compiles the form. The form that you create using Gentran:Server 
is a source form. When that source form is compiled, the result is a compiled translation 
object.

This translation object must be registered with the Gentran:Server system before you can 
use it. You will use the Compile function after the form is completed and saved.

Procedure Use this procedure to compile the form.

Step Action

1 Select Compile from the File menu to display the Run-Time Translation 
Object Name dialogue.

(Continued on next page)
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2 Click Save to accept the translation object name (pettinvs.tpl) in the “File 
name” field.

This name for the compiled translation object (.TPL file) is the same 
filename as the source form (.STP file). Preserving the same filename 
(with different file extensions) ensures that the relationship between the 
source form and the compiled translation object remains evident.

CAUTION
BE VERY CAREFUL NOT TO OVERLAY THE SOURCE 
FORM WITH THE COMPILED TRANSLATION OBJECT. 
USE THE .TPL FILE EXTENSION TO DISTINGUISH THE 
COMPILED TRANSLATION OBJECT.
The system will compile the form and generate an error report. The error 
report is displayed in the Compile Errors dialogue. 

3 Click OK to exit the Compile Errors dialogue.

Note
If the Compile Errors dialogue contains errors, you must fix the 
problem(s) by redoing the appropriate section of the tutorial. Recompile 
the form after you correct the error(s) and save the form.

4 Select Save from the File menu to save the form. The date on which you 
compiled the form is loaded automatically into the Compiled on field on 
the Translation Object Details dialogue.

 (Contd)
Step Action
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Printing the Report 

Overview The Gentran:Server report enables you to validate and review the translation object, and 
make modifications as needed. If you review the report and determine that the translation 
object is incorrect, you should reiterate the form creation process as many times as 
necessary (make the modifications, save the form, recompile the form, and print the report 
again).

Procedure Use this procedure to print the Gentran:Server report.

Step Action

1  Select Print from the File menu to access the Print Options dialogue.

2 Click OK to accept the defaults on this dialogue (all options marked), so 
the report includes all sections and only the activated form components. 

System Response
The Print dialogue is displayed.

3 Do you need to change setup options (to select a specific printer, paper 
orientation, or size and source of paper) ? 

◗ If yes, click Properties. Set the appropriate options. Click OK to 
begin the print process.

◗ If no, click OK to begin the print process.
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Testing the Translation Object

Overview After you compile the form, print and verify the report, and register the translation object 
with Gentran:Server, you should test the translation object to verify that the data is 
translated correctly. To test the compiled translation object, you should use the translation 
object to create a new document. You also should verify acknowledgement processing (if 
applicable) and verify communications with your network.

Important
The translation object must be registered with the Gentran:Server system before you can 
use it. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for information on registering the 
translation object.

Procedure Use this procedure to test the screen entry translation object you just created.

Step Action

1 Register the PETTINVS.TPL translation object with Gentran:Server. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on registering a translation object.

2 If you have not done so already, import the PETZONE4.PAR partner 
relationship into Gentran:Server. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on importing a partner.

3 Import the division lookup table (INVATCO.LKP) for the system partner 
(Internal System User) into Gentran:Server. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on importing a table.

The default full path for the lookup table is:
C:\GENSRVNT\TUTORIAL\INVATCO.LKP

(Continued on next page)
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4 Verify (in Partner Editor) that the Screen TRADACOMS INVOIC Pet 
Zone screen entry translation object is selected for the Outbound 
Relationship. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on selecting outbound translation objects.

5 Create a new document (partner PETZONE4 and relationship 
PETZONE4_TRADACOMS_INVOIC) to enter the data in the screen 
entry translation object you created. 

Reference
See the Gentran:Server® Windows® User’s Guide for more information 
on creating a document.

 (Contd)
Step Action
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Glossary

?In Documents This Gentran:Server browser contains a list of messages that were received by the system 
but failed compliance checking or that do not have an identifiable partner or transaction 
set.

?Out Documents This Gentran:Server browser contains a list of messages that were imported into the 
system via unattended processing but are invalid.

acknowledgement This term is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999 
acceptance/rejection advice, and the EDIFACT CNTRL message.

activation This function enables you to make map components available for use. The system 
activates all the groups, segments, composites, and elements that are defined as 
“mandatory” (must be present) by the standard. The system does not enable you to 
deactivate the mandatory groups, segments, composites, and elements. When translating 
data, the system does not process groups, segments, composites, and elements (or records 
and fields) that are not activated. Therefore, you must activate the groups, segments, 
composites, and elements that are not defined as mandatory by the standard, but that you 
have determined that you need to use in mapping.

AIAG The Automotive Industry Action Group (AIAG) is the standards-setting group for the 
automotive industry. The standards form a subset of the ANSI X12 standard. 

ANA Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and 
services, such as safety glasses and battery capacities. The ANSI X12 committee is the 
chief EDI standards-setting organisation for the United States.

application file If you are creating an import or export map, you must define your application to the 
Application Integration subsystem. In Gentran:Server terminology, your application file is 
also referred to as a fixed-format file or a positional file. Your application file must contain 
all the information that you either need to extract from your partner’s message (if the map 
is inbound) or need to send to your partner (if the map is outbound), so that your system 
can accurately process the data.
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application system Computer systems, outside of EDI, designed to fulfil specific business functions. These 
include accounting, purchasing, materials control, human resources, shipping, and other 
systems.

browser A browser is a window that displays a list of items, such as messages (transaction sets), 
interchanges, translation objects, etc. A message browser displays only messages.

check box A check box enables you to select or clear options from a list. You can select as many 
options from the list as you need. A selected check box contains a checkmark. The labels 
of unavailable options are dimmed.

code list tables These are used by EDI standards as repositories for lists of codes. Each EDI standard 
provides a code list for each element that can be further defined with a code.

colours This feature enables you to select foreground and background colours to visually define 
the various map components. The use of colour is optional.

communications
session

Everything sent and received to/from one telephone number in one continuous period of 
connection. This could include sending two or three interchange envelopes to a network, 
each for a different trading partner.

Communicator This is the Gentran:Server communications software. The Communicator enables you to 
send, receive, resend, establish communication port definitions, establish communication 
profiles, establish communication scripts, and view and delete communication sessions.

compile This function compiles the form and creates a translation object. The form that you create 
using Gentran:Server is a source form. When that source form is compiled, the result is a 
compiled translation object. This translation object will need to be registered with the 
Gentran:Server system before you can use it.

compliant This means that the message conforms to the EDI standards as defined by the translation 
object.

component data
element

A simple data element that belongs to a composite data element. Component data 
elements are also called sub-elements.

composite data
element

A contains two or more component data elements or sub-elements. Composites are 
defined by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI 
X12 standards).
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conditions See relational conditions.

constant This standard rule enables you to move a literal constant value to the specified element or 
field, indicate a qualifying relationship with another element or field, and map the current 
date or time to the specified element or field.

cross-reference
table

This table is created in Partner Editor and is used to convert your values to your trading 
partner's values during outbound processing, or your partner's values to your values during 
inbound processing.

date/time This type of field or element contains a date or time. If you specify that a field or element 
will be a date/time type, you must specify exactly how the date or time must be formatted.

deactivation This function enables you to make map components unavailable for use by the system. 
The system does not enable you to deactivate the mandatory groups, segments, 
composites, and elements.

default A predefined value – programs use these built-in values unless you specifically override 
them.

document
(message)

One transaction set containing actual data and treated as a single entity. The amount of 
data does not affect whether something is a message or not, only the fact that it is treated 
as a single entity. For example, regardless of whether a purchase order contains one item 
or ten thousand, if it is one purchase order, it is one message.

If a trading partner sends you a communication containing 10 purchase orders, you have 
received 10 messages. If the communication contained 15 invoices, you have received 15 
messages.

EANA International Article Numbering Association, Brussels, Belgium.

EDI Electronic Data Interchange (EDI) is the process by which companies can exchange 
business messages directly from application to application by computer without paper 
messages being produced.

EDI File Format
Pane

The EDI File Format Pane contains the EDI file format. When you click a segment or 
group in the EDI file format, the corresponding frame is displayed in the Layout Window. 
When you click an element in the EDI file format, the corresponding layout component is 
highlighted in the Layout Window.
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EDI standard This is the rules for turning a business message into an EDI message.

EDIA The Electronic Data Interchange Association, formerly known as the Transportation Data 
Coordinating Committee (TDCC). 

EDIFACT This is the standards organisation of the United Nations Economic and Social Council. 
The acronym is short for the Electronic Data Interchange for Administration, Commerce, 
and Transport.

element The smallest piece of usable information defined by the standards. Examples might 
include a quantity, unit price, or description. An individual element can have somewhat 
different meanings depending on context. Therefore, elements are normally not 
considered to have useful meaning until they are combined into segments. An element is 
the EDI map component that is mapped (linked) to a corresponding application field to 
move data to and from the EDI file.

There are three types of data elements, as illustrated in the table below:

envelope A way of separating information in transmissions for ease of processing. Each envelope 
contains a header segment and a trailer segment, which separate the envelope from other 
envelopes and provide information about the contents of the envelope.

There are three levels of envelopes, as follows:

Transaction Set
Each transaction set (business message) is contained within a transaction set envelope.

Functional Group
An envelope containing related business messages. The standards define which 
transaction sets should be placed together into a functional group envelope.

(Continued on next page)

Data Element Definition

Simple data element A single piece of information 
defined by the standards.

Composite data 
element

A data element that is made up of 
multiple component elements.

Component data 
element

A simple data element that belongs 
to a composite data element. 
Component data elements are also 
called sub-elements.
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Interchange Envelope
All material being sent to one trading partner in one communication. The term Interchange 
Envelope is the term used by ANSI. EDIA uses the term Transmission Envelope to refer 
to this level of envelope. Since we use the term transmission for other uses, we will refer 
to Interchange Envelope only.

Note
A communications session could easily include a number of interchange envelopes. For 
this reason, the standards-setting bodies are considering a fourth level of envelope to cover 
an entire communications session.

equalize This function enables you to reinstate the two sides of the map with focus in equal 
dimensions. The use of the Equalize function is optional.

export map This map defines how to move data from the EDI standard-formatted messages that your 
partners send you to your application file (flat file definition). An export map is necessary 
for inbound processing.

export translation
object

See export map.

extended rules These rules enable you to use a Gentran:Server proprietary programming language to 
perform virtually any mapping operation you require.

field The smallest piece of information defined in the application file. A field is the application 
map component that is mapped (linked) to a corresponding EDI element to move data to 
and from your application file.

fixed-format file See application file.

 form A form is a set of instructions you define in the Forms Integration subsystem that indicates 
how the system should format data.

frame A frame contains the groups, repeating segments, and elements at that level (single 
segments are not represented on the frame). Gentran:Server uses frames to format the EDI 
file for the translation object.

functional group A group of transaction sets that the standards-setting body (such as ANSI) has defined as 
fitting together with other related transaction sets. An example might be a Functional 
Group defined as containing all purchasing transaction sets.
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group A looping structure that contains related records/segments and/or groups that repeat in 
sequence until either the group data ends or the maximum number of times that the loop is 
allowed to repeat is exhausted. If you create a group that is subordinate to another group (a 
sub-group), this corresponds to a nested looping structure (a loop within a loop). The 
application (positional) file and the EDI file are both groups and therefore, they is visually 
represented the same way as other groups and sub-groups in Gentran:Server.

import This command enables you to import data from an external application file. Depending on 
the content of the file, the system may prompt you for partner, transaction, or translation 
object information.

import map This map defines how to move data from your application file (flat file definition), which 
may contain multiple messages, to the EDI standard-formatted messages that your 
partners expect to receive from you. An import map is necessary for outbound processing.

import translation
object

See import map.

inbound mapping The system translates your trading partner’s EDI standard formatted business message to 
your application file format, so you can receive messages from you partners. To translate 
inbound data, you need to create an export map.

In Documents This Gentran:Server browser contains a list of messages that the system received but that 
have not yet been processed by the user. Once the messages are processed (printed or 
exported) the messages will be transferred to the In Drawer.

In Drawer This Gentran:Server browser contains a list of messages that were received and processed.

integer An integer is a number that has an implied decimal point (e.g., “2.01” is formatted as 
“201”).

interchange The interchange contains all the functional groups of messages (transaction sets) sent from 
one sender to one receiver in the same transmission.

Interchanges
browser

This Gentran:Server browser enables you to view a hierarchical list of all the interchanges 
that were sent or received. It contains status information about the interchanges, (e.g., 
whether or not a functional acknowledgement was received and the status of that 
acknowledgement). This browser also enables you to access the messages within the 
interchanges. The Interchanges browser can always be accessed.
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 Layout Pane The Layout Pane contains the actual format of the translation object. Each group (with a 
maximum usage greater than one) and repeating segment has a corresponding frame in the 
Layout Window. When you click a segment or group in the EDI file format, the 
corresponding frame is displayed in the Layout Window. When you click an element in 
the EDI file format, the corresponding layout component is highlighted in the Layout 
Window.

list box A list box displays a list of choices. Scroll bars are provided if there are more choices than 
can fit in the box.

literal constant These are used by the system as a repository to store information that will be used at a 
later point in the map. Typically, constants are used in an outbound map to generate a 
qualifier.

location table This is a table created in Partner Editor that is used to contain address-related information 
about the partner.

lookup table This is a table created in Partner Editor that is used to select information related to a value 
in inbound or outbound data.

loop count This standard rule enables you to count the number of times a loop is repeated, if the 
element or field is part of a loop. If the loop is a nested loop, you can track the current loop 
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop 
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can 
choose to count either the “15” (Y loop) or the “3” (X loop).

loop start/loop end Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE 
segments differentiate between two or more loops of the same type. If the transaction 
contains LS and LE segments and depending on whether your map is inbound or 
outbound, you will need to define the LS and LE segments for the loops you will be using 
in the map in one of two different ways.

map A set of instructions you define in the Application Integration subsystem that indicates the 
corresponding relationship between your application file and the EDI standards, and 
defines how the system should translate data. 

network Also known as a Third Party Network or Value-Added Network (VAN) that accepts and 
holds transmissions from companies until it is convenient for a trading partner to accept 
them.



number Glossary

Gentran:Server for Windows – November 2005 Forms Integration TRADACOMS Tutorial Guide

GL - 8

number This type of field or element contains either an integer or real number. If you specify that a 
field or element will be a number type, you must designate the format by specifying a 
format of either “N” (integer) or “R” (real) and the number of decimal places.

ODETTE The Organisation for Data Exchange by Tele-Transmission in Europe.

outbound mapping The system translates your application file format to EDI standard formats, so you can 
send messages to your partners. To translate outbound data, you need to create an import 
map and a system import map in the Application Integration subsystem.

Out Documents This Gentran:Server browser contains a list of messages that are ready to be sent. After the 
messages are successfully sent, they are automatically transferred to the Out Drawer.

Out Drawer This Gentran:Server browser contains a list of messages that were successfully sent out by 
the system.

partner Another firm with which your company trades messages. Also referred to as a trading 
partner.

Partner Editor This Gentran:Server function enables you to define, edit, and delete all partner 
information for your company and all of your trading partners.

positional file See application file.

post This Gentran:Server function enables you to move compliant messages from the 
Workspace to the Out Documents.

predefined On a data entry translation object, a default value for a particular element. You can change 
the value as necessary.

printout This is produced when data received from a trading partner passes through a print 
translation object. You do not have to actually print the data. The printout could be to a file 
on your hard disk.

print translation
object

A print translation object organises and formats the printout of EDI messages that are 
received from or sent to the trading partner(s) for which you have established a trading 
relationship (inbound or outbound) that uses that print translation object. The print 
translation object enables you to view the EDI message in an easily readable format.
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promote This function extracts one iteration (instance) of a group or repeating segment. This 
enables you to map unique data from your application file, and/or enter a specialised 
definition. Gentran:Server specifies that only one-to-one (no loops) or many-to-many 
(loop) mapping relationships are valid.

qualifier This is an element that has a value expressed as a code that gives a specific meaning to the 
function of another element. A qualifying relationship is the interaction between an 
element and its qualifier. The function of the element changes depending on which code 
the qualifier contains.

radio buttons Radio buttons indicate a group of mutually exclusive options. You can only select one 
option at a time. Select an option by clicking the radio button or pressing the Space Bar 
until the option you want is selected. The selected option contains a black dot. The labels 
of unavailable choices are dimmed.

real number A real number has an explicit decimal point (e.g., “2.01” is formatted as “2.01”), and 
truncates trailing zeroes.

receive This Gentran:Server function enables you to manually initiate a communications session 
to receive data from a network through an invocation of the Connection Manager.

record Contains a group of related fields. A record can occur once or can repeat multiple times.

relational
condition

This function enables to connect fields together for syntax or compliance reasons. For 
example, Field A is invalid unless Field B is present. Therefore, if you set up a condition 
that pairs Fields A and B, the system will generate a compliance error if one of those fields 
is not present.

respond This Gentran:Server function enables you to create a turnaround message (using the Turn 
Around translation object in the partner relationship) in response to one or more selected 
message(s) in the In Drawer.

responsible agency An organisation that develops and updates standards for EDI communications. These 
organisations include ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.

screen entry
translation object

A screen entry translation object provides a standardised format for keying an EDI 
message into the Document Editor, for translation and transmission to your trading 
partner(s), for which you have established an outbound trading relationship that utilises 
that screen entry translation object. The screen entry translation object ensures that your 
users key all the data necessary to create the required EDI message.
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segment A group of related elements or composite data elements that combine to communicate 
useful data. Segments are defined by the EDI standards. A segment can occur once or can 
repeat multiple times. For example, a catalogue price segment might consist of elements 
for item description, volume, price, lead time, etc. By themselves, none of these elements 
would communicate useful information. Together, they provide the information necessary 
for someone to tell if the item is what is desired, whether the price is reasonable, etc. A 
number of segments together form a transaction set.

select This standard rule enables you to select entries from a location table, cross-reference table, 
partner table, or lookup table (all tables created in the Gentran:Server Partner Editor). You 
can then map the fields in those tables to one or more fields in the data. The Select 
function uses the value of the current field to perform the selection.

send This Gentran:Server function enables you to manually start a communications session to 
send data to a network through an invocation of Connection Manager. Only selected 
messages are enveloped and sent. If no messages are selected, ALL messages will be sent. 
Successfully sent messages are moved to the Out Drawer.

set See Transaction Set.

simple mapping See link.

split This function enables you to split (break) a group or repeating segment into two loops. 
You will typically use this function when you need more than one instance of the same 
map component that still occurs multiple times.

standard rules These rules give you access to functions that are necessary for mapping operations that are 
more complex than simple linking, but less involved than extended rules. Each of the 
standard rules are mutually exclusive (you can use only one on a particular field).

static text Static text is text that is always included in the screen entry or print translation object. 
Examples of static text include legends and column headings. Field labels, which usually 
accompany fields to identify the contents of the fields, are not considered static text.

status bar The status bar of an application window defines information about a selection, command, 
or process, defines Menu Bar items as the user highlights each item, and indicates any 
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key or NUM 
for the “Num Lock” key, etc.).
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string This type of field or element contains one or more printable characters. If you specify that 
a field or element will be a string type, you must designate the format by specifying a 
syntax token.

syntax token This function enables you to designate a “token” that defines ranges of characters and/or 
numbers that are allowed to be used for a string-type element or field. You can then use 
the syntax tokens in the Format field of the Field Properties dialogue. This enables you to 
define what type of characters should be used while compliance checking each element/
field (i.e., alphanumeric within a certain range, numeric within a certain range, etc.).

system import map The translator uses this map to determine which trading relationship (established in 
Partner Editor) corresponds to each message in the application file, so the system will 
know which import map to use to process the message. You need a system import map 
that is defined in EDIMGR.INI to translate outbound data.

system import
translation object

See system import map.

system translation
object

These translation objects control the creation and separation of interchanges, functional 
groups, and transaction sets. They also used to generate and reconcile functional 
acknowledgements. All the required system translation objects are automatically installed 
with the Gentran:Server system.

TDCC See EDIA.

TDF TDF is the Transaction Data File. This file serves as a filter between your message files 
and the Gentran:Server translator. For outbound processing, data is imported from a TDF 
file and translated to EDI format using a TDF Import translation object. The data is then 
ready to be posted and sent to your trading partner. For inbound processing, EDI messages 
that are received by Gentran:Server can be exported to a TDF-formatted file using a TDF 
Export translation object. This data file is then ready to be processed or converted to your 
internal application files.

third-party
network

See Network.

title bar The title bar of an application window contains the name of the application and enables 
you to move the window to another position on your desktop.

toolbar This contains buttons that graphically represent commands available in the Menu Bar.
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TRADACOMS The U.K. standards for EDI that are published by the Article Numbering Association 
(UK) LTD. 

trading partner Another firm with which you company trades messages. Also referred to as a partner.

transaction set
(message)

A business form as defined by the standards. Examples include an ANSI 850 purchase 
order or an UCS 880 invoice. The standards define each transaction set in terms of the 
segments and elements that make up the form, the order in which they appear, and the 
relationships among them. This is also known as “message” in Europe.

translation object A predesigned layout set up to ensure that input or output for a particular transaction set 
exists and is presented in a usable fashion. You must specify which translation object(s) 
will be used by each partner relationship.

Inbound Translation Objects:

Turn Around: This translation object is used when a message is received, to create the 
natural response message that contains as many elements from the received message as 
possible.

Export File: This translation object indicates that when a message is received, it will be 
exported to a specified file format.

Print: This translation object is used to print messages.

Outbound Translation Objects:

Import: This translation object is used to import data from an application file.

Print: This translation object is used to print messages.

Data Entry: This translation object is used to enter data into the Message Editor facility.

translator This is the engine that processes data for the Gentran:Server, Application Integration 
subsystem and Forms Integration subsystem.

transmission See Communications Session.

transmission chain A path an EDI communication could follow, including one company, one trading partner, 
and one or more network services.

turnaround
document

A message into which data elements from the source message have been automatically 
transferred using a turnaround map.
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turnaround map A series of instructions that the system uses to create a turnaround message (a logical 
response message to the source) from an inbound (source) message, by transferring data 
from the source message to elements in the target message (translation object).

UCS The Uniform Communications Standard is the standard used by the grocery industry.

update This standard rule enables you to update a specific field in a message record, envelope 
segment, interchange, group, current partner, or message (if the map side format type is 
EDI), with the contents of the element or field.

Note
Please note that this function updates the internal Gentran:Server database tables. We 
recommend that you use this function only if you are sure you really want to update the 
internal database tables.

Typically, you will only use this function if you want to update the message name and 
reference in the message table. Any other use of this function could have disastrous 
consequences!

use accum This standard rule gives you access to a set of numeric variables that you can manipulate 
via numeric operations, and then transfer to and from fields. This function enables you to 
add, change, or delete calculations for the element/field, including hash totals (used to 
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you 
to map the accumulated total into a control total field, and use accumulators. 
Accumulators are used generally for counting the occurrences of a specific element or 
generating increasing or sequential record or line item numbers.

use code This standard rule enables you to match an element or field against a predefined code 
table, specify whether or not a compliance error will be generated if the element or field 
does not contain one of the values in the code table, and store a code’s description in 
another element or field.

user translation
object

These translation objects control data entry, importing, exporting, message turnaround, 
and creating printed reports. These translation objects are created using the Application 
Integration or Forms Integration subsystems. The Application Integration subsystem 
enables you to generate import, export, and message turnaround translation objects. The 
Forms Integration subsystem enables you to generate data entry and print translation 
objects.

version Each standards-setting body updates its standards on a regular basis. Each formal update is 
referred to as a version.
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VICS The Voluntary Inter-industry Communication Standards is the standards-setting body for 
the retail industry, a subset of ANSI X12.

Workspace This Gentran:Server browser contains a list of outbound “Work in Progress” messages. It 
also contains recently imported or data entry messages.

X12 The ANSI committee that sets and publishes standards for EDI.
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